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SpeechMiner 8.5.x Release Notes

SpeechMiner 8.5.x Release Notes

This Release Note applies to all 8.5.x releases of SpeechMiner. Links in the Available Releases section
enable you to access information regarding a specific release.

[+] Note about release order

Releases are listed by version number rather than in date order. For this reason, a recent release may
be listed after earlier releases, if the version number is lower. Except when otherwise noted in the
information for a specific release, each release includes all of the features and corrections that were
introduced for the applicable operating system at earlier dates, regardless of the version numbering.

[+] Important Points to Remember

* When working with Internet Explorer 11+, the Online Help documentation may not appear as it
should due to your Internet Explorer > Compatibility View settings. To view the Online Help
properly, go to the Tools menu, select Compatibility View Settings and verify that Display
intranet sites in Compatibility View is not checked.

¢ A Text Interaction with more than 100K characters (with or without an attachment) is not supported.

The following characters are not supported in Text interactions with xml formats (for example, chat and
social): & < >.

Phrases defined in SMART must be part of a single sentence. Phrases cannot be a combination of
multiple sentences separated by a period. The period can only appear once at the end of the phrase.

Available Releases

Release 8.5.5:
Release GlEres el Restrictions AIX Linux Solaris Windows
Date Type
8.5.512.52 12/19/25 General X
8.5.512.50 10/15/25 General X
8.5.512.49 07/17/25 General X
8.5.512.46 01/03/25 General X
8.5.512.43 06/28/24 General X
8.5.512.42 03/26/24 General X
8.5.512.37 10/13/23 General X
8.5.512.28 03/31/22 General X
8.5.512.13 02/22/21 Hot Fix X
8.5.512.12 07/30/20 Hot Fix X

Speech and Text Analytics 5
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Release Release
Date Type

8.5.512.11 05/07/20 Hot Fix
8.5.512.10 04/26/20 Hot Fix
8.5.512.07 10/17/19 General
8.5.512.06 03/06/19 Hot Fix
8.5.512.04 11/07/18 Hot Fix
8.5.512.03 10/30/18 Hot Fix
8.5.512.02 10/02/18 Hot Fix
8.5.512.01 09/07/18 Hot Fix
8.5.512.00 07/11/18 General
8.5.511.00 03/27/18 General
8.5.510.35 11/22/20 Hot Fix
8.5.510.30 01/13/20 Hot Fix
8.5.510.28 08/25/19 Hot Fix
8.5.510.27 07/21/19 Hot Fix
8.5.510.24 04/30/19 Hot Fix
8.5.510.23  02/22/19 Hot Fix
8.5.510.22 01/29/19 Hot Fix
8.5.510.21 12/31/18 Hot Fix
8.5.510.20 11/22/18 Hot Fix
8.5.510.13 09/06/18 Hot Fix
8.5.510.12 08/16/18 Hot Fix
8.5.510.11 08/14/18 Hot Fix
8.5.510.05 05/12/18 Hot Fix
8.5.510.04 05/06/18 Hot Fix
8.5.510.03 03/05/18 Hot Fix
8.5.510.02 01/15/18 Hot Fix
8.5.510.01 12/19/17 General
8.5.509.16 11/28/18 Hot Fix
8.5.509.13 07/27/18 Hot Fix
8.5.509.11 06/13/18 Hot Fix
8.5.509.10 05/14/18 Hot Fix
8.5.509.09 05/09/18 Hot Fix
8.5.509.08 04/08/18 Hot Fix
8.5.509.07 02/21/18 Hot Fix
8.5.509.06 02/11/18 Hot Fix
8.5.509.05 10/24/17 Hot Fix
8.5.509.04 09/26/17 General

Release Restrictions AIX Linux Solaris Windows

X X X X X X X X X X X X X X X X X X X X X X X X X X X X X X X X X X X X Xx
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Release Release

Release Date Type Restrictions AIX Linux Solaris Windows
8.5.508.10 11/10/17 Hot Fix X
8.5.508.09 10/15/17 Hot Fix X
8.5.508.08 10/10/17 Hot Fix X
8.5.508.07 10/01/17 Hot Fix X
8.5.508.04 08/07/17 Hot Fix X
8.5.508.03 06/29/17 General X
8.5.507.01 03/29/17 General X
8.5.506.01 01/04/17 General X
8.5.502.04 02/10/16 General X
8.5.502.03 01/06/16 General X
8.5.501.05 09/30/15 General X
8.5.500.47 07/16/25 General X
8.5.500.04 07/01/15 General X

Release 8.5.4:

Release R(I-:)I:‘z:e Rgr;e::e Restrictions  AIX Linux Solaris Windows
8.5.401.50 03/03/16 Hot Fix X
8.5.401.39 10/08/15 Hot Fix X
8.5.401.36 09/30/15 Hot Fix X
8.5.401.35 09/06/15 Hot Fix X
8.5.401.32 08/05/15 Hot Fix X
8.5.401.24 07/11/15 Hot Fix X
8.5.401.16 06/22/15 Hot Fix X
8.5.401.01 05/26/15 Hot Fix X
8.5.400.85 04/15/15 General X

Release 8.5.3:

Release R?)I:::e R(_-i_;e::e Restrictions  AIX Linux Solaris Windows
8.5.300.08 09/30/15 Hot Fix X
8.5.300.07 07/16/15 Hot Fix X
8.5.300.04 03/03/15 General X
8.5.300.03 01/09/15 General X

Speech and Text Analytics
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Release 8.5.2:

Release R(Ie)I:taese R(:_;e:ese Restrictions AIX Linux Solaris Windows
8.5.201.08 05/26/15 Hot Fix X
8.5.201.07 01/26/15 General X
8.5.201.06 10/22/14 General X
8.5.200.09 08/26/14 General X

Release 8.5.0:

Release Rgl:taese Rﬁ_:’e:ese Restrictions AIX Linux Solaris Windows
8.5.007.01 06/15/17 Hot Fix X
8.5.006.02 04/12/17 Hot Fix X
8.5.006.00 02/07/17 Hot Fix X
8.5.005.01 06/07/16 Hot Fix X
8.5.004.00 01/27/16 Hot Fix X
8.5.003.02 09/09/15 Hot Fix X
8.5.003.01 07/07/15 Hot Fix X
8.5.000.00 12/08/14 General X
8.5.001.00 03/28/14 General X
8.5.000.02 01/13/14 General X

The operating systems available for use with each component release are listed in the table at a high
level only. For more detailed information about the supported operating environments, including
requirements, supported versions, and any conditions or limitations, see the SpeechMiner page in the
Genesys Supported Operating Environment Reference Guide.

Discontinued Support

[+] Note about discontinued items

This section documents features that are no longer supported in this software. This cumulative list is
in release-number order with the most recently discontinued features at the top of the list. For more
information on discontinued support for operating environments and databases, see Discontinued
Support in the Genesys Supported Operating Environment Reference Guide.

A collapsed search filter no longer displays the number of branches in a tree.
e Internet Explorer 10.

e Similar Calls

¢ Global Search is not supported by the Web UI.

e Anonymous Permalink

Speech and Text Analytics 8
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e Topic Correlation
¢ Audio protection for comments
* Active Search
¢ GSM Playback
e Internet Explorer 8 and 9
* Gauge widget
¢ Functionality changes: Anonymous Permalink was removed from SpeechMiner
e The following permissions were discontinued:
e Audio Protection: Comments
e Audio Protection: Sensitive Topics

* Manage My Preset View

Known Issues

You can find a cumulative list of the Known Issues and Recommendations for all 8.5.x releases of
SpeechMiner, including the issues that are specific to Localized (International) releases, at the
following links:

¢ Known Issues and Recommendations

¢ Internationalization Issues

Related Resources
For additional information about SpeechMiner, see the following documentation:
¢ The documentation related to this software is available from the SpeechMiner page.

e The SpeechMiner Analytics Administration Guide provides details about installing and configuring
SpeechMiner.

¢ The SpeechMiner page in the Genesys Supported Operating Environment Reference Guide provides
detailed information about the supported operating environments, including requirements, supported
versions, and any conditions or limitations for SpeechMiner components.

Release Notes for other Genesys components are available here.

Speech and Text Analytics
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Known Issues and Recommendations

Speech and Text Analytics

The Known Issues and Recommendations section is a cumulative list for all 8.5.x releases of Speech
and Text Analytics. This section provides the latest information on known issues and
recommendations associated with this product. It includes information on when individual items were
found and, if applicable, corrected. The Resolved Issues section for each release describes the
corrections and may list additional issues that were corrected without first being documented as
Known Issues.

See also Internationalization Issues.

Call Recognition fails in SpeechMiner when FIPS is enabled.

ID: PRSM-29818 Found In: 8.5.512.37 Fixed In:

When Arabic language is selected in the browser language setting, SpeechMiner may not render the
page in Arabic, instead it would render the page in English (en-US).

ID: PRSM-29814 Found In: 8.5.512.37 Fixed In:

Interaction export with Encryption turned ON does not work when FIPS is enabled in the Web Server.

ID: PRSM-29787 Found In: 8.5.512.37 Fixed In:

Screen Recording Export is currently unavailable in SpeechMiner Help.

ID: PRSM-29629 Found In: 8.5.512.37 Fixed In:

SpeechMiner encounters the error, CRIT Unhandled Exception occurred, when a user tries to
choose a column layout when creating a dashboard.

ID: PRSM-29519 Found In: 8.5.512.37 Fixed In:

Genesys is not responsible for the data migration from old Elasticsearch to new Elasticsearch.

ID: PRSM-28682 Found In: 8.5.512.28 Fixed In:

Speech and Text Analytics 10
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As part of the installation process, there might be database changes. If you are planning for a fresh
installation of the database, it can only be restored from the .bak file packaged in the IP and not
through the installer. If you want to migrate your existing database, use the SMUpgrade option. For
more information, contact Genesys Customer Care.

After manually installing the database, you should update the database version by
running the following script:

update dbo.versionTbl set version= '8.5.512.429' where resource in
('SM', 'SMART') go

If you use SMUpgrade or install the database through the installer, you’ll get the following error
when trying to log in to SMConfig:

“SMConfig failed to load - Invalid column name 'RcsUri'. Invalid column name 'HtccUrl'.

[

Invalid column name 'ExternalRcsUri'.

This error means that the database is using the build 429 and not 335. In such case, you should run
the following script to downgrade the database to the 335 build.

ALTER TABLE configServer DROP COLUMN GwsUrl

EETER TABLE configServer DROP COLUMN ClientId
ALTER TABLE configServer DROP COLUMN ClientSecret
ALTER TABLE webServiceParams DROP COLUMN HubUrl

ALTER TABLE configServer DROP COLUMN GwsUrlExternal

ALTER TABLE configServer ADD RcsUri varchar(512) NULL
ALTER TABLE configServer ADD RcsKeepAlivelInterval int NULL
ALTER TABLE configServer ADD ExternalRcsUri varchar(512) NULL

ALTER TABLE configServer ADD HtccUrl varchar(512) NULL

SET ANSI_NULLS ON
SET QUOTED IDENTIFIER ON
GO

-- create a new table to store transcript json

DROP TABLE [dbo].[ExportedDataTbl]

ALTER TABLE CallRecognizer DROP COLUMN TranscriptionExportSaveData;
GO

/¥**¥*¥xx Object: StoredProcedure [dbo].[sp deleteCallsAndGetTheirPath] Script Date: 11/9/
2021 2:17:56 PM **x¥kx/

ALTER PROCEDURE [dbo].[sp deleteCallsAndGetTheirPath](@CallIDs varchar(max),@eletedCallsNum
int OUTPUT)
WITH EXECUTE AS SELF

Speech and Text Analytics 11
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AS
BEGIN

SET NOCOUNT ON;

DECLARE @getPaths as nvarchar (max)

SET @getPaths = 'select folder + ''\'' + filename,siteld from callAudioTbl where owner = 0
and storeMode = 1 and callid in (' + @CallIDs + ')'

EXEC sp_executesql @getPaths

--This calculates into @DeletedCallsNum the number of calls that are deleted (regardless of
callAudioTbl)

DECLARE @ParmDefinition nvarchar(500);

DECLARE @SelectCounter nvarchar(max)

SET @SelectCounter = N'select @sOUT = count(*) from callmetatbl where callid in (' +
@Callibs + ')

SET @ParmDefinition = N'@sOUT int OUTPUT';

EXEC sp executesql @SelectCounter,@ParmDefinition,@s0UT=@DeletedCallsNum OUTPUT;

DECLARE @getAdhocIDs as nvarchar (max)

DECLARE @adhocIDs as nvarchar (max)

SET @getAdhocIDs = N'SELECT @sOUT = STUFF((SELECT '','' + STR(EvaluationId) FROM
EvaluationSession where InteractionId in (' + @CallIDs + ') AND Type = 5 FOR XML PATH('''"))
,1’1'||||)|

SET @ParmDefinition = N'@sOUT nvarchar (max) OUTPUT';

EXEC sp executesql @getAdhocIDs, @ParmDefinition, @sOUT=@adhocIDs OUTPUT;

DECLARE @getFormFilledIDs as nvarchar (max)

DECLARE @formFilledIDs as nvarchar (max)

SET @getFormFilledIDs = N'SELECT @sOUT = STUFF((SELECT '','' + STR(FormFilledID) FROM
EvaluationSessionForms where EvaluationSessionId in (SELECT Id FROM EvaluationSession where
InteractionId in (' + @CallIDs + ')) FOR XML PATH('''')) ,1,1,'''"')"'

EXEC sp executesql @getFormFilledIDs, @ParmDefinition, @sOUT=@formFilledIDs OUTPUT;

DECLARE @deleteCalls as nvarchar (max)

SET @deleteCalls = "'

SET @deleteCalls = @deleteCalls + 'DELETE FROM actionItemEvaluationSessions where
evaluationSessionId in (SELECT EvaluationId FROM EvaluationSession where InteractionId in ('
+ @CallIbs + '))'

SET @deleteCalls = @deleteCalls + 'DELETE FROM EvaluationSessionForms where
EvaluationSessionId in (SELECT Id FROM EvaluationSession where InteractionId in (' + @CallIDs
+ 1))

SET @deleteCalls = @deleteCalls + 'DELETE FROM EvaluationSession where InteractionId in ('
+ @CalliDs + ')'

SET @deleteCalls = @deleteCalls + 'DELETE FROM EvaluationInteraction where InteractionId in
(" + @Callibs + ')

IF (@adhocIDs IS NOT NULL)

BEGIN

SET @deleteCalls
+ @adhocIDs + ')'

SET @deleteCalls
in (' + @adhocIDs + ')

SET @deleteCalls
+ @adhocIDs + ')'

SET @deleteCalls = @deleteCalls + 'DELETE FROM EvaluationSchedule where
EvaluationManagerId in (' + @adhocIDs + ')'

SET @deleteCalls = @deleteCalls + 'DELETE FROM Evaluations where Id in (' + @adhocIDs +

@deleteCalls + 'DELETE FROM EvaluationAgent where EvaluationId in ('

@deleteCalls + 'DELETE FROM EvaluationEvaluator where EvaluationId

@deleteCalls + 'DELETE FROM EvaluationForm where EvaluationId in ('

I)I
END
IF (@formFilledIDs IS NOT NULL)
BEGIN
SET @deleteCalls = @deleteCalls + 'DELETE FROM FormsQuestionsSelectedAnswers where
FormFilldId in (' + @formFilledIDs + ')
SET @deleteCalls @deleteCalls + 'DELETE FROM FormFilledQuestions where formFilledid
in (' + @formFilledIDs ')
SET @deleteCalls @deleteCalls + 'DELETE FROM FormFilledGroups where formFilledid in
(" + @formFilledIDs + ')
SET @deleteCalls

I~ + 1

@deleteCalls + 'DELETE FROM FormFilled where Id in (' +

Speech and Text Analytics 12
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@formFilledIDs + ')
END
SET @deleteCalls = @deleteCalls + 'DELETE FROM callAudioTbl where callid in (' + @CallIDs +

")
SET @deleteCalls = @deleteCalls + 'DELETE FROM callForwardTasksTbl where callid in (' +
@Callibs + ")
SET @deleteCalls = @deleteCalls + 'DELETE FROM coachingStaticCallListCalls where callid in
(" + @Calllbs + ')
SET @deleteCalls = @deleteCalls + 'DELETE FROM callMetaExTbl where callid in (' + @CallIDs
+ ')

SET @deleteCalls = @deleteCalls + 'DELETE FROM repCategoryMetaTbl where callid in (' +
@Callibs + ')

SET @deleteCalls = @deleteCalls + 'DELETE FROM callcategoryTbl where callid in (' +
@Callibs + ')

SET @deleteCalls = @deleteCalls + 'DELETE FROM callStatusTbl where callid in (' + @CallIDs
+ ')
SET @deleteCalls = @deleteCalls + 'DELETE FROM callNotesTbl where callid in (' + @CallIDs +

")
SET @deleteCalls = @deleteCalls + 'DELETE FROM callEventsTbl where callid in (' + @CallIDs
+ ')
SET @deleteCalls = @deleteCalls + 'DELETE FROM callEventsAuditTbl where callid in (' +
@CallIbs + ')
SET @deleteCalls = @deleteCalls + 'DELETE FROM callStatisticsTbl where callid in (' +
@CallIbs + ')
SET @deleteCalls = @deleteCalls + 'DELETE FROM callAgentTbl where callid in (' + @CallIDs +

")

SET @deleteCalls = @deleteCalls + 'DELETE FROM callPartitionTbl where callid in (' +
@Callibs + ')
SET @deleteCalls = @deleteCalls + 'DELETE FROM callTasksTbl where callid in (' + @CallIDs +

")

SET @deleteCalls = @deleteCalls + 'DELETE FROM callSpeakersTbl where callid in (' +
@CallIDs + ')

SET @deleteCalls = @deleteCalls + 'DELETE FROM segmentMetaTbl where callld in (' + @CallIDs
+ I)I
SET @deleteCalls = @deleteCalls + 'DELETE FROM callMetaTbl where callid in (' + @CallIDs +
I)I
SET @deleteCalls
SET @deleteCalls

@deleteCalls + 'DELETE FROM CallQTbl where callld in (' + @CallIDs + ')'
@deleteCalls + 'DELETE FROM lvcsrindex where callld in (' + @CallIDs +
")

")

")
SET @deleteCalls = @deleteCalls + 'DELETE FROM ExplorationFragment where callld in (' +
@CallibDs + ')
SET @deleteCalls = @deleteCalls + 'DELETE FROM InteractionTags where InteractionId in (' +
@CallibDs + ')
SET @deleteCalls = @deleteCalls + 'DELETE FROM TranscriptionExportStatus where CallIld in ('
+ @CalliDs + ')
EXEC sp _executesql @deleteCalls
END
GO
DROP TABLE [MetricsTbl]
GO
ALTER TABLE siteStoreTbl Drop Column resourceType
GO
update configServer set RcsKeepAlivelnterval = 10
GO
update dbo.versionTbl set version= '8.5.512.429' where resource in ('SM', 'SMART')
GO

SET @deleteCalls = @deleteCalls + 'DELETE FROM callchannels where callld in (' + @CallIDs +

SET @deleteCalls = @deleteCalls + 'DELETE FROM callLogTbl where callld in (' + @CallIDs +

ID: PRSM-28615 Found In: 8.5.512.28 Fixed In: 8.5.512.37
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Release 8.5.5

Speech and Text Analytics Release Notes

You can find links to Release Notes for particular 8.5.5 releases of Speech and Text Analytics, if
available, in the tree menu on the left or in the list of Available Releases.

Speech and Text Analytics

15



SpeechMiner 8.5.x Release Notes

Release 8.5.5

8.5.512.50

Speech and Text Analytics Release Notes

Release Release
Date Type

10/15/25 General

Restrictions AIX Linux

What's New

This release includes the following features or enhancements

e Speechminer application components are upgraded to .NET
Framework 4.8.(PRSM-30096)

Resolved Issues

This release contains no resolved issues.

Upgrade Notes

No special procedure is required to upgrade to release 8.5.512.50.

Mac Solaris Windows

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

Speech and Text Analytics
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Release 8.5.5

8.5.512.49

Speech and Text Analytics Release Notes

Release Release
Date Type

07/17/25 General

Restrictions AIX Linux

What's New

This release contains the following new features and
enhancements:

¢ SpeechMiner Indexer component now supports Elastic Search
version 8., including secure connections with basic user
authentication and TLS.(PRSM-30090)

Resolved Issues

This release contains the following resolved issues:

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

Mac Solaris Windows

Saved Reports now supports accented characters in metadata. (PRSM-30139)

Upgrade Notes

No special procedure is required to upgrade to release 8.5.512.49.

Speech and Text Analytics
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8.5.512.406

Speech and Text Analytics Release Notes

Release Release . . . .
Date Type Restrictions AIX Linux Mac Solaris Windows
01/03/25 General X
|
What's New Helpful Links
This release contains the following new features and Releases Info
enhancements:

e Angular]S is now upgraded to v1.9.7. (PRSM-30026) * Listor8.5.xReleases

. . * 8.5.x Known Issues
e Performance of the Team Evaluation Comparison report has been

improved. (PRSM-30080)

¢ The Indexer component has been upgraded to .NET core 8.
(PRSM-30041) Product Documentation

SpeechMiner

Genesys Products

Resolved Issues List of Release Notes

This release contains the following resolved issues:

SpeechMiner now calculates scores correctly even when the sliding scale question is marked as N/A.
Previously in this scenario, the score was incorrect. (PRSM-29916)

Search no longer fails when browser language is selected as Turkish. Previously in this scenario, an
error was shown. (PRSM-29918)

A vulnerability that allowed unauthorized users to access the config files has been fixed.
(PRSM-29975)

Speech and Text Analytics 18
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Upgrade Notes

No special procedure is required to upgrade to release 8.5.512.46.

Speech and Text Analytics 19
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8.5.512.44

Speech and Text Analytics Release Notes

Release Release . . . .
Date Type Restrictions AIX Linux Mac Solaris Windows
01/03/25 General X
|
What's New Helpful Links
This release contains the following new features and Releases Info
enhancements:

e Angular]S is now upgraded to v1.9.7. (PRSM-30026) * Listor8.5.xReleases

. . * 8.5.x Known Issues
e Performance of the Team Evaluation Comparison report has been

improved. (PRSM-30080)

Product Documentation

SpeechMiner

Resolved Issues
Genesys Products

This release contains the following resolved issues: List of Release Notes

SpeechMiner now calculates scores correctly even when the sliding scale question is marked as N/A.
Previously in this scenario, the score was incorrect. (PRSM-29916)

Search no longer fails when browser language is selected as Turkish. Previously in this scenario, an
error was shown. (PRSM-29918)

A vulnerability that allowed unauthorized users to access the config files has been fixed.
(PRSM-29975)

Speech and Text Analytics 20
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Upgrade Notes

No special procedure is required to upgrade to release 8.5.512.44.

Speech and Text Analytics 21



SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.512.43

Speech and Text Analytics Release Notes

Release ez Restrictions  AIX Linux Mac Solaris Windows
Date Type
06/28/24 General X
|
What's New Helpful Links
This release includes only resolved issues. Releases Info

e List of 8.5.x Releases

e 8.5.x Known Issues
Resolved Issues

This release contains the following resolved issues: Product Documentation

SpeechMiner

Interaction export now works properly when encryption is turned
off. Previously in this scenario, the interaction export function did Genesys Products
not work. (PRSM-29827)

List of Release Notes

Search based on Comments filter now returns appropriate results.
(PRSM-24673)

Upgrade Notes

No special procedure is required to upgrade to release 8.5.512.43.
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8.5.512.42

Speech and Text Analytics Release Notes

Release Release . . . .
Date Type Restrictions AIX Linux Mac Solaris Windows
03/26/24 General X
|
What's New Helpful Links
This release includes only resolved issues. Releases Info

e List of 8.5.x Releases

e 8.5.x Known Issues
Resolved Issues

This release contains the following resolved issues: Product Documentation

If a Load Balancer is used before SpeechMiner web ~ SPeechMiner

servers, SpeechMiner now logs the source IP instead

of the Load Balancer IP in audit tables. Genesys Products

List of Release Notes

The X-Forwarded-For (XFF) HTTP header must be enabled at the Load Balancer.

(PRSM-29750)

An issue that prevented SpeechMiner from connecting to RWS via HTTPS is now fixed. (PRSM-29729)

The Batch Actions menu is now visible in Interactions List Panel, which displays the interactions
grid corresponding to the selected Interaction List. (PRSM-29678)

Text strings in SpeechMiner are now displayed in the selected language. (PRSM-26336)
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Some pages like Saved searches and Reports now work properly when the Windows service, Federal
Information Processing Standard (FIPS), is enabled. Previously, these pages had issues when FIPS was

enabled. (PRSM-29041)

After setting a system with externalApplicationBaseURL in the webserviceparams table,
business alerts are sent with a link that points to the correct external URL and not to the local web
server. (PRSM-29581)

On Event Business alerts no longer trigger multiple emails per call that triggers the event.
(PRSM-29580)

Usernames with uppercase letters now get selected properly in Saved Search’s shared windows,
based on user’s selection. Previously in this scenario, usernames with uppercase letters did not get
selected properly. (PRSM-27401)

Upgrade Notes

No special procedure is required to upgrade to release 8.5.512.42.
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8.5.512.37

Speech and Text Analytics Release Notes

Release Release
Date Type

10/13/23 General

Restrictions AIX Linux

What's New

This release contains the following new features and
enhancements:

¢ The SpeechMiner Indexer component is upgraded to use .NET
core 6.0. (PRSM-29150)

¢ The Indexer component now supports Elasticsearch version
7.17.6. (WFOAZURE-2698)

Mac Solaris Windows

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

Installing .NET 6.0 and Elasticsearch 7.17.6 are mandatory requirements for Indexer.
All the libraries mentioned in Installing .NET Core 6.0 Runtime & Hosting are required
for successful installation of SpeechMiner (if the Indexer component is selected). If the
Indexer component is selected and if .NET 6.0 is not installed, installation would fail.

e SpeechMiner now provides an option to download Screen Recordings from the SpeechMiner Web UI.

(WFOAZURE-1820)
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* This option is supported only for exporting a single Screen Recording interaction and it is
not supported for batch export.

e To export screen recordings, Genesys Administrator Extension (GAX) plugin must be
updated to 8.5.097.57.

e Users must have the privilege Enable Video Contest Menu to be able to export screen
recordings.

SpeechMiner now supports HTML formatted content for digital media interactions:

» Transcript text recognized as a topic now displays in bold only if it's not formatted in HTML. If the
transcript text for the topic is formatted in HTML, then the text displays in HTML format.

* If the content of table formatted data for digital interactions has text recognized as a topic, the topic
pointers display below the table.

* Enabling digit filtering now replaces all numbers in the text with an asterisk (*). This may have an impact
on the HTML format of the transcript.

(WFOAZURE-1525)

SpeechMiner now displays the web Ul in a language that you selected in the browser. If you select an
unsupported language in the browser, the web Ul defaults to the language selected in the SMConfig
application. (PRSM-28608)

Digits can now be filtered based on complex logic. Additional conditions can be included in the filter, such as
greater than, smaller than or equal to. The conditions must be separated by a semi-colon. For example,
>5;<12;. If the condition is not allowed, the previous logic will take effect. (PRSM-29124)

Enhanced digits filtering is only applicable for voice interactions.

As part of a security feature update, SpeechMiner is upgraded to work only with HTTPS connections. To work
with HTTP, refer to the configuration specified in Working with HTTP. (PRSM-29132)

SpeechMiner now supports only Single Connection mode. In Single Connection mode, SpeechMiner
communicates only with the RWS component. SpeechMiner no longer supports configuring RCS URL in the
Recording panel of SMConfig tool. Starting from this release, the only option available in SMConfig
(Recording panel) is Internal RWS URI, whereas the previous versions of SpeechMiner provided fields to
enter RCS URI, RWS URI, External RCS URI, and External RWS URI. (GIR-31292)

To use single connection in Interaction Recording Web Services, refer to Local Decrypt
URI Prefix for Call Recording and Screen Recording. Note that Interaction Recording
Web Services must be upgraded to 8.5.204.02 or a newer version.
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Resolved Issues

This release contains the following resolved issues:

SpeechMiner now calculates the form score correctly, even if only the free form question is answered
within a specific group. Previously, if there were two question groups within a form and only the free
form question within a group was answered, the form score was not calculated correctly.
(WFOAZURE-1101)

The metadata fields for the Metadata Frequency report now appear in alphabetical order.
(PRSM-28895)

Free Form answer can now handle up to 4000 characters. Previously, Free Form supported only up to
2000 characters. (PRSM-28818)

An issue with the Installer (DB installation) is now resolved. (PRSM-28615)

Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.512.28

Speech and Text Analytics Release Notes

Release Release C . . . .
Date Type Restrictions AIX Linux Mac Solaris Windows
03/31/22 General X
What's New

Helpful Links

This release contains the following new enhancements: Releases Info

* RCSI settings should be used in the Database. « List of 8.5.x Releases

e Support for Windows Server 2019 operating system and SQL .
Server 2019 database. See the SpeechMiner page in the Genesys 8.5.x Known Issues
Supported Operating Environment Reference for more
information and a list of all supported operating systems.
(PRSM-28615)
. . . Product Documentation
e SpeechMiner now supports the latest version of Elasticsearch

7.16.3. It no longer supports the older versions of Elasticsearch. .
(PRSM-28682) SpeechMiner

Genesys Products

List of Release Notes

To install SpeechMiner, you must upgrade to Elasticsearch 7.16.3.

e SpeechMiner now supports Microsoft Edge Chromium browser. See the SpeechMiner page in the

Genesys Supported Operating Environment Reference for more information and a list of all supported
browsers.
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Resolved Issues

This release contains no resolved issues.

Upgrade Notes

No special procedure is required to upgrade to release 8.5.512.28.
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8.5512.13

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
02/22/21 Hot Fix X
What's New .
Helpful Links

This release contains the following new enhancements:
Releases Info

* Quality Management - The View all Evaluation Sessions

permission was added to the system. Administrators with this * List of 8.5.x Releases

permission can now view evaluation sessions associated with all . 85xK |

users (read-only). (PRSM-27561) 22X Known issues
Resolved Issues Product Documentation

. . . . SpeechMiner
This release contains the following resolved issues:

Genesys Products

The Agent Evaluation Comparison report has been improved so
that trend information is shown for each group available in the
form. (PRSM-27635)

List of Release Notes

Failed logins no longer occur due to a failed connection to the Configuration Server. (PRSM-27628)

There is now a configurable retry mechanism when loading persons and roles from the Configuration
Server. The retry mechanism is configured using the LoadRolesRetry field (default value 3) in the
configServer table. (PRSM-27627)

There is now a timeout for Configuration Server operations. The Configuration Server operations
timeout is configured using the ConfigSrvrTimeout field (default 30 seconds) in the configServer
table. (PRSM-27626)

When working with Exploration an error no longer occurs when a bulk clustering task is imported.
(PRSM-27620)
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SpeechMiner Auditing now includes the following events: Create, Delete, Save, Export, Complete,
Archive, Cycle Interactions. (PRSM-27619)

The lower part of the Evaluation Summary report now displays one value for each session per user.
Previously, the Evaluation Summary report displayed the session per user value twice. (PRSM-27618)

When an Evaluator completes an evaluation session and notifies the agent, the agent receives an
Action Item. Without appropriate permissions, the agent can no longer see the evaluation session
score. Previously, the agent was able to see the evaluation session score. (PRSM-27617)

When the database is unavailable due to network connectivity or other database server problems,
the application throws a valid message (for example, SQL connectivity error) in the ULogger.
Previously, the application threw an invalid message. (PRSM-27616)

Two ADDP fields (ClientTimeout and ServerTimeout) are no longer missing from the configServer
table. (PRSM-27574)

The logic to export the QM Evaluation Session report to PDF has been modified to increase the size of
text that can be included, and to move longer text to the end of the report. (PRSM-27532)

The stored procedure that creates partitions based on call time has been enhanced to cover dates
further into the future. (PRSM-27270)

The monitor task that sends the event-based report now runs at regular intervals, as configured, and
uses the UTC time zone for validation. (PRSM-27036)

A problem where SMART could not load the events panel after a user opened a topic has been
addressed. The logic that fetches the audit status of topics and terms for interactions has been
improved. (PRSM-26990)

The database maintenance job has been enhanced to further optimize database performance.
(PRSM-26784)

When generating a report with multiple metadata filters, an unhandled exception is no longer thrown.
(PRSM-26581)
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Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.

Speech and Text Analytics 32


https://docs.genesys.com/Documentation/SPMI/8.5.5/Upgrade/Welcome

SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.512.12

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
07/30/20 Hot Fix X
What's New .
Helpful Links

This release contains the following new enhancements:
Releases Info

e SMART - SMART logs now include data about every SMART

operation processed during the Apply action. With this new » List of 8.5.x Releases
information users are now able to better understand the cause of . 85xK |
Apply failures. (PRSM-26938) 2 X Rnown ssues

* New logs were included to provide information about the time it
takes the Indexer to query Elasticsearch results and about the

time it takes Elasticsearch to query the results. (PRSM-26516) Product Documentation

* New logs were included to provide information about the API
search sub-tasks that fetch interactions from the indexer SpeechMiner
component and load them in the Interactions page when a user

performs an interaction search. (PRSM-26518) Genesys Products

List of Release Notes

Resolved Issues

This release contains the following resolved issues:

When you save a report that includes a metadata filter, the selected metadata filter is now saved
with the report. Previously, the metadata filter was not saved with the report. (PRSM-26931)

Silence Detection is now operative. (PRSM-26930)

When working with Trending, conflicting results no longer appear in the Trending page. (PRSM-26685)

Searching for an event now works correctly. Previously, it failed due to SQL Server collation.
(PRSM-26928)
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A deactivated time based report no longer continues to send reports. Previously, the deactivated time
based report sometimes continued to send reports. (PRSM-27053)

Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.512.11

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows
05/07/20 Hot Fix X
What's New :
Helpful Links
This release contains the following new features and Rel Inf
enhancements: eleases Info
* Login » List of 8.5.x Releases
* User partition loading is now configurable for the Login * 8.5.x Known Issues

function. By default, partitions are not loaded during login.
(PRSM-26583)

* Search Product Documentation

e Search performance results have improved due to recent
enhancements to the Indexer. (PRSM-26516) SpeechMiner

Genesys Products

Resolved Issues List of Release Notes

This release contains the following resolved issues:

When performing a Search, partition data is now cached and the Configuration Server is no longer
queried multiple times. (PRSM-26267)

If you install the latest SpeechMiner version without installing the .Net Core 3.1.3 prerequisite the
following message will now appear:

Setup could not detect Microsoft .NET Core Windows Server Host version 3.0.0 and
above. This is a prerequisite for installing the Web and indexer.

Previously, an incorrect message appeared instead. (PRSM-26579)
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Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.

Speech and Text Analytics 36


https://docs.genesys.com/Documentation/SPMI/8.5.5/Upgrade/Welcome

SpeechMiner 8.5.x Release Notes
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8.5.512.10

Speech and Text Analytics Release Notes

Release Release .. .
Date Type Restrictions AIX Linux
04/26/20 Hot Fix
What's New

This release contains the following new features and
enhancements:
* Language

e Training material was added to the following languages to
improve speech recognition:

» Dutch (nl-NL) (PRSM-26446)
¢ Argentina LATAM Spanish (es-AR) (PRSM-25922)
e UK English (en-gb) (PRSM-25576, PRSM-25299)
¢ Brazilian Portuguese (pt-BR) (PRSM-25520)

* Compatibility

* Genesys Interactions Analytics is now compatible with .NET
Core v3.1.x. For additional information, refer to Required
Third-Party Software (PRSM-26333, PRSM-26235,
PRSM-25641)

Resolved Issues

This release contains the following resolved issues:

Solaris Windows

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

The Content Browser now loads a relatively large list of interactions without generating an error.

(PRSM-26398, PRSM-25808)

When you create/edit a Category Distribution report, the Context menu now appears as expected

when you right-click a category in the Category list. Previously, the Context menu did not appear.

(PRSM-26163, PRSM-26087)
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When a form includes a question/group that was assignhed a weight with two digits after the decimal
point, the form can now be activated. (PRSM-26164, PRSM-25860)

All topics with a high confidence level are now highlighted in the interaction
transcription. Previously, not all such topics were highlighted. (PRSM-25931)

Reports are now created correctly in a Portuguese Brazil (pt-BR) system
when the globalDateTimeFormat is hh:mm tt. (PRSM-25912)

When you create an Evaluation Session, the filter options are now located correctly on the screen and
the user can now scroll the drop down filter.. (PRSM-25859)

When data is processed through Fetcher, the metadata field names are no longer converted to lower
case. (PRSM-26238)

The ConfigServer table is now updated with accurate information when a user logs into SMConfig
and the Authentication field in the SM Config Login window is left empty. Previously, this empty
field resulted in inaccurate information in the ConfigServer table. (PRSM-26223)

The French Canadian translation in the Saved Reports screen for the Last Modified and
Permalink fields is now correct. (PRSM-26165)

The French Canadian Genesys Interaction Analytics system no longer contains language and
grammatical errors. (PRSM-25822)

In Chrome sessions, the Last Updated field in the Monitor System tool is now displayed correctly.
Previously, this field appeared larger than it should. (PRSM-25885, PRSM-26246, PRSM-26411)

When playing an interaction, the Media Player now displays event icons. Previously, event icons were
not displayed for some of the interactions. (PRSM-25650, PRSM-26412)

Measures have been taken to improve the prevention of potential security threats to the web
application. (PRSM-26218)

When creating/editing an Ad-Hoc Evaluation, you can now select Required Forms. Previously, the
Required Forms were not available. (PRSM-26245, PRSM-26410)

When an Ad-Hoc evaluation is created, the server no longer receives the complete metadata set for
each interaction. Previously, the server receives the complete metadata set for each
interaction. (PRSM-26225)

Speech and Text Analytics 38



SpeechMiner 8.5.x Release Notes Release 8.5.5

Non-segmented interactions can now be exported from Speechminer Ul. Previously, they could not be
exported. (PRSM-26382)

When you create/edit an Evaluation Summary Report, the Name column now displays the full
evaluator name. (PRSM-26181)

Business alert emails can now be sent without issues to recipients who are Genesys users.
(PRSM-26341, PRSM-26254)

The Interaction Time column in the exported QM Session spreadsheet now contains the Local time.
Previously, this column contained the UTC time. (PRSM-26355, PRSM-26237)

Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.512.07/

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows
10/17/19 General X
What's New :
Helpful Links
This release contains the following new features and Rel Inf
enhancements: eleases Info
* Language » List of 8.5.x Releases
* Hindi (hi-IN) Speech Analysis and Text Analysis is now * 8.5.x Known lIssues

supported for Interaction Analytics (Speech and Text
Analytics). (PRSM-23002)

* Spanish numbers in the Spanish US language have been

added to the English US language and English US language Product Documentation
numbers have been added to the Spanish US language.
(PRSM-25608) SpeechMiner

e Training material is improved for UK English (PRSM-25495)
Genesys Products
e Training material is improved for US English (PRSM-25338)

« Training material is improved for Mandarin Chinese List of Release Notes
(PRSM-25685)

¢ Quality Management - The Edit all Evaluations permission was added to the system. Administrators
can now review evaluations associated with all users. (PRSM-25132)

Resolved Issues

This release contains the following resolved issues:

When an agent belongs to multiple business units (that is, the agent belongs to multiple parents in
the hierarchy), the agent filter in the Evaluation Session page does now functions as expected.
(PRSM-25805)

The Available Templates page in the SpeechMiner User Manual no longer includes broken links.
(PRSM-25626)
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Configuration of sensitive data privileges is now working as expected. (PRSM-25610)

When a text interaction contains a line similar to the following example, the Recognition task no
longer fails. For example, $90 + $9.75 + $3 equals $102.75 times 2 = $205.50, not $210.257
(PRSM-24088)

Interaction segments with long external IDs are now exported as expected. (PRSM-25612)

When you edit one form associated with a completed evaluation that includes multiple forms, the
answers associated with the forms you are not editing are no longer deleted. (PRSM-25582)

When an interaction contains Silence time in 2 or more different segments, the Silence time is now
calculated separately. Previously, in this scenario the interaction may have been calculated as
continuous when it shouldn't have been because the segments are different. (PRSM-25606)

In mixed mode (Genesys Interaction Recording + UConnector), a Quality Management > Evaluation
Session for text interactions can now be successfully completed. Previously, such a session could not
be completed. (PRSM-25455)

The Agent Comparison Report now includes correct data. (PRSM-25261)

When a Quality Management evaluation is exported as a PDF in a 8.5.512 environment, the Total
Score is no longer missing. (PRSM-25296)

Category name recognition is no longer case sensitive. Previously, category name recognition was
case sensitive. (PRSM-25632)

A backslash was added to an example URL address in the Installing SpeechMiner Components page
in the Administration Guide. Previously, the backslash was missing in the example URL address.
(PRSM-25559)

When working with a German Ul and a user deletes an evaluation, the confirmation message is in
German. Previously, the confirmation message was in Dutch instead of German. (PRSM-25414)

A note about how the sqlclr.sql file should be executed against the SpeechMiner Database was added
to the SpeechMiner Components > Installing the SpeechMiner Database > Deploying the SQL CLR
section of the SpeechMiner Administration Guide. Previously, this information was missing.
(PRSM-25411)

In the Additional Configuration > Remove SpeechMiner Metadata Fields section in the Administration
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Guide, quotes are no longer missing at the end of the SQL command. (PRSM-25400)

The Prerequisites section in the Upgrade SpeechMiner from any Version to 8.5.512 procedure in the
Upgrade Guide, now includes a link to the new Genesys Licensing Team online request tool.
Previously, this section included an in valid link to Genesys Licensing. (PRSM-25300)

In the Setting Up the SQL Server for SpeechMiner > Recommended SQL Server Configuration section
of the Administration Guide, the DB Script is now correct. (PRSM-25330)

Information about how to configure UPlatform to work with TLS 1.2 was added to the SpeechMiner
Administration Guide in the following section: Deploying SpeechMiner > Configuring SpeechMiner >
Additional Configurations > HTTPS for SpeechMiner > Securing SpeechMiner Connections >
Configure UPlatform to work with TLS 1.2. (PRSM-25260)

Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.

When upgrading to 8.5.512.07 you must upgrade to Elasticsearch 5.6.16.
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8.5.512.06

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
03/06/19 Hot Fix X
What's New .
Helpful Links

This release contains the following new features and
enhancements: Releases Info
» Quality Management Reports - You can now select Creation * List of 8.5.x Releases
Date, Updated date, and Completion date for three Quality
Management (QM) Reports (Agent Evaluation Comparison, Team
Evaluation Comparison, Evaluator Evaluation Comparison).

¢ 8.5.x Known Issues

* Quality Management Evaluations - You can now activate, but

not deactivate, Quality Management Calibration and one time Product Documentation
evaluations. As a result, multiple sessions are not created for
different dates. SpeechMiner

* SpeechMiner Connections - SpeechMiner now supports TLS Genesys Products

1.2. This requires that the server is configured to use TLS 1.2 and

the client trusts the server certificate. List of Release Notes

* SQL Support - SpeechMiner now supports MS SQL Server 2014
SP3.

Resolved Issues

This release contains the following resolved issues:

The roles an Administrator can grant to users is defined in the grantRoles field in the rolesTbl table
(Note: more than 100 roles may hinder expected performance). When the list of roles an
Administrator can control reaches the grantRoles field limit (256 characters), an error no longer
occurs when a user attempts to add roles to this list. (PRSM-25170)

When upgrading a system with a large amount of events to 8.5.512.00 or later, the upgrade process
no longer stops. (PRSM-25134)
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In a Coaching session, the Search option now functions as expected. (PRSM-25024)

When you modify and save a Saved Scheduled Report, the changes are now saved. Previously, when
a Saved Scheduled Report was changed and saved, the changes were not saved. Instead, after 15
minutes the changes were ignored and the specific Saved Scheduled Report reverted to its previous
configuration. (PRSM-24953)

SpeechMiner now supports TLS 1.2 when the server is configured to use TLS 1.2 and the client trusts
the server certificate. For this reason, SSL errors no longer occur and the UPlatform can now connect
to the SQL Server. (PRSM-24732)

When more than 1000 characters are entered as an answer to a Free Form Question in an evaluation,
the exported PDF is now formatted correctly and sentences are no longer missing. (PRSM-24815,
PRSM-24716)

When a SpeechMiner Dashboard is created the selected dashboard name is not limited to a specific
number of characters. Previously, when the user attempted to rename a saved SpeechMiner
Dashboard, the same Dashboard's hame was limited to 29 characters. (PRSM-24647)

Interaction Receiver no longer fails to process recordings with a valid .wav file format, no audio data
and duration = 0. (PRSM-24644, PRSM-25135)

When an Exploration search includes an interaction that has at least one empty channel (with no
recognized words in it), the Clustering task no longer stops functioning and produces results for the
Trending web page. Previously in such scenarios the Clustering task sometimes stopped functioning
with the following languages: (PRSM-24611)

e Dutch - NL

e Russian - Russia

¢ German - Germany

* Korean - Korea

* Japanese - Japan

¢ Mandarin - China

e Arabic - World Wide

e Turkish - Turkey

e Cantonese - Hong Kong

When a user who is not a part of any Configuration Server access group makes numerous failed
attempts to log in to SpeechMiner, other users in the system can log in normally. Previously in such
scenarios, other users might be unable to log in. (PRSM-24489)
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Measures have been taken to improve the potential security threats to the web application.
(PRSM-24483, PRSM-25220)

When some interactions are played in the Media Player and a beep sound is heard after a sequence
of numbers is played (that is, numbers that may indicate personal information), the Media Player will
not move back to the beginning of the interaction after skipping the sequence of numbers.
Previously, when some interactions were played in the Media Player, a beep sound was heard after a
sequence of numbers was played and the Media Player may have moved back to the beginning of the
interaction. (PRSM-24375)

When configuring the group weights in a Quality Management Evaluation Form with more than 15
questions, clicking Redistribute now evenly divides 100 among the groups. The group weights now
add up to 100. (PRSM-24323)

When a user (with the correct permissions) opens an Evaluation created by another user, the Search
filters in the Interaction tab no longer look like they have been reset. (PRSM-24039)

When you select N/A for a Quality Management form Scale question during an evaluation session, the
total score is now calculated as expected. (PRSM-23541)

The translation of the word "Any" in the French Canadian SpeechMiner User Interface (Ul) is now
correct. Previously, the word "Any" was translated incorrectly in the French Canadian SpeechMiner Ul.
"Any" was translated to "Quelconque" when it should have been translated to "Tous" (that is, if what
follows is masculine and in plural form). (PRSM-23675)

All strings in the French SpeechMiner Ul were translated to French. Previously, numerous strings were
not translated to French when the SpeechMiner Ul was translated to French. (PRSM-23668,
PRSM-24054)

When a QM Evaluation Session is exported, the text in the exported PDF is now formatted properly
when the Free Form contains &, <, or >. (PRSM-23612)

When a topic strictness is changed, the strictness assigned to the topic's terms with a custom
confidence is no longer changed as well. Previously, when topic strictness was changed, the
strictness assigned to the topic terms with a custom confidence was also changed. (PRSM-23522)

When working with a SpeechMiner Ul translated to Russian, the string for the on week of month
option is now translated to Russian. (PRSM-22771)
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Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.512.04

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
11/07/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
When you export a multisegment interaction, the exported file

includes all of the segments. Previously, not all of the segments SpeechMiner

were exported. (PRSM-24086)

Genesys Products

Measures have been taken to improve the prevention of potential

security threats to the web application. (PRSM-23967) List of Release Notes

Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.512.03

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
10/30/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
Coaching Session type configurations are now saved as expected.
(PRSM-24246) SpeechMiner

) ) ) Genesys Products
Reports no longer fail when a French Canadian system is

configured with an hh:mm tt time format and the Custom Date

Range filter is set before the report is run. (PRSM-24098) List of Release Notes

SMConfig now creates performance counters, which were previously unavailable. (PRSM-24094)

A mistake in the French Canadian SpeechMiner Ul translation has now been corrected. The word All
(for All Users), was translated to Tous. (PRSM-24068)

The Media Player in the French Canadian SpeechMiner Ul now includes the correct translations for the
mute/unmute. (PRSM-23793)

When search results return more than 100 interactions and you expand a multi-segment interaction,
more then 100 interactions are displayed if the Search results contain more than 100 interactions.
Previously, when search results were over 100 interactions and you expanded a multi-segmented
interaction, only the first 100 interactions were displayed when there are more than 100.
(PRSM-23547)
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Running the Coaching Summary report no longer causes an error. (PRSM-23540)

When the database contains usernames that include other usernames for an Ad-Hoc evaluation, only
the selected username will be added to the Ad-Hoc evaluation. Previously, if the database contained
usernames Tom, TomC and TomCruise and Tom was selected as an evaluator, Tom, TomC and
TomCruise were added as evaluators. Now only Tom is added as an evaluator to the Ad-Hoc
evaluation. (PRSM-23493)

The Agent External ID is no longer case sensitive. Previously, because the Agent External ID was case
sensitive the Agent name would disappear from the Agent filter if the capitalization of the specific
name was changed in GAX. (PRSM-22971)

Measures have been taken to improve the prevention of potential security threats to the web
application. (PRSM-23968, PRSM-23967, PRSM-24200)

Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.512.02

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows

10/02/18 Hot Fix X

What's New :
Helpful Links

This release contains the following new feature and Rel Inf
enhancement: eleases Info

» Screen Recording Context Menu Permission: A new Enable * List of 8.5.x Releases

Video Context Menu permission was added to the SpeechMiner Ul
to control access to the Video Context menu when performing a
right-click on a screen recording in the player. By default, the
Video Context menu is no longer accessible. If users need this
functionality, enable the permission in their assigned role.

¢ 8.5.x Known Issues

Product Documentation

SpeechMiner
Resolved Issues
Genesys Products

This release includes only new features and enhancements. .
List of Release Notes

Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.512.01

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
09/07/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
Trending report results are now available for new installations of
8.5.512. After upgrading to 8.5.512, Trending report results will be  SpeechMiner
based on Trending terms available before and after the upgrade.
Previously, Trending terms were only based on Trending terms

n Pr t
available before the upgrade. (PRSM-23741) Genesys Products

List of Release Notes

Measures have been taken to improve the potential security
threats to the web application (SpeechMiner Ul). (PRSM-23728 and PRSM-23930)

The SpeechMiner Russian training material is now supported by UTF-8 variable width character
encoding. (PRSM-23566)

Chrome no longer disconnects when you try to search for and/or listen to a long recording.

The Wave graph is not visible for long recordings and the duration of long recordings is configurable.
To set the wave graph visibility change the WaveGraphCallDurationLimit parameter in the
webServiceParams table. Note: It is recommended to limit the visibility to recordings of the Media
Player wave graph that are no longer than 30 minutes. If the value of the
WaveGraphCallDurationLimit parameter is longer than 30 minutes, users may experience
performance issues.(PRSM-23560)

An exception is no longer raised in the browser when an Evaluation Session search result contains a
session associated with a user that no longer exists in the system. (PRSM-23475)
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Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.512.00

SpeechMiner 8.5.x Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
07/11/18 General X
8.5.512 Release .
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

* List of 8.5.x Releases
e The SpeechMiner connection to the Configuration Server now

uses ADDP (Advanced Device Discovery Protocol). For details see * 8.5.x Known Issues

ADDP.
¢ Interaction Search Improvements:
e Search Results - Total Matches: When a search is Product Documentation
performed in the Interactions grid, the search results now
show the total number of interactions within the system that SpeechMiner

match the specified filter criteria. [+]
Genesys Products

As shown in the following image, previously only the number of interactions List of Release Notes
returned was shown on the menu :

Interactions (1000 hd

Now the menu contains information about the number of interactions returned out of the number that match the search
criteria in the server.

Interactions (1,000 of 21,941) ~

* Pop-Out Media Player: Users can now pop out multiple instances of the Media Player in separate
Media Player windows to allow multiple interactions to be accessed at the same time. This also

allows users with screen recordings to stretch out the Media Player to see more detail in the screen
recording.

* Quality Management Improvements:

* Improved Scheduling and Distribution Options: A number of changes have been made to the
options available for Evaluation Session scheduling and distribution:
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* Changes to Recurrence Parameters: Recurrence options are now Days, Weeks and Months.
The Hours and Minutes options have been removed to reduce the chances of creating too many
unneeded evaluation sessions.

¢ Distributed Agent Evaluation Improvement: The Exactly option is now available for
Distributed Agent Evaluation types. This allows a specific number of interactions to be selected
for evaluation for a specific set of agents for a given time (for example, in a month).

¢ Maximum Values for Exactly: The system now has limits on the maximum value for Exactly.
These are 1000 for Shared and Distributed Interaction Evaluation types and 30 for Distributed
Agent. Note that these values are changeable in the database.

¢ Multiple Evaluators Selection: It is now possible to select multiple Evaluators for Distributed
Interaction, Distributed Agent and Shared Evaluation types. When multiple Evaluators are

selected, the resulting Sessions will be evenly distributed across Evaluators in a round robin
fashion.

* Evaluation Session Grid Search: The Search Filter for Evaluation Sessions has been updated and
now users can select the type of sessions (Active, Archived, Expired) and other filter criteria, prior to

submitting a search. Previously, every change resulted in a new search that could cause delays in
loading time.

* Evaluation Session PDF Export Improvements: When exporting an Evaluation Session as a PDF
report, you can now see all text that was entered in a Free Form answer field. In addition, all
comments associated with the underlying interaction are displayed in the PDF report.

* Default Form to 100%: To reduce clicks and save time when performing an evaluation, users can
now select a toggle to default all answers in all forms within an Evaluation Session to 100% (or the
maximum possible score). The default behavior when initially loading the form is configurable in the
database. Also, a new permission to allow access to this toggle has been added. [+]

The following image shows the new Default scores to 100% option in the Evaluation Session page:

Default scores to 100% D

* Trending Improvements: (In a Genesys Interaction Analytics GIA deployment). A new View Trending
Cluster Task Information permission was added to SpeechMiner Permissions.

¢ Clustering Information Visibility: Users now have more flexibility about who can view and edit
Clustering Tasks and their related information on the Trending page. Now, users with the View
Clustering Task Information permission can view information without the need for elevated
permissions to edit these tasks.

* Language Enablement

* Recognition of Russian (ru-RU) and Russian Ul (ru-RU) support has been enabled. Genesys
Interaction Analytics (GIA) now operates on voice interactions and text interactions in Russian.

* The Turkish Language pack (tr-TR) for interaction analytics has been improved with additional
training material.

Speech and Text Analytics 54



SpeechMiner 8.5.x Release Notes Release 8.5.5

Resolved Issues

This release contains the following resolved issues:

The Log level in the Indexer is now set to the defined level. Previously, the Log level in the Indexer remained info even when it
was changed. (PRSM-21895)

When editing an Evaluation with a One Time schedule the selected interactions now appear in the Evaluation Summary.
(PRSM-23177)

After selecting the Select All checkbox in the Batch Actions menu in the Interaction grid, the number of the selected
interactions in the Interactions grid is now the same as the number shown in the Batch Actions menu. (PRSM-23053)

Interaction search time is now faster for large systems. (PRSM-22990)

In SMConfig > Sites & Machines > Properties > Language, French Canadian is written French - Canada. Previously,
French Canadian was written Canadian French. (PRSM-22796)

Improvements have been made to the the Canadian French Ul translation. (PRSM-22793)

When Agitation is turned on and Agitation events are found, transcriptions now appear for the selected time frame.
(PRSM-22660)

sp_createAgentsFromPartitions can now correctly handle a case where the partition matches an existing agent’s name but not
their external ID. (PRSM-22575)

The Indexer Microservice Migration tool does now contains logs. (PRSM-22569)

When there is a large number of users in the system (approximately above 10k), and each user is assigned to multiple Access
Groups, logging into SpeechMiner no longer takes longer than expected and does not cause a timeout. (PRSM-22519)

Users with Read/Write permissions can now delete Quality Management Evaluations and Sessions when the evaluations are
created by other users. (PRSM-22433)

Column selection is now saved in all Quality Management grids and in the Saved Trending Filter grid. (PRSM-22323)

Chrome no longer crashes when a long interaction is played back. But, the .wav graph is not displayed in the Media Player for long
interactions. (PRSM-22317)

Special characters in a Saved Trending Filter description now appear correctly in the Ul. (PRSM-22259)

Using the Number of segments filter in SpeechMiner Ul Reports no longer causes incorrect search results. (PRSM-22257)

When interactions are exported from SpeechMiner Ul without audio files, the event is now written in the usereventstbl in the SQL
table. (PRSM-22256)

When you drill down from the Trending page to the related words chart, the word NULL no longer appears in the Terms summary
and tool tip in the Related Words pop-up. (PRSM-22194)

The Cluster Task toggle option now appears in the Cluster Task column. Previously, the option did not appear in the column and
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instead the term false appeared in the Cluster Task column. (PRSM-22121)

During the recognition process of some of the audio files the Emotion detection component now no longer throws an exception
when computing the pitch. As a result, the audio files no longer fail the recognition process and appear in the Search Results list.
(PRSM-22094)

When selecting the web language for the Ul, Cantonese now appears in in SMConfig > Sites & Machines > Properties as
Cantonese. Previously, Cantonese appeared as Cantonese - Hong Kong. (PRSM-22081)

In SMConfig > Sites & Machines > Language Selection the name Netherlands is now spelled correctly. (PRSM-22080)

The headings in the table in the Agent Comparison by Segment report are now fully visible. (PRSM-22078)

When working with Internet Explorer the user can now re-login after the session has expired. (PRSM-22068)

Report results are now accurate when more than one metadata value for the same metadata filter is configured. (PRSM-22065)

Numbers at the end of a recording (that is, at the end of a channel) are now redacted. (PRSM-22059)

When a comma is entered in a Quality Management Free Form field, it now appears as it should in the exported evaluation
.csv file. (PRSM-21896)

When you create or edit an Evaluation and you clear the values in the Segments and Duration filters in the Interaction tab
(without clicking the Reset button), the previous segment and duration values no longer appear after you click Search.
(PRSM-21876)

When you click the Percentage column or bar to drill down in the Predictive Elements report, interactions are now listed
according to the selected category and Target Category. (PRSM-21874)

When you select to Drill Down in the Category Bubble Chart report, the results associated with the Bubble category and the
X Axis or Y Axis are now displayed. (PRSM-21873)

Copying the Permalink link from Google Chrome and pasting the link in Internet Explorer 11 no longer results in a blank
page. (PRSM-21847)

Explore > Search results do now accurately reflect the Segment and Duration filter configurations. (PRSM-21846)

An irrelevant message no longer appears after you select to create a new evaluation in the Evaluation Manager page.
(PRSM-21812)

The system does now creates Evaluation Sessions for evaluations that were created with the following Interaction Criteria:
* Agent = Unknown

» A specific Interaction ID that belongs to an interaction whose agent is unknown. (PRSM-21790)

Saved reports are no longer missing from the database. (PRSM-21742)

After the Search Filter is run, the Metadata filter displays the display name. Previously, after the Search Filter was run, the
Metadata filter displayed the field name instead of the display name. (PRSM-21658)
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When searching for interactions all terms added to the Terms & Topics field are now highlighted in the transcript. Previously,
when searching for interactions and two or more terms were added to Terms & Topics field, only the last term that was added
was highlighted in the transcript. (PRSM-21651)

An error no longer appears when you click a bubble in a Custom Exploration chart. (PRSM-21276)

Upper and lowercase letters now appear correctly in SMART Categorization and interactions are now categorized correctly.
(PRSM-21057)

With the introduction Elasticsearch (as of 8.5.511), Remote Search is no longer in use. (PRSM-20541)

When the following characters are entered in the Search Filter > Comments field and a search is run, the search is now
performed and an error no longer occurs in the Ulogger: @ \ '\ 2\ .\ *\ # \ $. (PRSM-19569)

When Elasticsearch or the Indexer is down, the Platform no longer prints the same error numerous times to the Event
Viewer. (PRSM-21786)

Special characters (for example, Japanese letters), now appear clearly in reports. (PRSM-16505)

Measures have been taken to improve the prevention of potential security threats to the web application. (PRSM-21812,
PRSM-23212, PRSM-22579, PRSM-22578, PRSM-22577, PRSM-22576, PRSM-23087, PRSM-23059, PRSM-22985, PRSM-22920,
PRSM-22919)

Upgrade Notes

To upgrade to release 8.5.512, refer to the SpeechMiner 8.5.x Upgrade Guide. .
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8.5.511.00

SpeechMiner 8.5.x Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
03/27/18 General X
What's New .
Helpful Links
This release contains the following new features and | f
enhancements: Releases Info

e List of 8.5.x Releases

* Interaction Search Improvements: « 8.5.x Known Issues

* Search for Interactions with Screen Recording (In a
Genesys Interaction Recording GIR deployment): It is now
possible to search for interactions that include or exclude
screen recordings. Interactions that have an associated
screen recording are tagged with the Screen Recording tag.
This feature can be used in conjunction with Quality .
Management (QM) to exclusively perform evaluations on SpeechMiner
interactions that have screen recordings.[+]

Product Documentation

Genesys Products

The following Tag section Explore > Search page includes a Screen List of Release Notes
Recording tag. Previously, this tag did not appear in this list:
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Tags

All Tags ~

All Tags
# Non-deletion
[+ ® Screen Recording
Evaluated

Compliance
Training
LOB

Performance

Note: This feature only works under the following conditions:

e Only for interactions that have been added to the system after SpeechMiner 8.5.511 was
installed.

e The system must be configured with an external Recording Web Services (RWS) to enable
screen recordings.

¢ The solution requires Recording Web Services (RWS) version 8.5.202.70 or later and Recording
Muxer Script version 8.5.285.68 or later.

e Muxer must be configured to label recordings with screen recordings.
* Filter by Minute Granularity: You can now search for interactions within the Interactions and

Events grids with minute granularity. Also, the filter within the QM Evaluations Manger and
Trending can now be specified with minute granularity. [+]

As seen in the following image the Custom date filter now contains hour and minute values:
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Date Range 09/01/18 03:06 -
Custom b
From: 09/01/18 ‘ 03:06| C) ‘
To: 04 o7

05 08
06 09
o7 10
0g 11

Previously, the Custom date filter did not contain hour and minute values.

Date Range 00:00 - 00:00
Custom hd
From: 00:00 ~
0000
To:
01:00
02:00 L
03:00
04:00 +

* Search Email Headers: The search capability has been extended to include additional filters for
email headers. You can now search for emails according to header fields including To, From, Cc and
Bcc fields. After upgrading to 8.5.511 you must re-index text interactions in order to be able to use
the new email filters for existing data.[+1]

The following Email Search section has been added to the Explore > Search page:
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Email Search
Include From S
From p
To
Cc I
Bco

¢ Support for Elasticsearch: The solution no longer uses Lucene to store the index for search and
retrieval purposes. The solution now uses Elasticsearch, which is a more scalable search engine,
based on a distributed storage that streamlines the backup process and provides robust functionality
around data integrity. As a result, all index data must be migrated from Lucene to Elasticsearch as part
of the upgrade. For details, refer to Install, Configure and Run Elasticsearch

* Quality Management Improvements:

* Form Weighting: It is now possible to provide up to two decimal places when assigning weights
within forms, both at the group level and the question level. [+]

As seen in the following image, you can now enter a value with 2 decimal places:

Weighting for Weighting test

Group1 3334
Group2 3323
Group3 33.93

Redistribute Cancel m

Previously, you could only enter a whole number.
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Weighting for Weighting test

Group1 34
Group2 13
Group3 33

Redistribute Cancel “

* Export Completed QM Sessions Improvement: The exported data is now organized such that
each question and related score are organized in separate columns for every group and form within
the selected evaluations. Also, the export is limited to a maximum of 10 selected evaluations for
the chosen date range. Previously, all evaluations where exported. [+]

As seen in the following image, you can now select up to 10 evaluations:

Export Completed QM Sessions

Metadata Fields Date Range

Evaluation Session Al i
Agent Mame

Evaluator

Interaction ID Evaluations (maximum 70)

External ID ;
Segment 3 Evaluations selected ~
Interaction Time

Duration

Program

Form

Group

Question

Answers

*Downloading all completed QM sessions for the 3 selected Evaluations

Previously, you could not select the evaluations for which you wanted to export evaluation data.
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Export Completed QM Sessions

Exported Fields Date Range

Evaluation Session id All -
Evaluation Session

Agent Mame

Evaluator

Interaction 1D

External ID

Segment

Interaction Time

Duration

Program
Form:Group:Question:Answer
Metadata

*Downloading all completed QM sessions

¢ Text Interaction Improvements:

* Storage of Text Interactions (In a Text Analytics GIA deployment): The solution now stores text
interactions in the file system instead of the database. This includes encryption of the file on disk,
if configured, as well as a unique value for retention policy period for these text interactions.
Migrating new and existing text interactions from the database to the file system, frees up a large
amount of database space.

* Text Attachments (In a Genesys Interactions Analytics GIA deployment): The solution now stores
and analyzes text attachments that are part of a text interaction. The system will analyze the
content of the attachment in the same way it analyzes text interactions (for example, topic
classification, searches and so on). The text attachment is displayed below the text interaction
transcript with Attachment in the title. For example: [+]

@ Attachment: purchase-return-form_customer txt

* Interaction Type: You can now search for interactions according to the new Text interaction type.

* Raw Text Interactions Support (In a Text Analytics GIA deployment): The solution can now
analyze raw text interactions (that is, .txt files) in the same way it analyzes audio, email and chat
interactions. You can also search for these interactions using the new Texts interaction type
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¢ In-Line Audit of Topic Events (In a Genesys Interaction Analytics GIA deployment): Users can now
audit topic events for Interaction Analytics in-line within the transcription viewer from the search page

for all interactions types. This option is only available is the user has the correct privileges assigned.
[+]

As seen in the following image events now appear in an interaction transcript with the option of marking the event with an audit
value:

Q w || |x

Previously, the transcript events did not have the audit value options:.

0

* Trending Improvements: (In a Genesys Interaction Analytics GIA deployment)

* New Words More Prominent: In Trending reports, when new terms are uncovered they are now
shown more prominently in Top Movers.

Layout Options: User now have more flexibility in how the data is viewed on the Trending page.
Users can now select one of three different layout options: Combination, Chart or Table.

Combination shows the chart and table together, while Chart or Table show only one or the other.

Also, the option to Ignore Blacklist is included as part of the layout options drop down. The
selected option is persistent across sessions. [+]

The new Trending page combination option includes a Layout menu.

Trending Report, Last refreshed on: N/A |

Layout: E Combination L “

E Combination

& Chart

EE Table

EI Ignore Blacklist

The previous Trending page options appeared as follows:
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b

Trending Report, Last refreshed on: N/A

Ignore Blacklist Show chart data @) “

* Reset Filters: You can now reset the trending filters to the default state in Trending. [+]

The Trending filter now contains a Reset button as shown in the following image next to the Run button.

Max terms per
period 50

Show Advanced Filters

The previous Trending Filter did not contain a Reset option next to the Run button, as shown here:
LTI TR I Ll =

Secs

Max terms per
period 50

Show Advanced Filters

The Search Filter page now contains a Reset button as shown in the following image next to the Run button.
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The previous Search Filter page contained a Clear Filters option as shown here:

Clear Filters Save as m

e Language Enablement:

* Recognition of Dutch (nl-NL) and Dutch (nI-NL) Ul support has been enabled. Genesys Interactions
Analytics (GIA) now operates on voice interactions and text interactions in Dutch.

e The US Spanish Language pack (es-US) has been updated to include improvements for Colombia
and Mexican Spanish dialects.

¢ PureConnect: Product materials have been updated to reflect the integration of Genesys Engage
Genesys Interaction Analytics and Genesys Engage Quality Management with PureConnect.

Resolved Issues

This release contains the following resolved issues:

Measures have been taken to improve the prevention of potential security threats to the web
application. (PRSM-21292), (PRSM-21278), (PRSM-21277), (PRSM-21270), (PRSM-21149),
(PRSM-21134), (PRSM-20945), (PRSM-20885), (PRSM-20884), (PRSM-20883), (PRSM-20882),
(PRSM-20881), (PRSM-20879), (PRSM-21332), (PRSM-21302), (PRSM-21301), (PRSM-21176)
(PRSM-21321).

When you run a report with a Metadata value that includes a + sign, the report now returns data.
Previously, no data was returned. (PRSM-20742)

SpeechMiner Ul now closes all connections to Recording Web Services (RWS) and Recording
Crypto Server (RCS). Previously, these connections were not closed and SpeechMiner Ul
periodically became unresponsive after a prolonged period of work. (PRSM-20839)

A user can no longer play audio interactions from the cache when he/she is not authorized in
Recording Crypto Server (RCS). (PRSM-21222)

When working with SpeechMiner 8.5.510 and a record duration is set to null in the
WildcardGrammars table, the system no longer crashes. (PRSM-20738)

When you search for a term using the Trending > Search Results > Related Words option, the
specific term is now highlighted in the transcript if it is part of an audio interaction. (PRSM-18449)
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When you select the Related Words option from a Explore > Search > Transcript page, the
menu for the root term in the Related Words chart now contains the number of interactions in
which the term was found. Previously, this information was not available. (PRSM-18380)

When searching for a specific event, SpeechMiner Ul no longer accepts nonnumerical characters in
the Interaction ID field. (PRSM-20462)

The current date is no longer missing from the Start and End dates in the Scheduled Report
window. (PRSM-20443)

In Google Chrome, if you create an Evaluation Session with a Form name that contains 200
characters, the Show Score and Save options are now aligned properly on the screen.
(PRSM-20424)

When editing a report, the Check all and Uncheck all filter options now select all the checkboxes
and clear all the checkboxes, respectively. (PRSM-20532)

The +More and -Less options are now available when a long Form question description is entered
without spaces between the characters. (PRSM-20522)

When working with an Arab language interface, the direction of the brackets in the Export window is
now correct. (PRSM-20523)

Text interaction transcripts now open successfully if you search for a term that includes parentheses.
Previously, the Loading Transcription message did not disappear and the transcription was not
opened. (PRSM-20504)

When selecting the Add in the Interaction List page, the Add List button is not enabled until a
session is selected. Previously, the Add List button was enabled even though a session was not
selected. (PRSM-20521)

Media Player keyboard shortcuts are no longer documented in the SpeechMiner Ul online help
and user manual. Previously, the documentation contained incorrect information about Media Player
keyboard shortcuts. (PRSM-20540)

When a date format is not US format (MM/dd/yyyy), and you use Custom dates in the date control,
you can now type the dates. Previously, you could not type the dates and you had to pick the dates
using the calendar provided. (PRSM-20552)

By default, you can create Evaluation Sessions every five minutes (minimum). Previously, when
one minute was selected in the Occur every # option in the New Evaluation page, Evaluation
Sessions were created every five minutes and not every one minute. (PRSM-20463)
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The browser tab title now contains the correct name. Previously, the Browser tab title included the
terms SpeechMiner - Sessions when you selected Coaching > Sessions. However, if you selected
one of the sessions in the Coaching Sessions page, the tab title changed to SpeechMiner when it
should have remained SpeechMiner - Sessions. In addition, the browser tab title included the
terms SpeechMiner - Search when you selected Explore > Search. However, if you selected
Admin > Tools > Export Completed QM Sessions, the tab title stayed SpeechMiner - Search
when it should have been SpeechMiner - Export Completed QM Sessions. (PRSM-20319)

The Blacklist now adds new terms in alphabetical order. Previously, terms were was added to the top
of the list and not in alphabetical order. (PRSM-17548)

When working with a Trending Cluster Task, the total number of Agents shown in the Cluster task
details now matches the total number of Agents selected in the filter. (PRSM-19652)

It is not possible to log into SMConfig and SMART when the Database Server Username and
Password contain a semicolon (;) and/or an equals (=) symbol. (PRSM-20149)

Agent hierarchy is now sorted at the second-level hierarchy and above. (PRSM-20711)

In the Partitions filter, the workgroup tree no longer duplicates workgroups that have sub-trees.
(PRSM-21224)

After you select an interaction in the Search Results grid, the checkbox is no longer invisible.
(PRSM-21205)

The Date and Time format configuration in the database is now used when the user manually inserts
the date. Previously, the , instead of selecting the Date and Time format configuration in the
database was only used when the date and time were selected using the date picker. (PRSM-21058)

If the date format in the webServiceParams table does not match the date format in your server,
the Related Words feature is not affected. Previously, such a scenario caused an error to appear
when viewing Related Words. (PRSM-21115)

The Index Stop Word list for the SpeechMiner Turkish language pack has been improved. As a result
of this fix, when using the Turkish language pack, SpeechMiner search and phrase recognition has
improved. (PRSM-21199)

If you select a large number of agents are selected in the Agent filter in the QM Evaluation
Sessions page, the Agent filter no longer appears empty due to the selection size. (PRSM-20710)

The Evaluation Summary Report now includes the Pager option when the report consists of more
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than 20 agents. Previously, the report did not show more than 20 rows, even if the report contained
more agents. (PRSM-21769)

Audit values that have been cleared in the SpeechMiner Ul are no longer counted as part of the term
details in SMART. (PRSM-21177)

An Ad-Hoc Evaluation Session can now be created for interactions without agent information.
(PRSM-21090)

When sending a report by email, the Recipient field now supports Auto-complete. (PRSM-20799)

Interactions in the Indexing queue that are indexed with status=1 no longer remain in the queue
for several hours. (PRSM-20557)

When trying to search for interactions that include a specific comment together with a specific type
(for example, bad, good and neutral), the system no longer retrieves interactions that include the
comment and type when they are not together. (PRSM-11947)

UPlatform continues to work after the machine name is chagned to Fully Qualified Domain Name
(FQDN). Previously, changing the machine name to FQDN cause the UPlatform not to work.
(PRSM-19687)

When creating a search without configuring the Agent and Date filters, selecting to view the search
results in the Screen Recordings grid no longer throws a property length exception to the browser
console log even though the feature functioned as it should. (PRSM-21693)

The Tools > Metadata Manager page no longer appears blank intermittently. Previously, data
appeared only after the page was refreshed. (PRSM-21657)

All pages visited by a user in SpeechMiner are now logged for auditing. (PRSM-16598)

Report errors are no longer generated if the SQL Server collation is different from the SpeechMiner
database collation. (PRSM-21807)

The Rewind option now works when the silence duration is more than five seconds during an
interaction playback. (PRSM-20581)

The calendar is now translated properly if you use the SpeechMiner application with the Canadian
French language pack. (PRSM-21774)
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The SpeechMiner Ul with Canadian French localization is now completely translated.
(PRSM-21089)

Comments added to an interaction within the first five seconds of playback are now displayed.
(PRSM-21251)

SpeechMiner now correctly retrieves users from the Configuration Server. As a result, a loading error
no longer occurs when you play back an interaction in SpeechMiner. (PRSM-20788)

The Usage Tracking report now correctly shows a call as played when the call was played from the
Explore > Interactions grid in Google Chrome in a Recording Only license mode. (PRSM-20707)

The date of a Scheduled report is now visible in the Schedule Report calendar. (PRSM-20701)

The Dashboard > My Messages sorting option now works as expected. (PRSM-20594)

The comment tool tip now shows the entire comment when a comment contains the maximum
number of allowed characters. (PRSM-20589)

When creating an evaluation, the forms listed under Evaluation Summary > Forms now remain
aligned next to their respective X when you scroll up/down the list. (PRSM-20556)

When working with Canadian French or Dutch SpeechMiner recognition languages the Ulogger no
longer throws an error message about missing files. (PRSM-20484)

When working with Internet Explorer 11, the following Report editing steps no longer cause the
filter selection to disappear:

1. Select to edit a report.

2. In the report page open a filter and right-click.

3. If a menu appears (since not all filters have menus), select an option. The filter no longer closes when it
shouldn’t.

(PRSM-20381)

The Sorting option is now correctly shown at the top of the column headings in the Quality
Management grids. The option is no longer missing. (PRSM-19917)

If two users apply a tag to the same interaction at the same time, the first user to save the tag no
longer loses his/her changes. (PRSM-19259)
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An error no longer occurs during SpeechMiner Parsing. Previously, during SpeechMiner Parsing, the
system assumed a specific Screen Recording structure and specific values and, this structure and
these values were not present, an error occured. (PRSM-17498)

Upgrade Notes

To upgrade to release 8.5.511, refer to the SpeechMiner 8.5.x Upgrade Guide. .
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SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.510.35

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
11/22/20 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
There is now a configurable retry mechanism when loading
persons and roles from the configuration server. The retry SpeechMiner
mechanism is configured using the LoadRolesRetry field

(default value 3) in the configServer table. (PRSM-27303) Genesys Products

There is now a timeout for configuration server operations. The List of Release Notes

configuration server operations timeout is configured using the
ConfigSrvrTimeout field (default 30 seconds) in the configServer table. (PRSM-27263)

A deactivated time based report no longer continues to send reports. Previously, the deactivated time
based report sometimes continued to send reports. (PRSM-27229)

When the database is unavailable due to network connectivity or other database server problems,
the application throws a valid message (for example,SQL connectivity error) in the ULogger.
Previously, the application threw an invalid message. (PRSM-27207)

Report results are now accurate when more than one metadata value for the same metadata filter is
configured. (PRSM-27193)

When generating a report with multiple metadata filters, an unhandled exception is no longer thrown.
(PRSM-26970)
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When you save a report that includes a metadata filter, the selected metadata filter is now saved
with the report. Previously, the metadata filter was not saved with the report. (PRSM-26969)

SMConfig now includes a validation that ensures that the index and backup folders are not on the
same computer. (PRSM-26967)

The maximum number of roles that can be granted to a user has been increased (PRSM-26966)

All topics with a high confidence level are now highlighted in the interaction transcription. Previously,
not all such topics were highlighted (PRSM-26937)

When creating/editing an Ad-Hoc Evaluation, you can now select Required Forms. Previously, the
Required Forms were not available. (PRSM-26936)

A new permission named Edit All Evaluations was added to the system. Administrators can now
review evaluations associated with all users. (PRSM-26629)

SpeechMiner Auditing now includes the following events: Create, Delete, Save, Export, Complete,
Archive, Cycle Interactions. (PRSM-26626)

The lower part of the Evaluation Summary report now displays one value for each session per user.
Previously, the Evaluation Summary report displayed the session per user value twice. (PRSM-26408)

Non-segmented interactions can now be exported from SpeechMiner Ul. Previously, they could not be
exported. (PRSM-26377)

Failed logins no longer occur due to a failed connection to the Configuration Server. (PRSM-26327)

When working with Exploration an error no longer occurs when a bulk clustering task is imported.
(PRSM-26179)

When an Evaluator completes an evaluation session and notifies the agent, the agent receives an
Action Item. Without appropriate permissions, the agent can no longer see the evaluation session
score. Previously, the agent was able to see the evaluation session score. (PRSM-26096)

Business alert emails are sent to the recipient when the recipient is a Genesys user. (PRSM-25952)
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Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.510.30

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
01/13/20 Hot Fix X
What's New .
Helpful Links

This release contains the following new features and
Releases Info

enhancements:
* Installation/Upgrade Prerequisite * List of 8.5.x Releases
 Before installing/upgrading SpeechMiner, you must install * 8.5.x Known Issues

.NET 4.7.2. (PRSM-25972)

Product Documentation
Resolved Issues

SpeechMiner

This release contains the following resolved issues:
Genesys Products

When using the SpeechMiner Ul to edit tags associated with an List of Release Notes
interaction that has screen recordings, the user will no longer

receive an error. Previously, users received an error that stated that the tags were not updated, even
though they were. (PRSM-25856)

When a user logs into SMConfig, the ConfigServer table is now updated with accurate information,
when the Authentication field in the SM Config Login window is left empty. Previously, this empty
field resulted in inaccurate information in the ConfigServer table. (PRSM-25740)

The Interaction Time column in the exported QM Session spreadsheet now contains the Local time.
Previously, this column contained the UTC time and not the Local time. (PRSM-25328)

When running the Agent Evaluation Comparison or Evaluator Evaluation Comparison reports,
the Average Score is no longer missing from the Agent\Evaluator table. (PRSM-25786)

When an Ad-Hoc evaluation is created, the server no longer receives the complete metadata set for
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each interaction. Previously, the server receives the complete metadata set for each
interaction. (PRSM-25690)

Measures have been taken to improve the prevention of potential security threats to the web
application. (PRSM-25972)

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.510.28

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
08/25/19 Hot Fix X
What's New .
Helpful Links

This release contains the following new features and
Releases Info

enhancements:
* Language » List of 8.5.x Releases
 Spanish numbers in the Spanish US language have been * 8.5.x Known lIssues

added to the English US language and English US language
numbers have been added to the Spanish US language.
(PRSM-25589)

Product Documentation

SpeechMiner

Resolved Issues
Genesys Products

This release contains the following resolved issue:

List of Release Notes

When you select N/A for a Quality Management form Scale question during an evaluation session, the
total score is now calculated as expected. (PRSM-25627)

When a text interaction contains a line similar to the following example, the Recognition task no
longer fails. For example, $90 + $9.75 + $3 equals $102.75 times 2 = $205.50, not $210.257
(PRSM-25602)

When an interaction's duration = 0 the Media Player now displays a "No Audio Available" message.
Previously, there was no indication on the Media Player that an interaction with duration = 0 did not
contain audio. (PRSM-25169)

When you playback an interaction, the wave graph now loads for a recording with a long duration.
Previously, the wave graph did not load for a recording with a long duration and when this happened
you could not click the wave graph to move to a different portion of the interaction. (PRSM-24296)
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When the Index Backup task fails, the system now automatically attempts to perform a backup.
Previously, when the Index Backup task failed, the system did not automatically attempt to perform
another backup and you were forced to manually restart the system to backup the index.
(PRSM-25185)

The Available Templates page in the SpeechMiner User Manual no longer includes broken links.
(PRSM-25652)

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.510.27

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
07/21/19 Hot Fix X
What's New .
Helpful Links

This release contains the following new features:
Releases Info

* Training Material - Language Enablement - Training material
is now available in UK English. (PRSM-25585) e List of 8.5.x Releases

* Quality Management - Reports - It is now possible to select a * 8.5.x Known Issues
Creation Date for three QM Reports (Agent Evaluation
Comparison, Team Evaluation Comparison, Evaluator Evaluation
Comparison). (PRSM-24491)

Product Documentation
SpeechMiner
Resolved Issues ’

Genesys Products
This release contains the following resolved issue:

List of Release Notes

Configuration of Sensitive Data privileges now works as
expected. (PRSM-25452)

Category name recognition is no longer case-sensitive. Previously, category name recognition was
case-sensitive. (PRSM-25434)

When an SQL timeout exception occurs, interactions that are being indexed at the same time are
now re-entered into the Index queue. Previously, when an SQL timeout exception occurred,
interactions that were being indexed at the same time were not re-entered into the index queue.
(PRSM-24502)

Interaction Receiver no longer fails to process recordings with a valid .wav file format, no audio
data, and duration = 0. (PRSM-25135)

Interaction segments with long external IDs are now exported as expected. (PRSM-25470)
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UPlatform continues to work after the machine name is changed to FQDN. Previously, changing the
machine name to FQDN prevented the UPlatform from working. (PRSM-25295)

When you edit one form associated with a completed evaluation that includes multiple forms, the
answers associated with the forms you are not editing are no longer deleted. (PRSM-25501)

When an interaction contains Silence time in 2 or more different segments, the Silence time is now
calculated separately. Previously in this scenario, the interaction may have been calculated as
continuous when it should not have been because the segments are different. (PRSM-19715)

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.510.24

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
04/30/19 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issue:

Product Documentation
When data is processed through Fetcher, the metadata field
names are no longer converted to lowercase. (PRSM-25191) SpeechMiner

. . ) Genesys Products
In mixed mode (Genesys Interaction Recording + UConnector), a

Quality Management > Evaluation Session for text interactions
can now be successfully completed. Previously, such a session
could not be completed. (PRSM-25116)

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.510.23

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
02/22/19 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issue:

Product Documentation
When an agent belongs to multiple business units (that is, the

agent belongs to multiple parents in the hierarchy), the agent SpeechMiner
filter in the Evaluation Session page now functions as expected.
(PRSM-25205) Genesys Products

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.510.22

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
01/29/19 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
When playing an interaction, the playback is continuous until the
end of the interaction. Previously, for some interactions the SpeechMiner
playback rewinded and looped back to the beginning of the

interaction. (PRSM-24883) Genesys Products

- List of Rel Not
Changes made to an existing saved scheduled report are now istorRelease Notes

saved. Previously, changes made to an existing saved scheduled
report were viewed as saved, but the changes were not saved. (PRSM-24727)

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.510.21

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
12/31/18 Hot Fix X
What's New .
Helpful Links

This release contains the following new features:
Releases Info

* Documentation: A new Recording, Quality Management and
SpeechAnaltyics user manual was created for cloud customers. * List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

Product Documentation
This release contains the following resolved issues:

SpeechMiner

When working with Custom Strictness, events with a Genesys Products
confidence equal to the term's strictness are no longer marked
with found=0. These events are now correctly marked with
found=1. Also, once Apply is selected the process now updates
existing events using the term and topic combination. The
process no longer updates existing events according to termiD. Also, even if the event has a
confidence value of 1 it will appear in callEventsTbl. (PRSM-24505)

List of Release Notes

After 13 minutes of inactivity or continuous activity, the SpeechMiner session no longer times out.
(PRSM-24429)

When a user who is not a part of any Configuration Server access group tries to log into SpeechMiner
numerous times, he/she no longer causes login issues for all the users in the system. (PRSM-24507)

When an SQL timeout exception occurs, interactions that are being indexed at the same time are
now re-entered into the index queue. Previously, when an SQL timeout exception occured,
interactions that were being indexed at the same time were not re-entered into the index queue.
(PRSM-24502)
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When logged into SpeechMiner, occurrences of not being able to view interactions until IIS is reset no
longer occurs if the value of the loadAccessGroupsAtLogin parameter in the WebServiceParams
database table is 1.

Note: The default loadAccessGroupsAtLogin parameter is 0 and should only be changed by an
administrator after consulting with customer care. This parameter should only be set to 1 if you are
not able to view interactions until IIS is reset. Also, if your users have a large amount of access
groups it is not recommended to change the value to 1. (PRSM-24490)

Measures have been taken to improve protection against the potential security threats to the web
application. (PRSM-24481)

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.510.20

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
11/22/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
When you export a multisegment interaction, the exported file
includes all of the segments. Previously, not all of the segments SpeechMiner
were exported. (PRSM-24326)

Genesys Products

Coaching Session type configurations are now saved as expected.

(PRSM-24177) List of Release Notes

SMConfig now creates performance counters, which were previously unavailable. (PRSM-24007)

When the same question is added more than once in a single Quality Management Evaluation Form
or Group, the Evaluation Summary report now lists the question that appears in the form / group
more than once. Previously, the Evaluation Summary report did not list the question that appeared in
the form / group more than once. (PRSM-24047)

When a user (with the correct permissions) opens an Evaluation created by another user, the Search
filters in the Interaction tab no longer look like they have been reset. (PRSM-23982)

When you log into SMART, the SMART deployment is no longer enabled when the Webdav username
and password are empty. (PRSM-23694)
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ULogger no longer contains exceptions when RTF tests are run on VTMS in version 8.5.510.157.
(PRSM-23646)

When the database contains usernames that include other usernames for an Ad-Hoc evaluation, only
the selected username will be added to the Ad-Hoc Evaluation. Previously, if the database contained
usernames Tom, TomC and TomCruise and Tom was selected as an evaluator, Tom, TomC, and
TomCruise were added as evaluators. Now only Tom is added as an evaluator to the Ad-Hoc
evaluation. (PRSM-23635)

Measures have been taken to improve protection against the potential security threats to the web
application. (PRSM-24128, 24127)

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.510.13

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
09/06/18 Hot Fix X
What's New .
Helpful Links

This release contains the following new feature:
Releases Info

* Screen Recording Context Menu Permission: A new Enable
Video Context Menu permission was added to the SpeechMiner Ul * List of 8.5.x Releases
to control access to the Video Context menu when performing a
right-click on a screen recording in the player. By default, the
Video Context menu is no longer accessible. If users need this
functionality, please enable the permission in their assigned role.

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner

Resolved Issues Genesys Products

This release contains the following resolved issues: List of Release Notes

When you try to add an interaction to a static interaction list during a Coaching session, SpeechMiner
no longer times out and the list is updated as it should be. (PRSM-23720)

Measures have been taken to improve the potential security threats to the web application
(SpeechMiner Ul). (PRSM-23723 and PRSM-23926)

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes

Release 8.5.5

8.5.510.12

Speech and Text Analytics Release Notes

Release Release .
Date Type Restrictions AIX
08/16/18 Hot Fix
What's New

This release includes only resolved issues.

Resolved Issues

This release contains the following resolved issue:

Linux

Measures have been taken to improve the potential security
threats to the web application. (PRSM-23676, PRSM-23677,
PRSM-23678, PRSM-23679, PRSM-23680, PRSM-23681,
PRSM-23682, PRSM-23683, PRSM-23684, PRSM-23685)

Upgrade Notes

Solaris Windows

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.510.11

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
08/14/18 Hot Fix X
What's New .
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

e List of 8.5.x Releases

e The SpeechMiner connection to the Configuration Server now
uses Advanced Disconnect Detection Protocol (ADDP). For details
see ADDP.

¢ 8.5.x Known Issues

Product Documentation
Resolved Issues

SpeechMiner

This release contains the following resolved issue: Genesys Products

Chrome no longer disconnects when you try to search for and/or List of Release Notes

listen to a long recording.

The Wave graph is not visible for long recordings and the duration of long recordings is configurable.
To set the wave graph visibility change the WaveGraphCallDurationLimit parameter in the
webServiceParams table. Note: It is recommended to limit the visibility to recordings of the Media
Player wave graph that are no longer than 30 minutes. If the value of the
WaveGraphCallDurationLimit parameter is longer than 30 minutes, users may experience
performance issues. (PRSM-23482, PRSM-22317)

When a comma, quotes and/or a new line is entered in a Quality Management Free Form field, it now
appears as it should in the exported evaluation .csv file. (PRSM-23523)

When the capitalization of a Username and/or External ID name are changed in GAX, the specific
Agent name may now appears in the SpeechMiner Agent filter even when Access Control is enabled.
Previously, capitalization changes sometimes removed Agent names from the filter when Access
Control was enabled. (PRSM-23346)
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When working in SMART, changing the Strictness level for an entire Topic no longer changes the
Strictness level for terms with a custom Confidence level. (PRSM-23184)

Numbers at the end of a recording (that is, at the end of a channel) are now redacted and transcribed
for the interactions pushed via Fetcher and IR components. (PRSM-23525)

Exporting 150 completed Quality Management sessions no longer takes more than a minute.
Previously, exporting 150 + completed QM sessions took more than a minute if the sessions included
approximately 20 questions. (PRSM-23215)

A Saved Report no longer disappears from the Saved Reports list. (PRSM-23226)

The Media Player displays the No Interaction message for non-existing recordings or recordings that
have not been processed. Previously, it displayed the Loading the interaction message instead.
(PRSM-23217)

When the Trending report is created, user partitions are now considered. Consequently, the report
results are now based on the interactions associated with the user's partitions. (PRSM-23218)

An exception is no longer thrown when logging into SpeechMiner. (PRSM-23378)

You can now delete a Quality Management evaluation from the Evaluation Manager. (PRSM-22798)

Measures have been taken to improve the potential security threats to the web application.
(PRSM-23124, PRSM-23126, PRSM-23634)

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.

Speech and Text Analytics 91


https://docs.genesys.com/Documentation/SPMI/8.5.5/Upgrade/Welcome

SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.510.05

Speech and Text Analytics Release Notes

Release Release

Date Type Restrictions AIX Linux Solaris Windows
05/12/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issue: Product Documentation

SpeechMiner
Agent names are no longer missing from the Search Filter >
Agents list due to case sensitivity problems. (PRSM-22561) Genesys Products

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.510.04

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
05/06/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issue: Product Documentation

. , SpeechMiner
When there is a large number of users in the system

(approximately above 10k), and each user is assigned to multiple
Access Groups, logging into SpeechMiner is now faster and does
not cause a timeout. Previously, logging into SpeechMiner took
longer than expected and sometimes caused a timeout after 1
minute.(PRSM-22085)

Genesys Products

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.

Speech and Text Analytics 93


https://docs.genesys.com/Documentation/SPMI/8.5.5/Upgrade/Welcome

SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.510.03

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
03/05/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issues: Product Documentation

) ) . SpeechMiner
Measures have been taken to improve the prevention of potential

security threats to the web application.(PRSM-21366,
PRSM-21365, PRSM-21364, PRSM-21363, PRSM-21362,
PRSM-21360, PRSM-21359, PRSM-21358, PRSM-21303, .
PRSM-21174, PRSM-21148, PRSM-21133, PRSM-20998, List of Release Notes
PRSM-20994, PRSM-20979, PRSM-20978, PRSM-20977,

PRSM-20976)

Genesys Products

The Explore > Search page now loads as expected. Previously, the page was not able to load due
an unexpected duplicate metadata key.(PRSM-21380, PRSM-21353)

to

Agent Hierarchy for Access Control is now working as expected. Previously, Agent Hierarchy did
not work as expected when hierarchy is set to Team Name/Imaginary Name other than Agent Name.

(PRSM-21370)

Speech and Text Analytics
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Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.510.02

Speech and Text Analytics Release Notes

Release Release Restrictions AIX Linux Solaris Windows
Date Type
01/15/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issues: Product Documentation

. , SpeechMiner
SpeechMiner Web no longer receives an error from the
Configuration Server when trying to load the current user's

details. (PRSM-20488) Genesys Products

List of Release Notes

When you run a report with a Metadata value that includes a +
sign, the report now returns data. Previously no data was returned. (PRSM-20592)

SpeechMiner Web closes all connections to Recording Web Services (RWS) and Recording Crypto
Server (RCS). Previously, these connections were not closed and, as a result, SpeechMiner Web
periodically became unavailable after a prolonged period of work. (PRSM-18689)

When working with SpeechMiner 8.5.510 and a record duration is set to null in the
WildcardGrammars table, the system no longer crashes. (PRSM-20735)

Speech and Text Analytics
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Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.510.01

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
12/19/17 General X
What's New .
Helpful Links
This release contains the following new features and Rel Inf
enhancements: eleases Info
 Interaction Search, Export and Add Improvements: » List of 8.5.x Releases
« Sort by Agent: Within the Interactions grid it is now possible ¢ 8.5.x Known Issues

to sort by the Agent column. Interactions with multiple
agents will appear after (descending order) or before
(ascending order) the alphabetized list of interactions with
one agent. Subsequently, interactions with multiple agents Product Documentation
are sorted by the number of agents and then relevance. [+]
SpeechMiner

The new Agent column heading now includes sorting options: Genesys Products

Agent -
9 M List of Release Notes

The previous Agent column heading appeared as follows:

Agent

* Search by List of Interaction IDs: It is now possible to search for a specific set of interactions
based on a list of Interaction IDs. A list of up to 50 Interaction IDs is supported. This can be useful
when working with a specific set of interactions. [+]

The new Interactions ID field contains a new resize option in the bottom right corner of the field that enables you to view
the Interaction ID:

Interaction 1D:

P

The previous Interactions ID field did not contain this option:

Interaction 1D:
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* Export All Interaction Meta Data: You can now easily export all the metadata associated with
interactions from an interaction search, up to the maximum number of listed interactions, without
having to scroll through all interactions in the search results. [+]

The new Export window enables you to select the interactions that should be exported. The following window appears before
the previous Export window:

x
Export
Select the interactions that should be exported:

@® Export the selected interactions (100)
Export all the interactions (1000)

.
(1]
(5]

The ‘Include audio and text
interactions files' option is disabled
because the size of the Export file
exceeds the maximum limit. To include
audio and text interaction files, reduce
the number of selected interactions.

The previous Export window did not contain this option:
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Export Interactions

The file(s) you are exporting is encrypted with & strong encryption. When you unzip this file,
you will be prompted to enter a password.

Password
) This is a one-time generated password that will be used to decrypt the zip file and its

contents.

Generate Password

Password must contain:
¥ A minimum of 12 characters.

®  Uppercase letter (English)
x  Lowercase letter (English)

®x  Numbers

4

Special character

Cancel

* Add All Interactions to a List: You can now easily add all interactions from an interaction search
to an Interaction List without having to scroll through all interactions in the search results. [+]

The new Add To... window enables you to select the interactions that should be added to the selected list:
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Add To...

Coaching Session  Interaction List

Mew Interaction List

itai new
Itai list #2
itai shared #1

g9
anat1

ab

1_test

Amit Test - ANZ

raymond test

test select All 389 interactions #2
select all 1000 interactions

Select the interactions to include in the selected interaction list

® Add the selected interactions (100)

0 Add all the interactions (1000}

e e

The previous Add To... window did not contain this option:
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Add To...

Coaching Session  Interaction List

Mew Interaction List

itai new

Itai list £2
itai shared #1
itai shared #1
itai new

a9

ital mew

itai new

e Quick Filter for Search Filters: Quick filters have been added to certain Search Filters. These
include Speakers, Languages, Types and Metadata filters.

* Quality Management Improvements:

¢ In-Line Rubric / Standards Definition: Forms and Questions within Forms now have an
expanded Question Description field that can be used to store the standard definition or rubric
used by your Quality Managers to ensure consistency when performing evaluations of Agents. [+]

The new Question Description field contains a new resize option in the bottom right corner of the field:

[1]
Required
P
Yes Auto-fail
No Auto-fail

Add "N/

=]
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The previous Question Description field did not contain this option:

= [}
Required
Yes Auto-fail
No Auto-fail

Add 'N/A

]

* Form and Evaluation Manager Improvement: The Forms Manager grid and the Evaluations
Manager grid now includes a Description column; if a description is long, the full content is shown
in a tooltip. In addition, when you hover over the Form or Evaluation name, a tooltip with the
description of the specific Form/Evaluation is shown. [+]

When you hoover over the Form / Evaluation name, the description appears in the tooltip as shown in the following image:

Working form with sliding scale question Description
Form with only sliding scale question
Form with only sliding scale question description

[V Py SN P K] A A TAr A e.rr

* Trending Rank for Top Terms (In a Speech Analytics deployment - GIA): The Top Terms table in the
Trending report results now includes a Rank column for each period. The Rank column displays the
relative importance and prominence of the specific term/phrase in the selected Period. [+]

The new Rank columns are now included in the Top # Terms table. The Period 1 and Period 2 column headings have been
replaced with Count (P1) and Count (P2). The table also includes a Select Columns option that enables you to change the
columns in the table:

Top 0 Terms ¥ @A @A Q

Statistics: United: 0, unique to Period 1: 0, unique to Period 2: 0
Total Interactions - Period 1: 15194, Period 2: 11162

Term Count (P1)  Count (P2Z)  Rank (P1) Rank (P2) s

The previous Top # Terms table did not contain the Rank columns and the Select Columns option:
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Top O Terms = Q

Statistics: United: 0, unique to Period 1: 0, unique to Period 2: 0
Total Interactions - Period 1: 10119, Period 2: 18742

Term Highest Period 1 Period 2 Visible

* Manual Text Categorization (In a Speech Analytics deployment - GIA): You can now manually assign
a category to a Text Interaction from the Attributes page of the interaction.

* SMART Improvements (In a Speech Analytics deployment - GIA):

* Option to Re-categorize Interactions: SMART users can now decide to re-categorize all existing
interactions in the system or not when updating Category definitions. [+]

The new Recategorize option now appears next to the changes menu:
FﬁPPh’ Categories 'I ¥ Recategorize all existing calls

The previous Apply Changes window did not contain this option:

Poply Categores |4

 SMART Statistics Date: You can now configure the default Show Calls Since date value in
SMART to determine in advance the date range for the information that will be shown.

* Reporting Improvements:

* Agent Comparison by Segment report: It is now possible to report on agent performance based
on the Segments within an interaction instead of just at the interaction level only. Interactions can
have multiple Segments, each involving a different Agent. Reporting by Segment provides more
precise Agent Comparison information for multi-segment interactions.

* Agent Trend by Segment report: It is now possible to report on agent performance trends based
on the Segments within an interaction instead of just at the interaction level only. Reporting by
Segment provides more precise Agent Trend information for multi-segment interactions.

* Team Comparison by Segment report: It is now possible to report on team performance based
on the Segments within an interaction instead of just at the interaction level only. Interactions can
have multiple Segments, each involving a different Agent from different Teams. Reporting by
Segment provides more precise Team Comparison information for multi-segment interactions
because only Segments where that Team was involved are included in the comparison report.

* 50/50 Dashboard Layout: The Dashboards now support a 50/50 layout for widgets in addition to
existing layouts.

¢ Language Enablement': Recognition of Canadian French (fr-CA) and Canadian French Ul support has
been enabled. Speech Analytics and Text Analytics now operate on voice interactions and text
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interactions in Canadian French.

¢ SpeechMiner Web Ul: Windows 10 64-bit Support: SpeechMiner Web Ul is now supported for all
existing supported browsers (for example, Chrome and Internet Explorer) on systems running Windows
10 64-bit.

e Support for MS SQL Server 2014 SP3 database: See the SpeechMiner page in the Genesys
Supported Operating Environment Reference for more detailed information and a list of all supported
databases.

Resolved Issues

This release contains the following resolved issues:

When an ampersand is used in a site name in SMConfig, the Web Ul no longer generates an error
when the Monitor System page is expanded. (PRSM-20303)

After an event is selected within the transcript, it is now possible to navigate again to the same
event. (PRSM-20150)

When SpeechMiner contains cycling data for agents (for example, when agent A is a parent of Agent
B and Agent B is a parent of Agent A), searching for specific agents from the Search page,
Evaluation Manager, and an Evaluation Session, no longer causes SpeechMiner to timeout.
(PRSM-20087)

When configuring metadata values in the Advanced Trending filter, the selected metadata values
are now saved and appear when the specific Trending filter is opened from the Saved Trending
Filter list. Previously, the metadata values were not saved in the specific Trending filter.
(PRSM-20047)

An error no longer occurs when you use the Tab key to move from one field to the next when
creating a new Coaching session that contains Type, Subtype and Reason Code. (PRSM-20141)

When a form is created with a name that contains 200 characters, the form name is now aligned
properly under the Forms title in the Evaluation Summary. Previously, a name with 200 characters
caused alignment issues. (PRSM-19986)

When you click Next to view the next interaction (after you scroll down to the end of the currently
selected interaction transcript), the initial view of the next interaction transcript is the beginning of
the transcript. Previously, the initial view of the next interaction transcript was at the end (bottom) of
the transcript. (PRSM-19976)
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Report caching now functions as expected when the current user is selected in the Agents filter in
the filter panel on the left side of the screen. Previously, when the current user was selected in the
Agents filter, Report caching did not function as it should. (PRSM-19913)

The following Warning message no longer appears in the Monitor System page, under the
Exploration task: Num of report workers / Counter instance does not exist. (PRSM-19898)

When you drill down to a specific day in an Agent Trend report and in a Category Trend report, the
data now represents the specific day. Previously, the data represented weeks and not the day.
(PRSM-19889)

The password recovery procedure error message and the password recovery link are now set for
optimal security. The password recovery link is now valid for 30 minutes. Previously, the link was valid
for 4 hours. (PRSM-19887)

When exporting reports to PDF format, blank pages no longer appear in the report. (PRSM-19728)

Tooltips for some of the Interaction list columns no longer contain lists with the term undefined in
the list. (PRSM-19728)

When you update the System Alert report schedule, the report is now saved. Previously, such an
update would cause an error and the report was not saved. (PRSM-19697)

When you select to open and play an interaction from an Evaluation Session in a new window, the
interaction now begins to play after the interaction is fully loaded. Previously, the interaction began
to play in the background before the interaction was fully loaded. (PRSM-19689)

An error no longer occurs when a database partition name is written in one place with capital letters
and the same name is written in a different place with small letters. (PRSM-19683)

When working with Internet Explorer, the Custom scheduling option no longer enables an
unnecessary drill down (in Chrome) when you edit an Action item and export a completed Quality
Management session. (PRSM-19678)

The row height for the Usage Tracking report is now large enough to properly show the date and
time. Previously, the row height was too small and the date and time were not visible. (PRSM-19665)

The Customer and Agent icons in the Chat interaction transcript are now located next to the
correct term. Previously, the Customer and Agent icons were reversed for Chat interactions.
(PRSM-19661)
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When you try to activate a Trending Cluster Task configured with a Fixed time period for non-
English languages, the Activate Trending Cluster Task pop-up window no longer states that the
specific Trending Cluster Task will be included in the Trending Cluster Task limit. (PRSM-19649)

In the Trending Information Export feature, when multiple MetaData filters are applied and run,
and the results are exported, the MetaData filter predicates are now separated by '&' and not '|'.
Previously, the MetaData filter predicates were separated by '|' instead of '&'. (PRSM-19645)

When you install a SMART build that includes the new Genesys logo in the same system as the older
SMART version, perform the following steps after restart to ensure the logo is replaced with the
correct logo: (PRSM-19603)
1. Clear the icons cache in Windows 10:
a. Open Windows Explorer.
b. From the View tab, select Hidden items.
c. Then select Show selected items.

d. Go to C:\Users\User\AppData\Local\Microsoft\Windows\Explorer, where C:\ is the drive
where you installed Windows 8 or 8.1 and User is the username of your account profile.

e. Select all files that begin with iconcache.

—h

Right-click these files.
Click Delete.To delete these files faster, press the Shift + Delete keys.

-«

Empty the Recycle Bin.
i. Restart the machine.

j. Install SpeechMiner.

When you try to access deleted sessions, the session no longer times out and the toolbar no longer
appears twice. Also, when you log into SpeechMiner after the session timed out because it was left
idle, the toolbar no longer appears twice. (PRSM-19582)

You can now deploy MRSLibrary in SMConfig when the SQL server has multiple instances and the
Report server includes an underscore in its name. (PRSM-19571)

When the following characters are entered in the Search Filter > Comments field and a search is
run, the search is now performed and an error no longer occurs in the ulogger: @ \ '\ 2\ .\ *\ #\ $
(PRSM-19569)

The list of Topics and Agents in the Search Filter is now in alphabetical order when one or more
Topic / Agent includes a sub-topic/sub-agent. (PRSM-19568)

If you press the ESC button when selecting from a list while configuring a search in the Search
Filter, the same list will now open when you try to open it again. (PRSM-19566)
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The Trending feature now works for the Cantonese language. (PRSM-19548)

Differences in SpeechMiner performance between Internet Explorer 11 and Chrome have been
improved. (PRSM-19510)

When Locale System Language is changed to Chinese in a system on which SpeechMiner is
installed, the Show/Hide filter icon no longer appears distorted when editing a Category
Distribution report. (PRSM-19371)

The Alerts field now accepts fractions for percentage values. (PRSM-19138)

When exporting an Evaluation Session, interaction metadata is now filtered. Previously, interaction
metadata was not filtered and all of the metadata was exported. (PRSM-19092)

SpeechMiner reports now only include dates in a format that was configured in the system.
(PRSM-18923)

The link to interactions within an Alert email now works as expected. (PRSM-18886)

When working with a resolution below 1280X1024, the options in the Date Range filter in the
Explore > Search > Search Filter will no longer expand upwards and are no longer hidden behind
the Media Player. (PRSM-18785)

The Terms filter in the Related Words filter summary now displays the merged label and with
information when two labels are merged. (PRSM-18773)

The Explore > Save Search list now loads as expected. Previously, the list took longer took a long
time to load.(PRSM-18669)

When working with es-MX globalization and the dates are configured hh:mm tt dd/MM/yy, the
date selection is now saved for Saved reports. (PRSM-18470)

An error no longer appears when running multiple reports in the Dashboard. (PRSM-18429)

When you attempt to view a report in a Dashboard at the same time numerous users are trying to
do the same, an error no longer occurs. (PRSM-18428)

You can now enter up to 1 billion characters in the SpeechMiner Dashboard widget. Previously, when
2500 characters were entered in the SpeechMiner Dashboard widget, the user was redirected to the
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Login page. (PRSM-18329)

When SMART is deployed, the Speaker type filter in Explore > Search now contains the correct
data. (PRSM-18242)

When an Action Item is created from a Coaching Session, the specific action item now appears in
the Action Item list. (PRSM-18239)

A user is now mapped according to the agent the user selected. Previously, if you had more than one
agent with the same name, and in the Administer User/User profile page you wanted to map a user to
an agent with this name, the user was always mapped to the agent with the lowest ID (first in the
list) from the list of agents with the same name. (PRSM-17106)

The amount of memory usage no longer grows exponentially when a user opens an evaluation from
the Evaluation Manager, uploads interactions, scrolls to the bottom of an interaction transcription
and returns to the Evaluation Manager page to select an additional evaluation. In such a scenario,
interactions are now played back as expected and SpeechMiner does not slow down to the extent it
used to. (PRSM-16722)

The Agents cache is now cleared automatically after a certain period of time. Users no long need to
clear the cache in the Manage Cache page. (PRSM-17101)

Upgrade Notes

To upgrade to release 8.5.510, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.509.16

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
11/28/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
When working with Custom Strictness, events with a

confidence equal to the term's strictness are no longer marked SpeechMiner
with found=0. Now these events are correctly marked with
found=1. Once Apply is selected the process now updates Genesys Products

existing events using the term and topic combination. The
process no longer updates existing events according to termiD.
Also, even if the event has a confidence value of 1 it will appear
in callEventsTbl. (PRSM-23748)

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.509, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.509.13

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
07/27/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
Agent names are no longer missing from the Search Filter >
Agents list due to case sensitivity problems. (PRSM-23351) SpeechMiner

L , , Genesys Products
When the capitalization of an Agent name is changed in GAX, the

specific Agent name now appears in all the SpeechMiner Agent
filters. Previously, capitalization changes sometimes removed
Agent names from the filter. (PRSM-23350)

List of Release Notes

When a large number of agents are selected in the Agent filter in QM Evaluation Sessions page,
the Agent filter no longer appears empty due to the selection size. (PRSM-23058)

Saved reports are no longer missing from the database. (PRSM-23054)

Measures have been taken to improve the prevention of potential Security threats to the web
application. (PRSM-23127, PRSM-23125, PRSM-23123)
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Upgrade Notes

To upgrade to release 8.5.509, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.509.11

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
06/13/18 Hot Fix X
What's New .
Helpful Links

This release contains the following new feature:
Releases Info

* The SpeechMiner connection to the Configuration Server now
uses ADDP (Advanced Device Discovery Protocol). For details see * List of 8.5.x Releases

ADDP.
¢ 8.5.x Known Issues

Resolved Issues Product Documentation

This release contains the following resolved issue: SpeechMiner

n Pr t
SpeechMiner Web closes all connections to RWS and RCS. Genesys Products

Previously, these connections were not closed and as a result
SpeechMiner Web periodically became unavailable after a
prolonged period of work. (PRSM-22917)

List of Release Notes

You can now delete an Evaluation Session that you did not create when you have the permission that
enables you to do so. Previously, you could not delete an Evaluation Session you did not create even
with the permission that should have enabled you to do so. (PRSM-22274)

Upgrade Notes

To upgrade to release 8.5.509, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.509.10

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
05/14/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issue: Product Documentation

) ) . SpeechMiner
The Media Player displays the No Interaction message for non-

existing recordings or recordings that have not been processed.
Previously, it displayed the Loading the interaction message
instead. (PRSM-22288)

Genesys Products

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.509, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.509.09

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
05/09/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issue: Product Documentation

) ) o SpeechMiner
When the Trending report is created, user partitions are now

considered. As a result, the report results are now based on the

interactions associated with the user's partitions. (PRSM-22318) Genesys Products

List of Release Notes

SpeechMiner Web no longer receives an error from the
Configuration Server when trying to load the current users details. (PRSM-22536)

When there is a large amount of users in the system (approximately above 10k), and each user is
assigned to multiple Access Groups, logging into SpeechMiner no longer takes longer than expected
and does not cause a timeout. (PRSM-22552)

Upgrade Notes

To upgrade to release 8.5.509, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.509.08

Speech and Text Analytics Release Notes

Release Release

Date Type Restrictions AIX Linux Solaris Windows
04/08/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issue: Product Documentation

. SpeechMiner
The Agent Bubble and Agent Comparison reports are now

available for deployment with a Recording Only license.
(PRSM-22089) Genesys Products

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.509, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.509.07/

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
02/21/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issues: Product Documentation

. _ SpeechMiner
Agent Hierarchy for Access Control is now working as

expected. Previously, it did not work as expected when the
hierarchy was set to Team Name/imaginary name. (PRSM-20577,
PRSM-21369)

Genesys Products

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.509, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes Release 8.5.5

8.5.509.06

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
02/11/18 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issues: Product Documentation

) ) . SpeechMiner
Measures have been taken to improve the prevention of potential

security threats to the web application.

(PRSM-21300, PRSM-21299, PRSM-21267, PRSM-21266,
PRSM-21264, PRSM-21263, PRSM-21262, PRSM-21180, .
PRSM-21136, PRSM-21129, PRSM-20982, PRSM-20952, List of Release Notes
PRSM-20951, PRSM-20950, PRSM-20949, PRSM-20947,

PRSM-21163 and PRSM-21091)

Genesys Products

Upgrade Notes

To upgrade to release 8.5.509, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.509.05

Speech and Text Analytics Release Notes

Release Release Restrictions AIX Linux Solaris Windows
Date Type
10/24/17 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issues: Product Documentation

_ SpeechMiner
The Failed to load report template warning no longer appears

in the ULogger. (PRSM-19907) Genesys Products

When the Report Caching task is enabled, reports are now List of Release Notes

cached as expected. Previously, the Failed to load report
templates error appeared in the log and reports were not cached after the Report Caching task
was enabled. (PRSM-19732)

The System Alert Report template can now be scheduled by authorized users. Previously, the
System Alert Report template could not be scheduled since it was created by the System account.
(PRSM-19733)

The System Alert report is now sent to the recipients, as expected. Previously, when the System
Alert report was scheduled and an error was discovered by the monitoring process, the System
Alert report was not sent to the recipients, as configured. (PRSM-19734)
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Upgrade Notes

To upgrade to release 8.5.509, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.509.04

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows

09/26/17 General X

What's New :
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

* Genesys Logo: The Genesys logo has been updated throughout * List of 8.5.x Releases

the product based on new Genesys branding. [+1] . 85 x Known Issues

The new logo now appears as follows:

3 GENESYS

The previous logo appeared as follows: Product Documentation
=
= Genesys

SpeechMiner

Genesys Products

¢ Access Control: SpeechMiner now supports Configuration Server
based Access Control for items within SpeechMiner for Genesys List of Release Notes
based user accounts. This functionality determines the agents
and users that are visible to a logged in user based on their
granted Read permissions. Additionally, access to items within SpeechMiner (For example, Forms,
Evaluations, and so on.) is also limited based on read access to the creator of those items. Access
Control is enabled in the following areas of the user interface:

» All Agent Hierarchy filters, including those in Search, Evaluation Manager, Evaluation Sessions and
Trending.

* All Users filters, including those in Search, Evaluation Manager, Action Items, Saved Reports -
Sharing, Saved Searches - Sharing, Interactions List - Sharing.

e Forms, Evaluations and Evaluation Sessions.

* Coaching and Alerts.

¢ Improved Tooltips: Tooltips in SpeechMiner in various locations now provide more detail; for cases
where even more space is required, clicking on the element loads a modal window with all the
information. Affected areas include: Topics and Categories in the Interactions Grid, Current Filter
at the top of the Interactions Grid, and Action Items details.
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Release 8.5.5

¢ Quality Management Improvements:

* Evaluation Sessions Grid: You can now filter the Evaluation Sessions grid according to the date on

which the session was created as well as when the session was completed.[+]

In the following image of the Evaluation Sessions filter, you can see the new Creation Date and Completion Date

parameters.
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The following image represents the previous Evaluation Session filter (without the Creation Date and Completion Date

options):
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* Evaluation Session Completion: The workflow to close an Evaluation Session has been optimized
to reduce the number of clicks required.

¢ Language Enablement: Recognition of Cantonese (zh-HK) and Cantonese Ul support was enabled.
Speech Analytics and Text Analytics now operate on voice interactions and text interactions in
Cantonese.

¢ Topic Analysis - Audits: (In a Speech Analytics deployment - GIA) The header row in the Topic
Analysis - Audits report is now fixed so users can always see the column titles. This functionality is
only supported in the Chrome browser.

* Trending Export: (In a Speech Analytics deployment - GIA) You can now export all information shown
in a Trending report. This capability is enabled only for users with the appropriate permissions.

¢ Coaching Improvements: (In a Speech Analytics deployment - GIA)

* Interaction Comments: It is now possible to add comments from the Media Player that is available
in the Coaching and Operations Search pages.[+]

The following image represents the updated Coaching Media Player with the New Comment option:
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* Session Subtype and Reason Code: You can now add session subtypes (a secondary or
subordinate session type that falls under the general classification of a specific session type) and a

reason code (the cause, explanation or justification for completing a coaching session) to each
Coaching Session.[+]

In the Coaching > Session List page, the Session Types button has been changed with the Configure button.

Session Types - Configure

The Session Types window is now called Configure, since it now includes two tabs: Session Types and Reason Codes.
The following 2 images represents the new Configure window:
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Configure

Sassion Types Reason Codes

The following image represents the previous Session Types window:
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* Updated Icons: The Coaching Session summary page now includes a Status icon and a Status
name that makes it easier to identify the status of a case at a glance.[+]

In the following image you can see that the Status column now includes a more easily discernible status, as the icons are
more varied and the Status label is shown:

@ In Progress

E) Scheduled

@ Completed

@ On Hold

In the following image you can see that the previous Status column did not indicate the status label and the icons for each
status were very similar:

E
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Resolved Issues

This release contains the following resolved issues:

The Evaluation Manager load time is now stable and functioning as expected. Previously, the load
time would increase the more you used it. (PRSM-19625)

Event bubbles now appear next to their relevant term throughout the transcript. Previously, when two
or more events occurred for the same term, all the event bubbles only appeared in the transcript
next to the first occurrence of the specific term. (PRSM-19606)

Blacklisted terms and phrases now appear in the Trending chart when the Ignore Blacklist option
is selected. Previously, the terms and phrases did not appear when the Ignore Blacklist option was
selected. (PRSM-19304)

The Operational Search page count location is adjusted on the screen when the length of the list
changes. The page count no longer stays at the bottom of the page. (PRSM-18876)

The Customer and Agent icons now properly appear next to Customer and Agent in the transcript.
Previously, the Customer and Agent icons in the transcript were reversed. The Customer icon
appeared next to the word agent and vice versa. (PRSM-19434)

The Styles.css file is now available when you log into SpeechMiner as a new user. Previously, when
logging into SpeechMiner as a new user, the system requested the Styles.css file, but the
Styles.css file was missing. (PRSM-19297)

The Error in REST API controller message in the WEB's Ulogger's Entry in the Event log no
longer contains a spelling mistake. Exists was changed to exist. (PRSM-19292)

When the Player is locked, the Search option now properly appears as disabled. Previously, the
Search option appeared as enabled when the Player was locked. (PRSM-19263)

Special characters can now be included in a new user's password. (PRSM-19242)

The new Genesys logo no longer appears in the 8.5.506 POST PA and 8.5.508 POST PA installation
package. The previous logo is now displayed. (PRSM-19216)

The Partition value in the Trending Cluster Task description is now the same as the Partition
value in the Search filter. (PRSM-19206)
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Exported Evaluation Sessions are now stored correctly in the Web Export folder. Previously, the
sessions were stored in an incorrect folder, and a corresponding error was generated. (PRSM-18820)

You can no longer edit the content in the column cells in the Saved Trending Filter list. Previously,
you could edit this content. (PRSM-19006)

When working with SpeechMiner reports you will no longer receive the warning: "failed to load report
template". Previously, this message appeared when report templates were removed from
SpeechMiner but not from the database.(PRSM-19007)

RWS now handles the Elasticsearch query as expected when userName starts with
<agent_hierarchy>. (PRSM-18618)

The Program Priority and Activation Editing permission is now entirely visible and is no longer
missing a period at the end of the sentence. (PRSM-19174)

The Preview images are no longer missing from the Report template page in the WebUI.
(PRSM-19170)

The Content Browser > Collapse option now works as expected. Previously, this option did not
collapse the selected list. (PRSM-19141)

Alerts are now triggered when they are created by a user who is not an agent. (PRSM-19127)

You can now sort and filter users in the Action Items and Coaching User filters. (PRSM-19067)

User Events are now logged when interactions are purged from the system. (PRSM-18241)

A Screen Recording (Video and Audio interaction) now begins to play after the Media Player loads
the wave file. Previously, when you played a Screen Recording, the Media Player indicated that
the wave was being loaded while the Screen Recording was already playing. When the wave graph
was completely loaded, the Screen Recording started playing again from the beginning.
(PRSM-18893)

When Access Control is enabled in the database, the Evaluation Session list is filtered according
to the Evaluator filter selection. (PRSM-18821)

In a SpeechMiner Recording Only deployment, the Ulogger no longer generates errors about non-
existent reports. (PRSM-18761)
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When SpeechMiner is localized for an non-English market (for example, Chinese Simplified), the
Evaluated and Cannot delete system tags are now translated. Previously, these tags were not
translated. (PRSM-18787)

When a transcription event is selected within the transcription, the same event is now highlighted in
the Event list on the right side of the screen. If the event is off screen, clicking the Event in the list
will now navigate to the event. Previously, the event was not highlighted in the Event list.
(PRSM-18802)

When you choose to view all the partitions in a filter, the filter now displays only the root partition.
Previously, the filter was expanded and displayed all the partitions. (PRSM-18786)

In the Trending page, the Related Words > Terms filter is now updated with the term in the
Related Words > Search field and/or with the term added to the Advanced filter. (PRSM-18743)

When attempting to delete a comment from the Comment and Events list in the transcript using
the X delete icon, a Delete tool tip appears and disappears when you complete the delete process.
In addition, if you are working with a 1920 X 1200 screen resolution and you attempt to delete the
first comment in the list, the Delete tool tip no longer covers the Comment tab. (PRSM-18275)

When the process of removing a tag from the Tools > Define Tags page fails, the tag is removed
from the Tag list. When the window is refreshed the specific tag no longer appears in the list.
Previously, the specific tag appeared in the list after it was removed. (PRSM-18249)

The dash (-) icon is no longer missing from the Terms & Topics row in the Trending filter.
(PRSM-17419)

After playing an interaction from the Search Results list, the subsequent interactions are played
automatically. Previously, the interactions were not played one after the other after 3to 5
interactions were played. (PRSM-18790)

You can now compare Saved Searches that another user saved and shared with you. Previously, the
Compare Saved Searches option did not apply to saved searches that someone else saved.
(PRSM-16024)

Capitalization of work group names is the same each time a name appear in the Search Results
interaction list. (PRSM-18337)

When using Internet Explorer 10, you can no longer save a Trending filter without a name.
Previously, you were able to save a Trending filter without a name. (PRSM-17474)

When using Internet Explorer 11, an error no longer occurs when the Quality Management > Form
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Manager is opened. (PRSM-18260)

When using Internet Explorer 11, an error no longer occurs in the Create New Comment window
when you attempt to create a new comment. (PRSM-18274)

When working with Internet Explorer 11, an error no longer occurs when you attempt to Save a new
Preset View. (PRSM-18273)

The loading indicator now appears when you choose to play the interaction. (PRSM-18939)

When you click the 5 seconds Rewind option in the Media Player in a Recording Only deployment,
the interaction is pushed back 5 seconds. Previously, this option caused the interaction to stop
playing and the progress bar was moved to 0 seconds. (PRSM-18838)

When the second level Tools menu is opened, the second level menu now closes after the selected
page is loaded and an attempt is made to select a different Tools menu. Previously, in this scenario,
the second level Tools menu did not close. (PRSM-18815)

Deleted Saved Searches no longer appears in Coaching options. (PRSM-18813)

You can now delete an interaction only when RWS returns 200 successfully. Previously, you could
delete an interaction when RWS returned a 500 or 503 error when Cassandra was marked as read-
only or Cassandra was down. (PRSM-18713)

The All Agents filter option in the Evaluation Session page is now functioning as expected.
(PRSM-18447)

You can now view complete Action Item details by clicking the Action Items details link. Previously,
the scroll option in the Action Item Details view did not work and some of the details were hidden.
(PRSM-18060)

The Explore filter tool tips include vertical scroll bars. Previously, the vertical scroll bars were
missing. (PRSM-11671)

Upgrade Notes

To upgrade to release 8.5.509, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.508.10

Speech and Text Analytics Release Notes

Release Release

Date Type Restrictions AIX Linux Solaris Windows
11/10/17 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issue: Product Documentation

SpeechMiner
SpeechMiner commands are now synchronized and the
SpeechMiner Menu bar is no longer hidden. Previously, Genesys Products
sometimes SpeechMiner commands were not synchronized and

as a result the SpeechMiner Menu bar was hidden. (PRSM-20191) List of Release Notes

Upgrade Notes

To upgrade to release 8.5.508, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.508.09

Speech and Text Analytics Release Notes

Release Release

Date Type Restrictions AIX Linux Solaris Windows
10/15/17 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issue: Product Documentation

L . , SpeechMiner
Report Caching is working as expected. Previously, Report
Caching failed if the current user was selected in the
Interactions filter when creating a report. (PRSM-19863) Genesys Products

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.508, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.508.08

Speech and Text Analytics Release Notes

Release Release

Date Type Restrictions AIX Linux Solaris Windows
10/10/17 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issue: Product Documentation

. ) SpeechMiner
The Trending page loads as expected when the system contains
over 10,000 partitions. Previously, when the Trending page was
first loaded, data took longer than expected to load when the Genesys Products

system contained over 10,000 partitions. (PRSM-19799) List of Release Notes

Upgrade Notes

To upgrade to release 8.5.508, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.508.07/

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
10/01/17 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issues: Product Documentation

. _ SpeechMiner
When the Report Caching task is enabled, reports are now

cached as expected. Previously, the Failed to load report
templates error appeared in the log and reports were not cached
after the Report Caching task was enabled. (PRSM-19731)

Genesys Products

List of Release Notes

The System Alert Report template can now be scheduled by authorized users. Previously, the
System Alert Report template could not be schedule since it was created by the System account.
(PRSM-19698)

The System Alert report is now sent to the recipients as expected. Previously, when the System
Alert report was schedule and an error was discovered by the monitoring process, the System Alert
report was not sent to the recipients as configured. (PRSM-19700)

Upgrade Notes

To upgrade to release 8.5.508, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.508.04

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
08/07/17 Hot Fix X
What's New .
Helpful Links

This release contains the following new features and

enhancements: Releases Info

» Trending Cluster Task: You can now create Trending Cluster * List of 8.5.x Releases
Tasks. This allows you to define cluster tasks with specific filter
criteria, beyond the default cluster tasks, to ensure that the data
and results shown on the Trending bubble chart fully reflect the
data set you are interested in exploring with this tool. (With
Speech Analytics license-GIA)

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

If you are upgrading to 8.5.508.04 or later (from any version that is 8.5.508.03 or
earlier) your system's Trending Cluster data sets will be removed. You will have to
wait a maximum of 24 hours for the system to collect new data sets before the
Trending feature can produce results.

¢ Topic Analysis - Audit Report: The Header row of the Topic Analysis - Audits report is now static when
the report is long and you must scroll down to view additional details. The static row is only supported
when working in Chrome. (With Speech Analytics license-GIA)

Resolved Issues

This release contains the following resolved issues:
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Delta and Threshold alerts with a change in percentage are now triggered and sent as expected.
(PRSM-19126)

Report templates that were manually deleted from the database no longer appear in the database
table. Previously, some report templates were not removed from the database table even when the
templates were manually deleted. (PRSM-19007)

You can now search users containing non-ASCIl characters in the agent hierarchy and obtain proper
results. Previously, when multi-byte characters were used in the agent hierarchy, the search returned
incorrect results. (PRSM-19023)

Upgrade Notes

To upgrade to release 8.5.508, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.508.03

Speech and Text Analytics Release Notes

Release Release

Date Type Restrictions AIX Linux Solaris Windows
06/29/17 General X
What's New .
Helpful Links
This release contains the following new features and Rel Inf
enhancements: eleases InTto
« Search for Users: (With Recording or QM licenses) When using * List of 8.5.x Releases
the Users filter option in the Search Filter in Search or . 85xKnown |
Evaluation Sessions, or when selecting Evaluators in Evaluation 2 owrn issues

Manager, the names are listed alphabetically according to the
user's full name, also the filter now filters based on username
and full name.

Product Documentation

+ Events and Comments for Text Interactions: (With Speech SpeechMiner
Analytics license - GIA)

. . . n Pr t
¢ You can now add in-line comments to text interaction Genesys Products

transcripts. Event markers are located throughout the text )
interaction based on where the event was detected in the List of Release Notes
text.

* Event navigation is now available in text interaction transcripts from the events and comments list
on the right side of the screen and from the transcript timeline. When clicking on an event marker
the event will be highlighted in the transcript.

* Interaction Transcript Search: When you view an interaction transcript, you can now search for
specific terms within the transcript using the Search field above the transcript.

e The text interaction timeline now contains both event and comment markers.

* The new Search filter above the events and comments list now enables you to quickly filter the
events and comments list for all interaction types. This filter can also be made persistent.

* Trending: (With Speech Analytics license - GIA)

* The Related Words option from the Trending chart, now produces the Related Words chart based on
the Trending page filter selections.

e The Trending chart can now include verbs. Previously, the chart only included noun phrases.
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¢ Audio Wave Graph: When working with Chrome, the SpeechMiner Media Player, in a Recording and
QM deployment (when Speech Analytics is not deployed), now contains an Audio Wave Graph that
enables the user to see where there are silences in the audio. From the Audio Wave Graph (when dual-
channel audio is available), the user can also distinguish between when one speaker is talking vs. the
other. Note: the Audio Wave Graph is not available when working with Internet Explorer.

e Screen Recording Grid: (With Recording or QM licenses) The SpeechMiner Screen Recording grid now
includes two new columns (Agent First Name and Agent Last Name).

* Usage Tracking Report: With Recording or QM licenses, the Usage Tracking report now logs
separate entries for playing a voice interaction vs. selecting an interaction from the search results grid.

Resolved Issues

This release contains the following resolved issues:

When a QM Evaluation Form is added to an Ad-Hoc evaluation, the specific Evaluation Form can
now be deleted if the associated Ad-Hoc Evaluation session was deleted. Previously, the form could
not be deleted when the Ad-Hoc Evaluation session was deleted. (PRSM-18671)

When creating an Ad-Hoc evaluation, it is now not possible to select inactive forms. Only active
forms appear in the list of available forms for Ad-Hoc evaluations. (PRSM-18663)

The total number of comments for text interactions will now be displayed properly in the interaction
player progress bar. (PRSM-18277)

An upgraded system does not include marks that are no longer required. Previously, the Important
mark was included in an upgraded system, even though the term marked as important should no
longer be marked important. (PRSM-18352)

When you select a phrase in the Trending > Related Words screen and drill down to search for
interactions associated with the selected phrase, the process now searches for the phrase and not for
each word separately using the AND operator. (PRSM-18457)

The Topic Analysis report is now created for text interactions. (PRSM-18441)

The Date Range tool tip for search results generated from the Interaction Transcript > Related
Words window now contains a time range. (PRSM-18435)

Terms in the Trending page are no longer ignored in the Related Words window, since Related
Words now uses the correct search filters.(PRSM-18421)
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All SpeechMiner Ul text is now translated from English to all of the non-English supported languages
(for example, Chinese Simplified). (PRSM-18425)

When the Related Words window is opened from the Trending page, the Partitions filter now
works as expected for the / directory. (PRSM-18420)

When searching for interactions according to the Interaction Reviewed by filter, you can now
search according to a user's name or ID. (PRSM-18357)

When search results are shown in the popup window, the Evaluated tag is now visible for
interactions that were evaluated. Previously, the Evaluated tag was not visible in the search results
popup window. (PRSM-18288)

In a Recording-only deployment, the Interaction Evaluation report is now available. (PRSM-18371)

A Saved Search and Call List can now be shared with all users. Previously,they could could not be
shared with users defined in the Configuration Server. (PRSM-18358)

The loading wheel is now displayed when SpeechMiner Dashboard Widget is loading. Previously,
there was no indication the widget was loading. (PRSM-18354)

When trying to share a Saved Search, the Find a user text in the Search field is now deleted when
you begin to type a letter and/or word. (PRSM-18276)

You can now save a search with the name of a deleted Saved Search. (PRSM-18248)

When exporting multi-segment calls, the sub-folder created under Speechminer\utopy\product\
WEB\Export)\ is now purged after one hour. (PRSM-18228)

You can now search for a user according to his/her username and/or first/last name. In addition, the
list is now ordered alphabetically. (PRSM-18107)

An exception no longer occurs when inserting a Yes/No question to a Quality Management form.
(PRSM-17931)

When the Media Player is locked during an audio playback and remains locked, the Search option
will function as expected when you open a Text interaction transcription. Previously, the Search
option did not work in this scenario.(PRSM-18370)
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Upgrade Notes

To upgrade to release 8.5.508, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes

Release 8.5.5

8.5.507.03

Speech and Text Analytics Release Notes

Release Release .
Date Type Restrictions AIX
04/18/17 Hot Fix
What's New

This release includes only resolved issues.

Linux

Solaris Windows

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

This is not a full release. Installation of the full 8.5.507.01 package is a pre-requisite

for installing the 8.5.507.03 hotfix.

Resolved Issues

This release contains the following resolved issues:

When working with a Single tenant Configuration Server, the Interaction Reviewed By field in the
Search filter now includes Configuration Server users, when the users and roles were configured

in the Resources tenant. (PRSM-18067)
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SpeechMiner can now share Saved Searches with Configuration Server users that were not
created in the Environment tenant. (PRSM-18271)

Web Patch Notes

To deploy the 8.5.507.03 web patch:

=

. Verify that you received the patch from Customer Care.

N

. Backup the web folder from the folder in which the software was installed. The default location is
C:\Program files (x86)\Genesys\Software\utopy\product\WEB.

w

. Copy all the files and folders from the Web folder in the extracted IP to the SpeechMiner Web folder
in which the software will be installed.

4. Reset lIS.
To rollback to the previous version:

1. Remove the SpeechMiner Web folder from the location in which the software was installed. By default,
the location is: C:\Program files (x86)\Genesys\Software\utopy\product\WEB.

2. Copy the Web folder you backed up.
3. ResetllS.
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8.5.507.01

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
03/29/17 General X
What's New .
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

If a voice recording has an associated screen recording, you must confirm that the
screen recording includes audio (for example, the audio is muxed) before using the
Protect from Deletion feature. The readiness of the screen recording can be
determined by trying to play the screen recording. The audio should be available
approximately 5 minutes from when the screen recording is uploaded.

¢ Auto Fail Report: A drill down report that focuses on auto fail Quality Management questions and
agents.

¢ Auto Fail Permission: A new Auto Fail permission has been added to enable the user to create, edit
and/or view the Auto Fail report.
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« Distributed Evaluations Targeted to Specific Agents: Provides supervisors with the ability to
evaluate specific agents repeatedly over time. [+]

e As shown in the following image, before 8.5.507.01, you could create three types of Evaluation
Sessions (Distributed, Calibrated and Shared). Select Quality > Evaluations Manager > New

Evaluation > Agent
New Evaluation ~

Distributed

Calibration

Shared

As of 8.5.507.01, you can now also create a Distributed Interaction Evaluation and a Distributed
Agent Evaluation.

Mew Evaluation - 0 Selected
Distributed i Interaction
Calibration Agent
Shared ager  Raymond segments t

e Before 8.5.507.01, the Evaluation Session filter included a Distributed type. Select Quality >
Evaluation Sessions
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Sessions

Archived

Expired

Filters

Saanus

[ Ready

[ In Progress
[ Compileted

Typas

[ Calibration
[ Shared
[ Distrbuted
Due Date

All

Agent

Agents

Evaluator

Users

As of 8.5.507.01, the Evaluation Session filter includes the new Distributed Interaction Evaluation

and a Distributed Agent Evaluation session types.
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Archreed

Expired

Filters

Satus

= Ready

B In Progress
[ Completed

Types

[ Calibration

[ Shared

B Distributed Interaction
[ Distributed Agent

[ Ad-Hoc
Dk it Al
All b
Agent
Agents i
Evalustar
T1 Users selected -

* In addition, as shown in the following image, as of 8.5.507.01, the new Distributed Agent Evaluation
includes a new Agent tab. Select Quality > Evaluations Manager > New Evaluation > Agent

* Evaliation Sumiman
EVailation Sumimany
Werw npkecind ony o—— .
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[ o decapen
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[ iy stacite e

maed A1 Colaseh &

Speech and Text Analytics 147



SpeechMiner 8.5.x Release Notes Release 8.5.5

* Quality Management - Agent Notification: Enables agent collaboration to provide agent feedback
against evaluations and related scores. [+]

» Before 8.5.507.01, an agent could not be notified that a session he/she was associated with was
completed. Select Quality > Evaluation Sessions select an evaluation and click Save >
Complete > Ok

Complete "test auto fail”

Agar agent_00T
RED anwwer lail Mo Score
With Ao Fail Mo Score

Export Session to C5V

Expart Session to FOF

-

As of 8.5.507.01, you can notify an agent that the session he/she was associated with was
completed with the Notify agent of results option.

Complete "test 123"

Agent aqerit
gali repord test Mo Score
Hige hgre Dpdicn
Exporting Motifications

Export Session to G5V Motify agent of resuits

Export Session to POF

-

e Show Evaluation Session Score Permission: Enables a user to turn on/off the evaluation session
Show Score option.
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* Replace Interaction: Enables a user (based on existing search criteria) to select an alternative
interaction due to the interaction's quality. [+]

» Before 8.5.507.01, you could not replace the interaction associated with the Evaluation Session.
Select Quality > Evaluation Sessions select an evaluation.

stributed Evaluabon, Due 19022018 142928

e € [

L L a Q 1
L ]
[ TR
i) . " 5 L | L . - 04:00
= = T ©
Interaction Attributes

Imteraction Processed Timee:
D200 T 145104

Wotgrous.

w

Agent:
adperi_00T
Mirtadata:

Cabegines:
From 201 to 500 s&c
duratian = 200 and < 350

Manual Calegories

Flanual

As of 8.5.507.01, you can replace the interaction associated with the Evaluation Session with the

- ion
Replace Interaction option .
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Dustnbated Inferaction Evaluation, Due 06032017 170218

— -

Interaction (CX202000091 134473705 — 'D
& qent -l @ L o =
9 9 9 9
[ ]
TR
o000 LI s e 8 Dé44
=+ = T O

Interaction Attributes

Interaction Processed Time:
190872016 202901

Werkgroup

-.
Agunt
agent
Metadata
Tags:

Categories:
From 200 o 500 sec

Manual Categomnes:

amual

¢ Replace an Evaluation Session Interaction Permission: Enables the user to replace the evaluation
session interaction.

* Interaction Tags: Now you can use user-defined tags for a variety of uses (for example, compliance or
training). [+1

* Before 8.5.507.01, you could not tag an interaction. The More menu in the top right corner of the
player did not include the Tag option.
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Export

Forward
Add To
Permalink

Delete

Retrieve Onginal Interaction

As of 8.5.507.01, you can tag an interaction as you play it in the Media Player. The More menu now
includes the Tag option.

Add To...

Tag___ _

Evaluate
Protect From Deletion

Delete

After you select to tag an interaction from the More menu, the Tag Interaction window is opened

with the list of available tags.

Tag Interaction

tag 1
tag 2
tag 5

[+ very long tag name 1 very long tag name

Cancel

Speech and Text Analytics

151



SpeechMiner 8.5.x Release Notes Release 8.5.5

* Define Tags: Now you can create interaction tags for a variety of uses (for example, compliance or
training). [+1

» Before 8.5.507.01, you could not tag define a tag. The Tools menu in the top right corner of the
player did not include the Define Tags option.

Tools

System Admin

Elements Explorer

Export Completed QM Sessions

As of 8.5.507.01, you can define a tag using the Tools > Define Tags option.

Tools

System Admin

Export Completed QM Sessions

Define Tags

After you select to define a new tag, the Define New Tags window is opened.

Define Tags

tagl ®
tag 2 ®
tag s 2%
very long tag name 1 very long tag name »®
) Add Tag
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* Define Tags Page Permission: Enables a user to define and edit an interaction tag.

* Tag Interactions Permission: Enables a user to tag an interaction.

¢ Protect from Deletion: Now you can prevent an interaction from being deleted. [+]

» Before 8.5.507.01, you could not protect an interaction from being deleted. The More menu in the

top right corner of the player did not include the Protect from Deletion option.

Export
Forward
Add To
Permalink

Delete

Retrieve Oniginal Interaction

As of 8.5.507.01, you can protect an interaction from being deleted. The More menu now includes

the Protect from Deletion option.

Tag...

Evaluate

Protect From Deletion

Delete

After you select to protect an interaction from deletion, the Protect from Deletion window is

opened.
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Protect From Deletion

This wall presende the interacton and wll indefinitely

exclude it from archiving of purging

o ——

* Protect Interactions from Deletion Permission: A new permission has been added to enable you to
protect interactions from deletion.

* Tag Interactions as Evaluated: Automatically adds an Evaluated tag when an evaluation session is
completed.

¢ Ad-Hoc Evaluation: Now you can launch an evaluation from the player against a specific media asset.
[+]

* Before 8.5.507.01, you could not evaluate an interaction from the player. The More menu in the top
right corner of the player did not include the Evaluate option.

Export

Forward
Add To
Permalink
Delete

Retrieve Onginal Interaction

As of 8.5.507.01, you can evaluate a single interaction. The More menu now includes the Evaluate
option.
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Add Ta...

Tag...

Evaluate
Protect From Deletion

Delete

After you select to evaluate a specific interaction, the Evaluate Interaction window is opened.

Easlustion T ppa
&3 HOC Ev phateon

Eniluilion Marst

Fomin)

T Frskasun sl sapere i1 4 Facasrs after creasan

* Create Ad-Hoc Evaluation Permission: This permission will enable the user to evaluate interactions
from the Explore page.

* Trending Bubble - Drag and Drop: Now you can move a Trending bubble to a different location on
the screen. This ability is useful in moving apart bubbles that are close together as the system has
found that they are closely related. Once the Trending chart is re-run , the bubble returns to its original
place.

¢ Recognition Improvements: Recognition enhancements have been made for improved accuracy and
detection results.

Resolved Issues

This release contains the following resolved issues:
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When there is no record of the segment in the segmentMetaTbl table, the system no longer
crashes..(PRSM-16553)

When Sharing an interaction list with another user, a delay no longer occurs as soon as you type the
first letter of the users name. (PRSM-17992)

Evaluation sessions can now be produced on the day the evaluation was created. Previously,
evaluation sessions were not produced on the day the evaluation was created.(PRSM-21889)

Terms that are almost identical are no longer duplicated in the Comparison tab. Previously, when
Period 1 contained a term similar to one that appeared in Period 2 (for example, if payment appeared
in Period 1 and payments appeared in Period 2), the Comparison tab contained both terms, each with
the same data. (PRSM-17485)

When you listen to a long call (longer than 20 minutes) without doing anything else in the Ul, your
session remain alive, and you will stay logged in the application. (PRSM-17833)

When you save a new search from a Coaching Session, the message that appears is now correct
(message: Enter Search name). Previously, the message that appeared was (message: Please enter
Interaction list name) incorrect. (PRSM-17630)

The name of the Action Item assignee no longer extends beyond the Action Item
window. (PRSM-17620) [+]

As shown in the following image, before 8.5.507.01, the name of the assighee extended beyond the

Add Action Item

azsignes

A o SuUiNan Aligariany [Camolmik e ALBAr ATy

Type Salect & Typ

Dt D

Summary

window boundaries.
As of 8.5.507.01, the name of the assignee no longer extends beyond the window boundaries.
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Add Action ltem

Aszagree
all Groups w Muiunthan a (mukunthan alsgarsamyd w
Type Select & Typs -
Dz Diate
SuETETAy
Cancel

The time that appears in an Action Item comment is the same as the time that appears in all other
SpeechMiner comments. Previously, the time in the comments were not the same. (PRSM-17622)

In the QM Question Library, the Save option is now disabled when Low or High title value is
removed from Sliding scale question and the following error message no longer appears: Failed to
save the Question Library. (PRSM-17325)

The SpeechMiner Coaching report includes only data associated with the user for which the report is
created. Previously, users could view data that they do not have permission to view. (PRSM-18038)

A message appears when an attempt is made to use the < and > characters in an Interaction List
name. The message informs the user that these characters cannot be used in the Interaction List
name. Previously, an error occurred when the characters were part of the name. (PRSM-17678)

When exporting a PDF of an Ad-Hoc evaluation, the Evaluation Type field is no longer empty.
(PRSM-17891)

When an Interaction list is renamed using Japanese letters, all the letters appear as Japanese letters.
Previously, the letters appeared as question marks (??7??). (PRSM-18108)

A console error no longer occurs when refreshing the Quality Management Evaluation Manager page.
(PRSM-17726)

The number of lines displayed in the different Evaluation Manager tabs is now consistent when
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moving from tab to tab and back to the original tab. (PRSM-17610)

SpeechMiner is now better able to detect a busy tone during an audio interaction. (PRSM-17908)

The designation arrows in a new Evaluation Form are now aligned. (PRSM-17384)

Tool tips are no longer missing for the following options in the following pages: (PRSM-17464)

¢ Interaction lists: Edit, Add, Delete

Content Browser: Refresh
¢ Saved Reports: Delete, Schedule
e Edit Reports: PDF, Excel

The Coaching report is now created as expected in a SpeechMiner Spanish USA system.
(PRSM-18102)

You now must provide a new name when renaming an interaction list. If you attempt to leave the
name field empty when selecting to rename an interaction list, a warning message appears.
(PRSM-17473)

It is no longer possible to add the same term to the Blacklist in different variations. When the same
word is been inserted with different variations (for example, Problem, PROBLEM, problem, ProbLEM),
an error message appears. Previously, it was possible to add the same word with different variations.
(PRSM-17573)

When a shared Interaction List is included in the Interaction List grid, you can now clear all the check
boxes at once. (PRSM-18124)

It is no longer possible to change the status of a form from active to inactive when the form is
associated with more than one evaluation session. For this reason, such a form cannot be deleted.
(PRSM-16948)

The SMART Replace All option is now functioning as expected. (PRSM-16750)

The reports caching task is no longer empty when a category is not selected before a report is run.
When a category is not selected, the Categories filter will automatically select all of the categories
and the report will now be taken from the cache. (PRSM-16637)

When a report is cached, the report parameters are now accurate and as a result the report is now
taken from the cache. (PRSM-16642)
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A URL field is now mandatory for social interactions. Previoulsy, the URL field was not mandatory and
an error occurred when the URL was not included. (PRSM-16491)

When you add a phrase without enough informative terms to a SMART topic, that phrase is no longer
added to the topic until it is fixed. (PRSM-11424)

The SMART Topic properties window is no longer distorted when resized. (PRSM-10448)

Upgrade Notes

To upgrade to release 8.5.507, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.500.02

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
08/01/17 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:
Product Documentation

SpeechMiner
Web Server now functions as expected when there are more than
5000 agents in a single access group. Previously, Web Server Genesvs Products
unexpectedly shut down in that scenario. (PRSM-19074) y

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.506.02, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.500.01

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows

01/04/17 General X

What's New :
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

« Installation/Upgrade Prerequisite: Before installing/upgrading * List of 8.5.x Releases

SpeechMiner, .NET 4.6.2 must be installed.
* 8.5.x Known Issues

* Export to PDF: Enables users to export a completed evaluation

session as a PDF file. [+] Product Documentation

As shown in the following image, before 8.5.506.01, you could only export a QM SpeechMiner
Evaluation Session to an Excel document by opening the specific session and
clicking Save > Export.

Genesys Products

List of Release Notes

Complete "title”

Agent Agentd
19.8.2901 5 foarms D%
Many Groups Mo Score

Export Evaluation Session

-

As of 8.5.506.01, you can now export a QM Evaluation Session to either an Excel document or a PDF.
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In addition, and as shown in the following image, before 8.5.506.01, you were given the option to export a QM Evaluation Session
to an Excel document when you decided to click Save > Complete.

Complete
Export

Close

As of 8.5.506.01, you can now export a QM Evaluation Session to either an Excel document or a PDF when you complete the

session.
Targeted Evaluation, Due 111972016 01:55:52
Show score i )
Comglete
Expan 1o G5V
“ @ » e 2

Export to PDF
Close

Q W

¢ Export Completed QM Sessions: Users can now export completed evaluation sessions according to a
specific date range. [+]

As shown in the following image, before 8.5.506.01, the Export Completed QM Sessions option was not available in the Tools
menu.
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System Admin

Elements Explorer

As of 8.5.506.01, you can now select the Export Completed QM Sessions option from the Tools menu.

Systemn Admin
Elements Explorer

Export Completed QM Sessions

Now when you select Export Completed QM Sessions, you have the option of selecting a date range from which to export the
sessions.
Export Completed OM Sessions

Exporied Fields Date Range

When exporting both single and multiple evaluation sessions to a .csv file (from both the evaluation session
itself and the Export Completed QM Sessions page), forms, groups, questions and answers will now appear in
one column and each evaluation session will be represented by a separate row.

* Recognition Improvements: Recognition improvements have been made for Italian.
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* Alpha Numeric Operation IDs: Operation IDs can now contain both letters and numbers.

Resolved Issues

This release contains the following resolved issues:

Terms/phrases in the Trending Top Terms panel no longer appear as links. (PRSM-11404)

When a Trending filter is saved with more than two metadata filters, all the metadata filters are
loaded. Previously, only the last metadata filter in the list was loaded. (PRSM-17255)

The Trending filter now runs as expected when you click Run after more than one row in the same
section of the Advanced filter is selected. (PRSM-17227)

In the Advanced filter panel in the Trending page, you can no longer add additional Programs. The +
icon has been removed. (PRSM-17265)

The dates in the Trending page now appears in the Local format. Previously, the date appeared in
USA format. (PRSM-17230)

The Fixed time period is now working as expected in a UK date format. (PRSM-17178)

There is now a 50-character limitation for the Name field, when saving a Trending filter. Previously,
you could enter more than 50 characters, but the Trending filter was not saved. (PRSM-17256)

When a Trending filter is saved with more than 2 metadata filters, all the metadata filters are loaded.
Previously, only the last metadata filter in the list was loaded. (PRSM-17254)

When attempting to remove one condition after selecting multiple conditions in a filter in the
Trending page, the selected condition is removed. Previously, the wrong condition was removed from
the filter and the selected condition remained in the list. (PRSM-17312)

When attempting to run a Trending report after selecting multiple conditions in one of the filters in
the Trending page, the report runs and retrieves results, as expected. Previously, the report failed and
did not retrieve results. (PRSM-17223)
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When a specific agent is selected when creating a SpeechMiner report, the report is now created as
expected. Previously, the report was created slower than expected. (PRSM-18247)

SpeechMiner now correctly returns search results. Previously, in very rare cases, SpeechMiner Search
returned a blank screen. (PRSM-17185)

The processing time for the SpeechMiner Search filter results is improved. (PRSM-17480)

The processing time to create a Trending report is improved. Previously, creating a Trending report
took longer than expected. (PRSM-17412)

The Trending filter Compare date option now contains the requested date. (PRSM-17380)

A Genesys user can no longer see the QM menu and pages when the license does not include QM.
Previously, a Genesys user could see the QM menu and pages when the license dis not include QM.
(PRSM-17494)

A timeout no longer occurs when a SpeechMiner report is processed for longer than 90 seconds.
(PRSM-17195)

When you select to configure a custom date range for an evaluation (when working with Internet
Explorer and Chrome), you only need to click the desired date once for it to be selected.
(PRSM-15938)

When an Exploration preset is opened in the Exploration Manager page, its changes are now saved
when you click Save. (PRSM-17219)

You cannot type more than 50 characters into the name field when saving a Trending filter.
Previously, you were able to enter more than 50 characters, but the filter was not saved.
(PRSM-17263)

When working with Trending, if the labels in Period-2 are a subset of the labels in Period-1, and the
labels in Period-1 are not a subset of the labels in Period-2, SpeechMiner Ul now responds as
expected. (PRSM-17127)

After creating and selecting a Trending filter, the filter type no longer changes to Custom. Now the
filter type remains as initially selected. (PRSM-17159)

The Trending filter Fixed time period in a UK date format now works as expected. (PRSM-17198)
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An error no longer appears if the Exclude audited events, TP, FP, or SFP option is selected when
searching for Events. (PRSM-17134)

When a saved search is run after it has already been run once, the results are now accurate and no
longer reflect the results of the previous search. (PRSM-17137)

An interaction is now added to the Interaction list when the Add To option is selected in the Player.
(PRSM-17184)

If the Region and Languages format is configured to work with a European number format in the
SMConfig host, SMConfig no longer fails to load. (PRSM-17258)

In the Advanced filter panel in the Trending page, you can no longer add additional Programs. The +
icon has been removed. (PRSM-17274)

An error no longer appears when the default Max Terms value is changed and Run is selected in the
Trending filter. (PRSM-17192)

You can no longer click the Terms filtered by Blacklist option when it is greyed out. Previously, the
option was active when it should not have been. (PRSM-17221)

You can now rename a cloned Trending filter. Previously, there was no indication the filter was cloned
and the two Trending filters were saved with the same name. (PRSM-17222)

When you open any Trending page in a saved Trending filter, the date now appears in the correct
format. Previously, the date was displayed in the wrong format in the Trending pages. (PRSM-17225)

When a new term is added to the Blacklist, the term is now in alphabetical order. Previously, the new
term was added to the top of the list and not in alphabetical order. (PRSM-17268)

After adding more than one row to a section in the advanced Trending filter, the correct row is deleted
when attempting to delete a row. Previously, the wrong row was deleted. (PRSM-17294)

SpeechMiner menus now close when a selection is made from the menu. Previously, in this scenario,
the menu stayed open. (PRSM-17136)

When the description of a Trending filter is very long, the description no longer appears on top of
existing text in the Ul. (PRSM-17260)

In a Recording Only license environment, the Explore menu now includes options that are relevant
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only to Recording Only. Previously, the Explore menu included options that should not have appeared
in the menu for the Recording Only license. (PRSM-17267)

Interaction events are now visible in the Player when a comment is added to the interaction.
(PRSM-17157)

When you select top terms filter and then change Relative to Fixed, Monitor and/or Compare, the
Trending Filter list will change to Custom. Previously, the filter was changed to Custom as a result of
any change to the selected filter. (PRSM-17160)

When working with a Trending page filter, you can now filter by a speaker's name. Previously, the
filter was limited to speaker type and produced different results than the Search filter. (PRSM-17079)

The following error no longer appears when saving SMConfig > Sites and Machines changes: Unable
to copy grammar files from <path> to grammar folder <path>. Could not find a part of
the path <path>. (PRSM-17083)

A BCC column was added to the SpeechMiner Interactions results list. (PRSM-17122)

An error no longer occurs when you sort chat or email interactions in the SpeechMiner search results
grid. (PRSM-17093)

The total call time no longer overlaps the time line in the Evaluation Manager player when the total
time is more than 1 hour. (PRSM-17088)

When an interaction is deleted from the system, its corresponding exploration fragments are now
deleted. Previously, the corresponding exploration fragments were not deleted. (PRSM-17060)

The SpeechMiner installation path no longer includes the /bin directory. Previously, the /bin was
included at the end of the path. (PRSM-17072)

Several text recognition processes can now work at the same time. As a result, text interactions are
recognized in parallel and text recognition no longer works at a rate slower than expected.
(PRSM-16848)

In the Metadata Frequency report the number of interactions filter now supports a double digit
(>=10). Previously, it only supported a single digit (0-9). (PRSM-17189)

Some implicit conversions in the database were removed, making performance better. (PRSM-16087)
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The Trending chart no longer contains terms and phrases in English when the chart is part of a
localized Ul. Previously, some of the terms and phrases in the Trending chart appeared in English for
a chart that was part of a localized Ul. (PRSM-17044)

An error no longer occurs when attempting to export events from the Event grid when the eventID is
greater than 2147483647. (PRSM-17962)

Dependent topics are now recognized after a topic trigger is detected. Previously, they were not
recognized. (PRSM-17609)

When the Numbering format is European (for example, 12.345,00) in the SMConfig machine,
SMConfig no longer fails to load. (PRSM-17291)

Terms/phrases in the Trending Top Terms panel no longer appear as links. (PRSM-17215)

Upgrade Notes

To upgrade to release 8.5.506.01, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.505.08

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
05/29/17 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issues: Product Documentation

. SpeechMiner
When a report is cached, the report parameters are now accurate
and as a result the report is now taken from the cache.

(PRSM-16642) Genesys Products

List of Release Notes

The reports caching task is no longer empty when a category is

not selected before a report is run. When a category is not selected, the Categories filter will
automatically select all of the categories and the report will now be taken from the cache.
(PRSM-16637)

Upgrade Notes

To upgrade to release 8.5.505, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.505.07/

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
04/27/16 Hot Fix X
What's New .
Helpful Links

This release contains the following new features and
enhancements: Releases Info
» Related Words Filtering: The Show Related Words option in * List of 8.5.x Releases
the Trending page Comparison tab is now available in the
Period 1 and Period 2 tabs. In each tab, the Show Related
Words results are now based on the same filter.

¢ 8.5.x Known Issues

* Interaction Transcript Search: When you view an interaction
transcript, you can now search for specific terms within the Pr tD mentation
transcript using the Search field above the transcript. oduct Documentatio

e Static Trending Chart: A dragged Trending Chart bubble now SpeechMiner
stays in its new location till the chart is changed.

« Audio Segment Length: A new setting was introduced to limit Genesys Products
the length of audio segments on which to run speech recognition
separately from the length of the call. The new setting is List of Release Notes

MAX SEGMENT LEN in the CMRSParams table.

Resolved Issues

This release contains the following resolved issues:

The processing time to create a Trending report is improved. Previously, creating a Trending report
took longer than expected. (PRSM-17412)

The dates in the Trending page now appears in the Local format. Previously, the date appeared in
USA format. (PRSM-17230)

The Fixed time period is now working as expected in a UK date format. (PRSM-17178)
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The SpeechMiner Dashboard menu lists all the existing dashboards. Previously, this menu did not
contain the full list of dashboard in some of the SpeechMiner screens. (PRSM-18333)

The processing time to create the Performance Profile report is improved. Previously, creating a
Performance Profile report took longer than expected. (PRSM-18359)

SpeechMiner now correctly returns search results. Previously, in very rare cases, SpeechMiner Search
returned a blank screen. (PRSM-17185)

The processing time for selecting the Related Words option in the Trending page is improved.
Previously, the process took longer than expected. (PRSM-17496)

Terms that are almost identical are no longer duplicated in the Comparison tab. Previously, when
Period 1 contained a term similar to one that appeared in Period 2 (for example, if payment appeared
in Period 1 and payments appeared in Period 2), the Comparison tab contained both terms, each with
the same data. (PRSM-17485)

The processing time for the SpeechMiner Search filter results is improved. (PRSM-17480)

The Trending filter Compare date option now contains the requested date. (PRSM-17380)

When attempting to remove one condition after selecting multiple conditions in a filter in the
Trending page, the selected condition is removed. Previously, the wrong condition was removed from
the filter and the selected condition remained in the list. (PRSM-17312)

In the Advanced filter panel in the Trending page, you can no longer add additional Programs. The +
icon has been removed. (PRSM-17265)

There is now a 50-character limitation for the Name field, when saving a Trending filter. Previously,
you could enter more than 50 characters, but the Trending filter was not saved. (PRSM-17256)

When a Trending filter is saved with more than 2 metadata filters, all the metadata filters are loaded.
Previously, only the last metadata filter in the list was loaded. (PRSM-17254)

When attempting to run a Trending report after selecting multiple conditions in one of the filters in
the Trending page, the report runs and retrieves results, as expected. Previously, the report failed and
did not retrieve results. (PRSM-17223)

A timeout no longer occurs when a SpeechMiner report is processed for longer than 90 seconds.
(PRSM-17195)
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An error no longer occurs when attempting to export events from the Event grid when the eventiID is
greater than 2147483647. (PRSM-17962)

Dependent topics are now recognized after a topic trigger is detected. Previously, they were not
recognized. (PRSM-17609)

When working with Trending, if the labels in Period-2 are a subset of the labels in Period-1, and the
labels in Period-1 are not a subset of the labels in Period-2, SpeechMiner Ul now responds as
expected. (PRSM-17127)

When the Numbering format is European (for example, 12.345,00) in the SMConfig machine,
SMConfig no longer fails to load. (PRSM-17291)

When an Exploration preset is opened in the Exploration Manager page, its changes are now saved
when you click Save. (PRSM-17219)

Terms/phrases in the Trending Top Terms panel no longer appear as links. (PRSM-17215)

When a saved search is run after it has already been run once, the results are now accurate and no
longer reflect the results of the previous search. (PRSM-17137)

An error no longer appears when the default Max Terms value is changed and Run is selected in the
Trending filter. (PRSM-17192)

An interaction is now added to the Interaction list when the Add To option is selected in the Player.
(PRSM-17184)

When you do not access the system for an extended period of time and the session has expired, you
are now logged out of the system when you attempt to work in the Explore/Trending pages.
Previously, when you did not access the system for an extended period of time, you were still able to
continue working with the Explore/Trending pages even when the session already expired.
(PRSM-17532)

The Topic Audit now includes and displays all the events that include the number wildcard.
(PRSM-18197)

When Sharing an interaction list with another user, a delay no longer occurs as soon as you type the
first letter of the users name. (PRSM-17992)

SMART categories now open within a reasonable time interval. Previously, opening a category in
SMART took longer than expected. (PRSM-18347)
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A Genesys user can no longer see the QM menu and pages when the license does not include QM.
Previously, a Genesys user could see the QM menu and pages when the license dis not include QM.
(PRSM-17494)

An error no longer appears if the Exclude audited events, TP, FP, or SFP option is selected when
searching for Events. (PRSM-17134)

When you open any Trending page in a saved Trending filter, the date now appears in the correct
format. Previously, the date was displayed in the wrong format in the Trending pages. (PRSM-17225)

After creating and selecting a Trending filter, the filter type no longer changes to Custom. Now the
filter type remains as initially selected. (PRSM-17159)

When using a metadata filter in reports, the number of interactions in the result set is correct and
there is no longer an inconsistency between the report and its drill down. Previously, the number of
interactions in the result set was sometimes higher than the actual number of interactions that the
report should have retrieved. (PRSM-18278)

Choosing a metadata field in a SMART category is now completed in a reasonable time period.
Previously, when you selected some metadata fields, the process could take a very long time.
(PRSM-18343)

Upgrade Notes

To upgrade to release 8.5.507, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.505.02

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows
11/01/16 General X
What's New :
Helpful Links
This release contains the following new features and Rel Inf
enhancements: €leases Info
» Improved Trending capabilities: Enables users to monitor and * List of 8.5.x Releases
analyze terms and phrases within conversations in conjunction . 85 x Known Issues
with a variety of search criteria to better surface and analyze o

unforeseen or unexpected trends to improve business outcomes
and agent performance.

* Configuration Data: Product Documentation

e User lists now include only users associated with the context
in which they are shown (for example, a list of evaluators will SpeechMiner
only include users with QM permissions).

« Changes to the Configuration Database have an immediate Genesys Products
effect on the system (for example, when a user is given QM
permissions, his/her name will appear in the evaluators list List of Release Notes

the next time you view the list).

* Preset views are now supported for users with Genesys authentication.

* Default Call List Order: A new configuration option that enables you to determine the order of
interactions in an interaction list. The new sort options are: Descending by Date Added, Ascending by
Date Added, Descending Alphabetical and Ascending Alphabetical.

 Database Optimization: Database storage can now be significantly decreased by not storing events
that were not found with a high enough confidence.

Resolved Issues

This release contains the following resolved issues:

When you open a text interaction after performing a search for terms in a SpeechMiner system that
was configured without English recognition, the text interaction is opened as expected. Previously,
the text interaction was not opened and an error is sent to the server. (PRSM-16526)
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A user that does not have permission to view a specific evaluation session, can no longer view the
same evaluation session from REST API. (PRSM-15930)

If the default login is set to Genesys (configured in the webServiceParams table), an error will no
longer occur when you try to create a new user in the SpeechMiner Ul. (PRSM-12492)

When a Coaching Session is created with an invalid time, the resulting error message is now visible.
(PRSM-15671)

A new field DAYS TO UPDATE EVENTS was added to SMARTConstants. If this field is null, all events are
updated with strictness changes in SMART. If this field includes a value X, interaction events going
back X days are updated. Note: Use 0 to not update any events. In some cases, events for
interactions older than X days may also be updated, if the interactions have a higher ID than
interactions that are in the last X days range. In addition, indexing as a result of event updates now
runs at priority 3, instead of 1. (PRSM-17046)

When generating event lists from the SpeechMiner Search page or from reports, the resulting grid
contains the correct number of events. Previously, the grid may have contained duplicated events.
(PRSM-16710)

When exporting an audio interaction from the Interactions grid in the Coaching Sessions page, the
specific interaction is now exported with its Interaction ID. Previously, the interaction was be
exported with its External ID. (PRSM-16499)

SpeechMiner no longer freezes when you try to view a long transcription while playing an interaction
using Internet Explorer. (PRSM-16048)

REST API services no longer send a data request when another request for the same data was
already sent. (PRSM-16354)

SpeechMiner functions at an expected rate when working with Internet Explorer due. Previously,
SpeechMiner functioned at a slower rate than expected when working with Internet Explorer due to
the number of watchers. (PRSM-16364)

Saving a search functions as expected. Previously, saving a search took longer than
expected.(PRSM-16424)

When the Interaction list is sorted or you select to view the new Interaction list page, the same
search is no longer repeated in Lucene. (PRSM-16521)

All SpeechMiner roles now have the Edit Action Items permission. (PRSM-14637)
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The Preset View option is now available to users defined in the Genesys Configuration Server.
(PRSM-10766)

When working with Internet Explorer 10 and 11, the Media Player does now functions as quickly as
expected when loading long interaction transcriptions (40+ minutes). (PRSM-14708)

Upgrade Notes

To upgrade to release 8.5.505, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.504.02

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows

08/15/16 General X

What's New :
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Info

» Encrypt exported interactions: Enables you to encrypt * List of 8.5.x Releases

exported interactions, so that a password is required to access
the interactions. As of 8.5.504.02, by default, exported
interactions are encrypted.

¢ 8.5.x Known Issues

e Export an Interaction List / Saved Search from a Coaching
Session: Enables you to export interaction lists and saved

X . ; Product Documentation
searches directly from a Coaching session.

* Retrieve Original Interaction: Enables you to restore an SpeechMiner
interaction with its original audio or text file (including all
attachments). This feature is only relevant in a SpeechMiner
Analytics mode and is not supported by Interaction Receiver. It is
only supported for the original location specified in the )
interaction metadata xml. List of Release Notes

Genesys Products

* Export Coaching Session Permission: A new permission has
been added to enable or disable the option of exporting an interaction list and/or saved search from a
Coaching Session.

* Retrieve Original Interaction Permission: A new permission has been added to enable or disable
the option of retrieving original audio or text data for a specific interaction. This permission is only
available in a SpeechMiner Analytics environment.

* Language Support: Support for the Catalan (ca-ES) language has been discontinued.

¢ Search Page: When the Search page is accessed, the Filter Panel will be opened and a search will not
be run.

e When upgrading from a version preceding 8.5.502 to 8.5.502 or later, all interactions are
re-indexed. During the re-index process, all SpeechMiner functionalities, except
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searching by term function as expected.
e The Active Search option was removed from the SMConfig User Interface.

e When upgrading to 8.5.504.02 build 93, the columns that appear in the Search Results
grid are reset to default.

Resolved Issues

This release contains the following resolved issues:

Interactions Grid: Performance improvements were made to the speed at which the Interactions
grid is loaded.

The Apply option in the Edit Comment window is now only enabled for users with the required
permission. Previously, it was enabled for all users with or without the required permissions.
(PRSM-16061)

When a calibration evaluation is not created because not all evaluators have permissions to view the
selected interaction, the status of the evaluation is now correctly marked as Inactive. Previously, the
status of the evaluation was incorrectly marked as Active. (PRSM-16063)

When the database contains less than 1000 interactions, the number of interactions in the report
now matches the number of interactions in the grid that appears when you drill-down. Previously, the
number of interactions in the reports did not match the number of interactions in the grid.
(PRSM-16022)

When you playback a screen recording an error no longer appears in the Browser Console log.
Previously, an error appeared in the Browser Console log. (PRSM-16189)

When you select a non-audio (text, email, chat) interaction in the Search Results grid, the time line
that appears is correct. Previously, the time line that appeared represented the time line for the
previously selected audio interaction. (PRSM-15981)

In SMART a topic name can now be renamed directly in the Topic tree using non-Latin letters (for
example, Korean, Japanese, Arabic and so on). Previously, a topic name could only be renamed with
non-Latin letters in the Topic Properties window. (PRSM-11337)

An SQL error no longer occurrs when the EntrylD column in the callEventsTbl table reaches a value of
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2,147,483,647 or more. (PRSM-14721)

The Report period in the Trend report is now the same as the Current period in the Trending page.
(PRSM-15335)

Text Recognition now supports the recognition of wildcards in the following languages: (PRSM-12424)
Korean

Japanese

Mandarin

Italian

When using the Hide Filter arrow in the Edit Report page in a Chrome environment, the report now
covers the entire page. (PRSM-11685)

When there is a timeout when attempting to export a large amount of interactions or very large
interactions a warning is now displayed. Previously, an error message was displayed instead of a
warning message. (PRSM-11551)

When you try to filter the search results in the following SpeechMiner grids, when you are not viewing
the first search results page, the filter will now redirect you back to the first search results page:
(PRSM-16249)

Interactions Lists

Saves Searches

Users

Saved Reports

When the EntrylD column in the callEventsTbl table reaches its maximum value an SQL error no
longer occurs. (PRSM-16051)

Upgrade Notes

To upgrade to release 8.5.504, refer to the SpeechMiner 8.5.x Upgrade Guide.
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Release 8.5.5

8.5.503.04

Speech and Text Analytics Release Notes

Release Release .
Date Type Restrictions AIX
05/30/16 Hot Fix
What's New

This release includes only resolved issues.

Linux

Solaris Windows

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

When upgrading from a version preceding 8.5.502 to 8.5.502 or later, all interactions
are re-indexed. During the re-index process, all SpeechMiner functionalities, except

searching by term function as expected.

Resolved Issues

This release contains the following resolved issues:

QM Evaluation creates sessions with interactions randomly selected from the entire time period
defined in the search criteria. Previously, QM Evaluation only created sessions with interactions

selected from the end of the time period defined in the search criteria. (PRSM-16194)
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Arabic text and numbers in an email Subject field are now displayed correctly. Previously, Arabic text
and numbers did not appear as they should in the email Subject field. (PRSM-16203)

When selecting the Search Filters option from the Explore screen, the filters page loads as expected.
Previously, the Search Filters page took longer than expected to load. (PRSM-16210)

Upgrade Notes

To upgrade to release 8.5.504, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.503.03

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows

04/18/16 General X

What's New :
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

 Predictive Elements Report: A report composed of two bar * List of 8.5.x Releases

graphs that show the relationship between selected Categories

and Target Categories. * 8.5.x Known Issues

¢ Interaction Evaluation Summary Report: A report that shows
the evaluation score for the last evaluation session, associated

with a specific evaluator and interaction. Product Documentation

¢ Program Distribution Report: A report that graphs the
interaction volume for each Program. SpeechMiner

¢ Edit Call Comments Permission: A new permission has been
added to control which Users can edit an interaction comment; Genesys Products
this permission is system-wide for a given User.

List of Release Notes
¢ Customer Sensitive Data Permission: A new permission has

been added to enable the user to display customer-sensitive
meta data (for example, attached data from CIM) in the SpeechMiner GUI. When this permission is
enabled, the data is visible.

* Agent Sensitive Data Permission: A new Recording Only permission has been added to enable the
user to display agent-sensitive meta data (for example, agent name) in the SpeechMiner GUI. When
this permission is enabled, the data is visible.

* Interaction Evaluation Summary Permission: A new permission has been added to enable or
disable the Interaction Evaluation Summary report.

* Timestamps in Comments: Interaction display improvements have been made to include a
timestamp in comments. Users will now see the date and time at which the comment was made/last
edited.

* Segment Filter: Users can now filter the Search Results grid according to a specific number of
segments. In addition, the search results can be restricted further using the greater than and/or less
than options.

¢ Support for MS SQL Server 2014 SP2 database: See the SpeechMiner page in the Genesys
Supported Operating Environment Reference for more detailed information and a list of all supported
databases.
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* Recognition Improvements: Recognition improvements have been made for the following existing
languages: Arabic (ar-WW), Brazilian Portuguese (pt-BR), German (de-DE), Korean (kr-KO), Japanese (ja-
JP).

* Language Enablement: Recognition of Indian English (en-IN) has been enabled. Speech Analytics and
Text Analytics now operate on voice interactions and text interactions in Indian English.

When upgrading from a version preceding 8.5.502 to 8.5.502 or later, all interactions
are re-indexed. During the re-index process, all SpeechMiner functionalities, except
searching by term function as expected.

Resolved Issues

This release contains the following resolved issues:

The word position calculation for events in text interactions was slightly changed. If you re-recognize
these interactions, the event positions may change. (PRSM-15886)

In the My Messages widget, the Type column now contains the correct type of interaction (for
example, chat, e-mail, and so on). Previously, the Type column contained Call for every entry in the
widget. (PRSM-15416)

You can now add an Interaction list to a Coaching session from the Coaching Session page, even if
the Interaction list was not shared with the creator. Previously, you could not add the list if the
Coaching session was not shared with the creator. (PRSM-15347)

Using the Search Filter, you can now filter for content using one letter. Previously, the filter did not
show results for one letter. (PRSM-15252)

When working in Operation Search, Batch Actions are now available. (PRSM-15804)

You can now open an email interaction when working in Operation Search. Previously, when
attempting to open an email interaction in Operation Search an error occurred. (PRSM-15805)

The View Selected Only option in the Search Filter is now functioning as expected. Previously, this
option did not limit the search results according to the user's selection. (PRSM-15243)

When working with Chrome (version 50), SpeechMiner reports now appear as they should. Previously,
the reports appeared smaller than they should. (PRSM-16174)
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The + signs in the Terms & Topics section of the Search Filter are now properly aligned.
(PRSM-15228)

The Edit cursor now appears correctly when you try to select a sub-menu from the Navigation bar.
Previously the Action cursor appeared instead in error. (PRSM-15223)

When searching for events using the custom date range, the search results now appear without
discrepancies. Previously, such results deviated according to the difference between UTC time and
your time zone when users either searched for events from the Explore page or drilled down to an
events search from a report. (PRSM-14911)

When you access a report link sent via e-mail, the requested search parameters now display correctly
even if you are not logged into SpeechMiner. Previously in this scenario, the general search page was
opened instead of the requested search parameters. (PRSM-13638)

When you create a new Dashboard view the My Messages link is now responsive. Previously, the
link was not responsive. (PRSM-12944)

The ID column in an Evaluation Session - Interaction grid is now populated with the correct
information. Previously, the ID column was empty. (PRSM-12797)

The Select Column icon no longer overlaps with the last column heading, in some Quality
Management grids. Previously, the two overlapped. (PRSM-12662)

When you run a search for the second time, the segment and duration filters are no longer ignored.
Previously, running a search for the second time caused these parameters to be ignored.
(PRSM-16007)

The transcription cursor no longer behaves sporadically when moving through an interaction
transcript during playback. Previously, the cursor would highlight a different term from the term
spoken. (PRSM-15624)

Turkish wild-cards [digits] and [boolean] are now recognized by the system. (PRSM-15307)

When you open a Screen Recording tab in Internet Explorer, the start and end times are
synchronized with the local time. Previously, they were synchronized with the UTC time.
(PRSM-15638)

In the SMConfig > Services tab, the Select/Deselect All option now remains chosen when you
open a different SMConfig tab and then return to the Services tab. Previously, opening a different
tab and returning to the Services tab changed your Select/Deselect all selections. (PRSM-9248)
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An error no longer occurs when you click on the Computers branch in SpeechMiner under Monitor
System > Sites. (PRSM-15574)

When SpeechMiner cannot connect to GIR components for Screen Recording playback, the error
message that appears is now correct. Previously, the error message was stated incorrectly that GIR
was disabled. (PRSM-16043)

When Uplatform runs recognizers, it no longer crashes when processing interactions associated with
a program that includes language=9999. (PRSM-15350)

When changes are made to the SMConfig > Audio panel, the changes now affect the entire system.
Previously, if the setting Play recognition file was cleared and Convert on the fly was selected
instead, the system was not affected and recognition files were still played. (PRSM-7625)

The scheduled index optimizer is now running as expected. (PRSM-15552)

SpeechMiner is now able to read privileges correctly when there is more than one Annex section in a
role containing SpeechMiner roles in the Configuration Data. Previously, SpeechMiner would fail to
read the privileges. (PRSM-15861)

Calibration Evaluation is now no longer created when one of the evaluators lacks the permission to
view the interaction marked for evaluation. (PRSM-15220)

If the setting play recognition file is cleared and Convert on the fly is selected instead (in the
SMConfig > Audio panel), recognition files are not played. Previously, the system was not affected
and recognition files were played. (PRSM-7625)

Upgrade Notes

To upgrade to release 8.5.503, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes

Release 8.5.5

8.5.502.04

Speech and Text Analytics Release Notes

Release Release .
Date Type Restrictions AIX
02/10/16 General
What's New

This release includes only resolved issues.

This version was first released as a Hot Fix on 02/09/16.

Resolved Issues

This release contains the following resolved issues:

Linux

Solaris Windows

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

When working in an Analytics deployment, SpeechMiner can now correctly recognize silence time
during English, Spanish and Turkish language interactions recorded in Stereo mode. (PRSM-15572)

As part of this correction, run the following SQL command after installing this release:
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update nleparams set SEG LEN=4000
update GenRecRecognizeCommandArgs set value='2000' where language=-1 and

cmd="'nnetLatgenArgv' and arg='--max-active'
update GenRecRecognizeCommandArgs set value='5' where language=-1 and
cmd="'nnetLatgenArgv' and arg='--lattice-beam’

INSERT INTO [dbo].[GenRecRecognizeCommandArgs] ([language], [cmd], [arg]l, [valuel)
VALUES (16, N'latticeToCtmConfArgv', N'--acoustic-scale', N'0.0909090909')

INSERT INTO [dbo].[GenRecRecognizeCommandArgs] ([language], [cmd], [arg]l, [valuel)
VALUES (16, N'nnetLatgenArgv', N'--acoustic-scale', N'0.0909090909')

UPDATE versionTbl SET version='8.5.502.95"'

In order to use Arabic recognition in your system, please contact Genesys Customer Service.
(PRSM-15398)

Upgrade Notes

To upgrade to release 8.5.502, refer to the SpeechMiner 8.5.x Upgrade Guide.

When upgrading from a version preceding 8.5.502 to 8.5.502 or later, all interactions
are re-indexed. During the re-index process, all SpeechMiner functionalities, except
searching by term function as expected.
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8.5.502.03

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows

01/06/16 General X

What's New :
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

* Recognition Improvements: Recognition improvements have * List of 8.5.x Releases

been made to enhance voice analysis for improved accuracy and

detection results for English and Spanish. * 8.5.xKnown Issues

¢ Shared Evaluations: Creates evaluation sessions about an
agent's performance during customer interactions without
assigning the sessions to a specific evaluator(s). Instead, each
evaluator associated with the session can select and assign

himself/herself a specific session from the available pool of .
sessions. SpeechMiner

Product Documentation

¢ Edit a Completed Evaluation Permission: Users with this
permission can now open, save, export and close a completed
evaluation session.

Genesys Products

List of Release Notes
¢ Filter Panel: Users can now quickly and easily create retrieve
evaluation session information by narrowing down the evaluation
session list.

¢ Export Incomplete Evaluation Session: Users can now export an evaluation session that was saved
but not completed.

¢ Archive Completed Evaluation Sessions: Users can now archive completed evaluation sessions
automatically at a specific period of time or manually.

* Interactions Report: A new report that provides a list of all the interactions in the system.
¢ Localization for Turkish: User Interface localization was added for Turkish.

e Analytics for Turkish: Speech Analytics and Text Analytics now operate on voice interactions and text
interactions in Turkish.

When upgrading from a version preceding 8.5.502 to 8.5.502 or later, all interactions
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are re-indexed. During the re-index process, all SpeechMiner functionalities, except
searching by term function as expected.

Resolved Issues

This release contains the following resolved issues:

When you configured a term(s) with a specific strictness level to use the topic-defined strictness level
an error occurred in the platform and the events were not updated. Currently, this scenario does not
cause an error in the platform and the events are updated. (PRSM-15172)

When working with Internet Explorer 10 and 11, the Custom Date Range filter now contains the
correct date when you type the date. Previously, the wrong date appeared when you typed the date.
(PRSM-15038)

SpeechMiner and IIS do not stop functioning when more than 50 users try to access the SpeechMiner
login page at the same time. Previously, when more than 50 users attempted to access the
SpeechMiner login page, SpeechMiner and IIS stopped functioning.(PRSM-15090)

The My Queue and Recently Queued widget permissions were removed from the Administrator Roles.
Previously, they remained even though the two widgets were removed from the Dashboard.
(PRSM-12638)

In the Action Items window the icon now clearly indicates that you can the Details, Complete and Edit
actions. Previously, it was not clear that you could click these options. (PRSM-12899)

The find option is now supported in the Program and Topic filters. (PRSM-11534)

When a user tries to delete an evaluation created by another user, a server error no longer appears.
(PRSM-14755)

The installer no longer requests irrelevant .NET prerequisites. (PRSM-15011)

You can now edit reports from the dashboard. Previously, an error message appeared when an
attempt was made to edit a report. (PRSM-14971)
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Previously, if audio files are waiting for the Interaction Receiver when the audio encryption keys were
changed, the audio files became unreadable. Now, such audio files are readable. (PRSM-14913)

Previously, terms in Australian English were not checked to verify that they do not have invalid
characters. The system now checks such terms to verify that they do not include invalid characters.
(PRSM-14801)

Previously, when a user tried to work with the Saved Search and Report tabs in Internet Explorer, IE
stopped functioning. Now IE functions as it should when working with the Saved Search and Report
tabs. (PRSM-14766)

Previously, when working with Internet Explorer and an active form is opened, the Ul displayed that
form as inactive. Now, the same form is displayed correctly as active. (PRSM-14764)

When creating a QM form, the Group Weight title is now localized. Previously, the Group Weight title
was not localized. (PRSM-14726)

When you click a multiple event icon in the Media Player, the playback no longer jumps to the
beginning of the interaction. (PRSM-14715)

Apply from the command line will now lock the objects it works on. In addition, if it finds items that
are locked by a previous apply, it will stop and display a message asking whether or not to unlock the
items.

It is possible to use the -| parameter to specify the answer (yes/no/cancel) so that the process does
not pause for user intervention. Previously, the objects were not locked and the message would not
appear. (PRSM-14650)

Previously, when a column grid was adjusted in any grid, the grid was sorted automatically. Now
adjusting a column grid does not sort the grid columns. (PRSM-14951)

Previously, there was no vertical alignment in the QM grid. Now the QM grid is aligned correctly.
(PRSM-15129)

A notification is no longer sent to SpeechMiner web server to update recognition languages in
Recording mode. Previously, the notification was sent in Recording mode. (PRSM-14628)

Previously, when working with a Spanish Ul, the position of the Previous and Next buttons in the
Search page was wrong. The Previous and Next buttons in the Search page in a Spanish Ul are now
positioned properly. (PRSM-14476)

When working with Internet Explorer the drop down lists in the Operation Search page are now
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displayed correctly. Previously, the drop down lists were not displayed correctly. (PRSM-14473)

The "Fetcher Total Audio Time" counter in the Monitor System page was removed. Previously, it
incorrectly displayed 0. (PRSM-14188)

The Input Folder counter in the Monitor System page is now updated periodically. Previously, the
Input Folder counter was not updated in the Monitor System page. (PRSM-14030)

When you create an Interaction list there is now no indication that the list is shared. Previously, the
list was automatically shared. (PRSM-12488)

When working with SpeechMiner in Internet Explorer 11, the Media Player now function as it should in
a Coaching session. (PRSM-14809)

When a user hovers over the Details associated with a specific action item, the Details remain open
as long as the user hovers over them. Previously, the Details remained open even after navigating to
a different page. (PRSM-14649)

When closing the new player after playing a text interaction, the player's Comment tabs are also
closed and no longer remain on the screen. In the previous player, the Comment tabs remained on
the screen. (PRSM-15420)

When a QM group name exceeds 72 characters the name no longer overlaps the number of questions
label and is not cut at the form preview window border. (PRSM-14041)

Upgrade Notes

To upgrade to release 8.5.502, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.501.05

Speech and Text Analytics Release Notes

Bl s Restrictions AIX Linux Solaris Windows
Date Type

09/30/15 General X

What's New :
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

+ Enhanced Segment Data and Metadata: The Attributes page * List of 8.5.x Releases

now contains data for interaction segments.
* 8.5.x Known Issues

¢ Localization for Arabic: User Interface localization was added
for Arabic.

¢ QM Evaluation Score Visualization: When a QM evaluation is .
completed and saved, the evaluation score appears. Product Documentation

¢ Screen Column Customization: Now you can change the

. SpeechMiner
column order in the Interactions, Events and QM grids per user. P

e Significant SQL server performance improvements have been Genesys Products
made, most notably in an SQL Cluster environment.
(PRSM-14214) Note: The significant SQL server performance
improvements are only relevant for hot fixes 8.5.003.01,
8.5.300.07, 8.5.401.24 and 8.5.501.05.

List of Release Notes

Resolved Issues

This release contains the following resolved issues:

If you receive the following error during the upgrade procedure, follow step #5 in the
Upgrade SpeechMiner from any version to 8.5.501 procedure in the
SpeechMiner Upgrade Guide.

Error You have duplicate external call IDs. Please refer to the release notes
for more information.<br>
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When working with Internet Explorer 10 and 11, the media player's Full Screen mode is now
functional. (PRSM-13695)

In the Topic Audit Report (phrase level) all the percentage bars now reflect their specific percentage-
size. Previously, all the percentage bars were the same length. In addition, all of the columns from
the Calls column to the right are now aligned properly. (PRSM-12339)

The Evaluations Session summary screen now displays 0. Previously, it displayed "No Score".
(PRSM-14202)

SpeechMiner no longer requires Execute rights to be granted to the default application object.
Execution rights can now be configured using an application object that is not the default application
object. (PRSM-14212)

Previously, when working in Explorer and FireFox a subscriber address could not be selected when
creating or changing an alert and had to be entered manually. Now the address can be selected.
(PRSM-11739)

Audio calls can now be converted from stereo to mono. Previously, if a call was in stereo, you were
required to supply the left and right speaker types in the metadata XML file. (PRSM-9823)

When working with IE 10 and IE 11, the To field associated with a Report email is now populated when
you click the address (that is, the recipients name) from the list of addresses that appears.
Previously, it was not populated.(PRSM-11943)

The Search Grid column automatically adjusts to fit the window when columns are added to the grid.
Previously, the Search Grid column did not adjust to fit the window in this scenario. (PRSM-10970)

When working with Internet Explorer there are no tool tips for the Quality Management parameters in
the Forms Manager and Evaluation Manager pages. The tool tips are available when working with
Chrome. (PRSM-13695)

The Event tool tip in the Media Player is now available for multiple events at the same time.
(PRSM-13133)

When working with SpeechMiner in a language other than English, the Search field in a filter no
longer covers the View Selected Only check box. (PRSM-14385)

Exporting a report with a European date format now returns expected results. (PRSM-14098)
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Audio interactions originating from GIR are now categorized correctly. (PRSM-14479)

SpeechMiner functions properly when processing a large number of items in the filter hierarchy.
(PRSM-14134)

It is now possible to change the column order in the Interactions, Events and QM grids per user.
Previously, it was not possible to change the column order. (PRSM-12898)

The following tag was removed and no longer causes Internet Explorer 10, 11 and higher to work in
compatibility mode of Internet Explorer 9: meta http-equiv="X-UA-Compatible" content="IE=9"
(PRSM-14286)

When you play a new interaction recorded in mono audio in Internet Explorer, the duration shown is
now the same as the actual duration of the interaction. (PRSM-12744)

The Player synchronization problems in Internet Explorer are now solved. (PRSM-11927)

Subfolder bookmarks and report descriptions are now included in the PDF on the CD. (PRSM-14321)

Users can now log into SpeechMiner using passwords with special character combinations (for
example, ||<||'||>||'||[||,||]||). (PRSM'14483)

The username and logout menu are now displayed in the top right corner of the SpeechMiner Ul.
(PRSM-14290)

The Batch Actions menu now appears when playing an interaction with a video. (PRSM-13954)

During the installation an Error opening file for writing message no longer appears. This error
occurred because the installation could not override Nuance files. (PRSM-14070)

When upgrading a SpeechMiner Analytics-only deployment ()without the Genesys Configuration
Data) from 8.5.500.04 (build 67) to 8.5.501.05 (build 97), you must add the "Delete Evaluation
Session | created." permission to the QM Manager role. (PRSM-14773)

When working with Chrome, Trend reports are now always displayed for a wide and mini version.
(PRSM-13934)

When working with SpeechMiner in a language other than English, the Search field in a filter now
covers the View Selected Only check box. (PRSM-14385)
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Upgrade Notes

To upgrade to release 8.5.501, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.500.04

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows

07/01/15 General X

What's New :
Helpful Links

This release contains the following new features and
enhancements: Releases Info

* Quality Management - Question Library: When creating a * List of 8.5.x Releases

Quality Management form you can now select an existing group

. ¢ 8.5.x Known |
of questions and you can create a new group for future use. 8.5 o ssues

« SMUpgrade: The new upgrade process executes faster and no
longer requires two databases. This one-step upgrade procedure
can be performed from any version to any version. on the
customer's database (that is, a new database is not required).
Note: The new upgrade procedure is not out of the box. If you .
are interested in this new upgrade procedure, contact Genesys SpeechMiner
Customer Care and allow for one week to receive the scripts
required to perform the procedure. For additional details, refer to Genesys Products
the SpeechMiner Upgrade Guide.

Product Documentation

List of Release Notes

Resolved Issues

This release contains the following resolved issues:

When exporting an interaction the .csv file contains a local time for the interaction time. Previously,
when exporting an interaction the .csv file contains the interaction time in utc instead of the local
time. (PRSM-11871)

Dates in the Report pages appear in the date format defined in the database. Previously the dates
appeared in different formats when the date format of the Web Ul culture (language) was different
from the date format configured in your SpeechMiner database. (PRSM-13832)

When forwarding calls from a Coaching session, the popup window is now displayed properly.
(PRSM-11564)
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Reports now function as they should when the database password contains the following characters:
(PRSM-11904)

<

>

&

Previously, in order for the Apply and Recognition process to work, a value was manually added to
the Environment Variables associated with the machines on which the SpeechMiner Uplatform is
installed. Now the value is added automatically. (PRSM-13861)

When exporting an interaction, the question that appears now is relevant to the scenario. Previously,
when exporting an interaction, the question that appeared asked you if you are sure you want to
export audio, even though text interactions do not have audio. (PRSM-11465)

When changing a column width in a grid, the width is changed as requested. Previously, when trying
to change the column width the column was sometimes sorted instead. (PRSM-12779)

Upgrade Notes

To upgrade to release 8.5.500, refer to the SpeechMiner 8.5.x Upgrade Guide.
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Release 8.5 4

Speech and Text Analytics Release Notes

You can find links to Release Notes for particular 8.5.4 releases of Speech and Text Analytics, if
available, in the tree menu on the left or in the list of Available Releases.
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8.5.401.50

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows
03/03/16 Hot Fix X
What's New :
Helpful Links
This release contains the following new features and Rel Inf
enhancements: eleases Into
» Performance improvements have been made to Interaction * List of 8.5.x Releases
Receiver.

* 8.5.x Known Issues
e Generation of the Topic Analysis - Audit report has improved.

¢ Performance of the CallMetaExFieldNamesView query has

improved. .
p Product Documentation

Trending has improved and now functions as expected in large

systems. SpeechMiner

Genesys Products
Resolved Issues

List of Release Notes

This release contains the following resolved issues:

The speed of generating Exploration reports for a large interaction volume has improved dramatically.
(PRSM-15524)

The Topic filter in the Reports page now supports the AND operator between values. Previously, the
Topic filter did not function as expected when you selected multiple topics using the AND operator.
(PRSM-15570)

Selecting a date from the calendar in the Trending page no longer results in occasional errors.
(PRSM-15592)

Filtered Trend reports are now correctly populated. Previously, they might be generated with 0
phrases. (PRSM-15730)
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The Metadata REST API now takes data from CallMetaExFieldNamesView instead of from
callmetaextbl. As a result, performance has improved. (PRSM-15664)

The Agent search filter now displays only agents that match the selected filter. (PRSM-15109)

The Login page no longer gets stuck in a loop when an exception is thrown while the Login page is
created. (PRSM-15087)

Internet Information Services (1IS) no longer gets stuck when numerous requests are sent to the Login
page. (PRSM-15089)

When interaction recognition fails, the Recognizer task now correctly recognizes subsequent
interactions. (PRSM-15675)

When auditing events with the Topic Analysis - Audits report in Internet Explorer, the user is no longer
unexpectedly redirected to the SpeechMiner Login page. (15508)

You can now successfully use the Agent filter. Previously, the Agent filter would cause an error to
occur. (PRSM-15682)

SpeechMiner performs as it should when processing an exceptionally large amount of interactions in
the filter hierarchy. Previously, processing a large amount of interactions would cause SpeechMiner to
perform slowly. (PRSM-15683)

When SpeechMiner runs on a large database, the Related Words task now runs faster. Previously, the
Related Words task took longer than expected to complete when running on a large database.
(PRSM-15687)

When a user opens SpeechMiner for the first time, the Login page now opens without error.
(PRSM-15655)

When the Buzz report is run with a custom date range, the summary at the bottom of the report now
displays the UTC time and not the local time. (PRSM-15788)
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Upgrade Notes

To upgrade to release 8.5.400, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.401.39

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
10/08/15 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
When you drill down from a Topic Analysis report to view the
events search results, the search grid now displays the requested SpeechMiner
results. Previously, the results might not have appeared until you

clicked the Search button. (PRSM-14841) Genesys Products

When you drill down from a report to view the interaction or List of Release Notes

events search results according to a specific custom date range,
SpeechMiner now retrieves the correct results. (PRSM-14784)

When playing an encrypted interaction in a SpeechMiner Analytics-only deployment, the interaction's
duration in the Media Player is now the same as the duration shown in the Search results grid (for the
same interaction). Previously, the values were different for the same interaction. (PRSM-14723)

Upgrade Notes

To upgrade to release 8.5.400, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.401.36

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
09/30/15 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
After upgrading to 8.5.401.36 you can now access the
SpeechMiner Tools > System Admin > Monitor System page. SpeechMiner
Previously, you could not access the Monitor System page after

upgrading to 8.5.401.35. (PRSM-14785) Genesys Products

You can run a Category Distribution report within a Metadata List of Release Notes

Frequency report without Ul alignment problems. (PRSM-14760)

SpeechMiner now warns you when you create a QM evaluation without adding at least one
interaction. (PRSM-13694)

Upgrade Notes

To upgrade to release 8.5.400, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.401.35
Speech and Text Analytics Release Notes
Rt;l::ese Rt:_;e::e Restrictions AIX Linux Solaris Windows
09/06/15 Hot Fix X
What's New

This release includes only resolved issues.

Resolved Issues

This release contains the following resolved issues:

A proper report is now created when you drill down from one
report to another using a custom date range. Previously, an
empty report was created. (PRSM-14655)

The Attributes page now contains Metadata and Category
information for Segments. Previously, this information was
missing. (PRSM-14209)

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.400, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.401.32

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
08/05/15 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
Non-linguistic categorization is now working as it should.
Previously, categorization ignored non-linguistic elements that SpeechMiner
were found in calls that come from GIR and as a result non-
linguistic categorization was not functioning properly.

(PRSM-14477) Genesys Products

List of Release Notes

Metadata is now available in SpeechMiner when data keys obtain
spaces and non-alpha characters. Previously, spaces and non-alpha characters prevented metadata
from being available. (PRSM-14447)

The category description in the Content Browser page now displays the speaker name configured in
SMART. Previously, the category description displayed incorrect speaker names for speakers that had
a different name in SMART. (PRSM-14438)

Long category names are now completely visible in the PDF file of an exported Category Distribution
report. Previously, they were not entirely visible in the pdf. (PRSM-14427)

SpeechMiner can now be activated successfully from a non-SpeechMiner domain. (PRSM-14423)

Long agent names are completely visible in the PDF file associated with exported Agent Trend and
Agent Comparison reports. Previously, they were not entirely visible in the pdf. (PRSM-14413)
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Upgrade Notes

To upgrade to release 8.5.400, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.401.24

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows
07/11/15 Hot Fix X
What's New :
Helpful Links
This release contains the following new features and Rel Inf
enhancements: eleases Into
* Significant SQL server performance improvements have been * List of 8.5.x Releases

made, most notably in an SQL Cluster environment.

(PRSM-14214) * 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

The significant SQL server performance improvements are only relevant for hot fixes 8.5.003.01, 8.5.300.07,
8.5.401.24 and 8.5.501.05.

Resolved Issues

This release contains the following resolved issues:

When you export a report to a PDF file, the report now runs on the correct date range and the correct
results are displayed. Previously, the report was run on the wrong date range and displayed the
wrong results. (PRSM-14162)
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Searching for an agent now yields results within 10 seconds. Previously, the search results took over
a minute to appear. (PRSM-14150)

Audio interactions originating from GIR are now categorized correctly. (PRSM-14324)

Program ID is now read correctly from GIR via the GRECORD_PROGRAM parameter. (PRSM-14328)

Upgrade Notes

To upgrade to release 8.5.400, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.401.16

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
06/22/15 Hot Fix X
What's New .
Helpful Links

This release contains the following new features and

enhancements: Releases Info

« Agent list: In a Recording Only deployment, it is now possible to * List of 8.5.x Releases
view all of the agents associated with an interaction and not only
those whose telephone extension was recorded.

The list appears in the Agent column in the Search Results

¢ 8.5.x Known Issues

grid.
¢ SMUpgrade: The new upgrade process executes faster and no Product Documentation
longer requires two databases. This one-step upgrade procedure
can be performed from any version to any version on the )
customer's database (that is, a new database is not required). SpeechMiner
¢ The new upgrade procedure is not out of the box. If you are Genesys Products

interested in this new upgrade procedure, contact Genesys

Customer Care and allow for one week to receive the scripts )

required to perform the procedure. For additional details, List of Release Notes
refer to the SpeechMiner Upgrade Guide.

¢ Contact Genesys Customer Care if the upgrade procedure fails and you receive the following
message: You have duplicate external call IDs. Please refer to the release notes
for more information.

Resolved Issues

This release contains the following resolved issues:

You can view Screen Recordings only from the Interactions Grid.
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Now there are no error responses when the eventData.contact.userName field is missing metadata.
Previously, Interaction Receiver returned a 500 error response when the
eventData.contact.userName field was missing metadata. (PRSM-14216)

Speaker types are displayed correctly in the Japanese SpeechMiner Ul. (PRSM-14067)

SpeechMiner WebUI now functions properly after a user performs a specific search for calls using
topics as search criteria. Previously, SpeechMiner WebUI was unresponsive in that situation.
(PRSM-14151)

When working with SMART, event data appears for any topics with Japanese phrases. (PRSM-14068)

When performing certain searches it takes approximately 5 to 15 seconds for the filter fields to load
with the selected information. Previously, it took 30 to 40 seconds. (PRSM-13986)

You can use Japanese characters to name a report. Previously, when Japanese characters were used
to name a report, the report name appeared in question marks ????. (PRSM-14053)

Japanese words in the Ul are now translated properly. (PRSM-14015)

Upgrade Notes

To upgrade to release 8.5.400, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.401.01

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
05/26/15 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
Interaction receiver now fully supports duplicated and partial
metadata arrival. (PRSM-13930) SpeechMiner

. . . L L Genesys Products
The index ix_originalTime is no longer missing from the TextData

table. (PRSM-13137) List of Release Notes

Upgrade Notes

To upgrade to release 8.5.400, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.400.85

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows

04/15/15 General X

What's New :
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

» Media Player: When you play back an interaction the Media * List of 8.5.x Releases

Player can be resized when a Screen Recording is attached to the
interaction. In the QM Evaluation Session, the Media Player can
be opened in a separate window.

¢ 8.5.x Known Issues

* Localization of new languages: User Interface localization was

added for the following languages: Product Documentation

e German

SpeechMiner
* Brazilian Portuguese P

+ Japanese Genesys Products
e [talian .

List of Release Notes
e Catalan
e Mandarin

e European French

¢ Related Words: When you view the transcript of an interaction, you can use the Related Words
option to graphically show which terms are commonly found within the same or similar term clusters as
a selected term and how frequently the terms are found together in the cluster.

* Search by ID: You can filter an interaction search query according to the interaction's ID.

* Show/Hide Search Filter: You can now select to show or hide the SpeechMiner Search filter in the
Edit Reports page and in Coaching Sessions.

¢ SpeechMiner Command Line Configuration: SpeechMiner can now be configured using the
command line.

¢ Transcript - Comments and Events display: With a new Comments and Events panel, you can
now view and edit a list of all the comments and events associated with the transcript you selected to
view.

¢ Playback speed: When you play back an interaction you can now select the playback speed. 1.0 is the
default normal speed and every number above is faster. For example, 2.0 is twice as fast as the normal
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speed.

¢ Column selections: Column selections are now saved per user profile. The columns you select to view
in a SpeechMiner grid are displayed until you select the Reset to defaults option. "Reset to
defaults", resets the grid to display the default column layout.

The Upgrade Guide pdf on the CD is missing a step in the 8.5.3 to 8.5.4 upgrade
procedure. The latest version of the Upgrade Guide can be found in the SpeechMiner
8.5.x Upgrade Guide

Resolved Issues

This release contains the following resolved issues:

Purging audio interactions from the SpeechMiner Ul or with GIR archiving may fail if not all the
platform services are running. (PRSM-14304)

If this occurs the following message will appear in the purgeTbl table under the serviceErrorMessage
column:

System was not changed to idle after waiting 5 minutes.
To fix this issue, edit the sp_runPurgeTaskService stored procedure by removing the following lines:

-- if the system is not idle after waiting the configured time - raise an error
if (@nRunning > 0)

BEGIN
declare @errorMsg as varchar(1000)
set @errorMsg = 'System was not changed to idle after waiting ' +

cast(@waitTimeSeconds/60 as varchar(10)) + ' minutes'

RAISERROR (@errorMsg, 11, -1) -- sevirity 11 or above will make the code to jump to
the catch block

END

Interaction Receiver now supports systems without RCS. Audio files will be saved in the SpeechMiner
Store folders. (PRSM-13838)

An unnecessary scroll bar no longer appears when running the Coaching Summary report from the
Coaching sessions page. (PRSM-11507)

The data links for the following information in the SMART Topic Edit screen now function as expected:
(PRSM-11442) - Events Count - Audits: TP / FP / SFP (PRSM-13838)
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Integrated Windows Authentication is now supported in the 8.5.400.85 release. (PRSM-11524)

Exporting events from the Events Grid are now supported. Such events were not supported in the
8.5.2 release. (PRSM-10458)

When opening a Coaching session with setup mode on Internet Explorer 10, the 'Sys is undefined'
error popup nho longer appears. Previously, the error appeared and after closing the popup everything
functions as expected. (PRSM-11704)

Performance counters are now created when using Windows credentials to log into SMConfig.
Previously, they were not created when using Windows credentials to log into SMConfig.
(PRSM-13870)

The Explore button was returned to the Actions menu in the 8.5.4 release. The option was not
available in the 8.5.3 release. (PRSM-11009)

Different playback speeds are now supported by the Media Player. (PRSM-11451)

When Interaction Receiver simultaneously processes more than one metadata request for the same
interaction, it now returns 215 success responses to the Recording Processor. Previously, it returned
500 error responses. (PRSM-13316)

Machines dedicated for Interaction Receiver appear in the SMConfig > Sites & Machines > Machines
& Tasks list. Previously, the same machine did not appear in this location. (PRSM-13696)

The Status and Type columns are now sorted according to the user's language. Previously, these
columns were sorted according to the English language. (PRSM-12800)

Role IDs do not conflict with the QM Manager role. Previously, a query was required to avoid conflicts.
(PRSM-13209)

The new QM manager role now exists in upgraded databases. Previously, to add a QM Manager role
you were required to run a query after running SMUpgrade. (PRSM-13198)

Searching for numerous topics simultaneously does not hinder the search process and QM design
pages. Previously, such a large search hindered the search process. (PRSM-12842)

The Audit (FP and SFP) colors are now correct. FP is red and SPF is purple. Previously, FP was purple
and SPF was red. (PRSM-13260)
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The auditing time in the Event grid is the user's local time. Previously, this time was incorrect (it was
not the user's local time). (PRSM-13055)

Deleting a user does not affect the sessions he created. Previously, when User-A was deleted after
he/she created an Evaluation Session for User-B, the Evaluation Sessions grid was empty when
User-B logged in. (PRSM-12673)

The N/A option is no longer enabled when making a Yes/No question a required question.
(PRSM-12845)

Pressing Enter after entering a value in the Paging text box opens the requested page. Previously,
this action was not associated with moving to a specific page. (PRSM-12839)

When a Performance Profile report is created, the last column heading in the table is not cut.
Previously, this column heading title was cut. (PRSM-12856)

A Report email will not be sent without a subject. Previously, the Report email may have been sent
without a subject. (PRSM-12855)

Report data is visible in the Evaluation Summary report details. Previously, some of the data was not
visible. (PRSM-12852)

When previewing a Quality Management form it is now not possible to select answers. (PRSM-12835)

The menu bar no longer disappears when you navigate with the mouse wheel downwards in the
screen. (PRSM-12831)

Page numbers appear in the page navigation text box. Previously, incorrect values may have
appeared in the page navigation text box instead of page numbers. (PRSM-12748)

The Evaluations Manager columns selection is saved when you change the selected columns.
Previously, such a change was not saved in the application. (PRSM-12865)

Names are visible in the Evaluation Manager's Name column. Previously, the names were cut.
(PRSM-12760)

A user given the Show Page permission for the Evaluation Manager Page can now view evaluations.
Previously, the evaluations were not visible. (PRSM-12695)

The Related Words feature is now supported. (PRSM-11621) (PRSM-11011)
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When you add more than one note to a Coaching Session action item, the Save and Cancel buttons
are now positioned correctly. Previously, the buttons were positioned incorrectly. (PRSM-12675)

When selected QM permissions affect a user's options. Previously, a number of QM permissions did
not affect a user's options when they were selected. (PRSM-12616)

An Event search criteria is saved as an Event search criterion. Previously, it was saved as an
Interaction search criterion. (PRSM-12632)

When the Media Player is paused, the player's scroll bar now functions properly. (PRSM-12743)

Playback of multi-segment/multi-agent calls will not fail if screen recording is not enabled on all
segments/agents. Previously, playback of multi-segment/multi-agent calls would fail if screen
recording was not enabled on all segments/agents. (PRSM-11732)

Column configuration for each of the Quality Management grids is now saved per user profile or
session. (PRSM-12557)

Text captions are aligned correctly when working with the Schedule Report feature in an Internet
Explorer 10 environment. Previously, the alignment was not accurate. (PRSM-11920)

When searching for a category in the Categories & Programs section of the Search Filters window,
you cannot find and select categories for which you do not have permissions. Previously, you could
find and select without permissions. (PRSM-11764)

Search Filter parameters show the number of options selected. Previously, some showed one fewer
than what was selected. (PRSM-11672)

The Search option in the Add To Coaching Session now returns relevant results when searching for
numbers. (PRSM-11486)

The browser authentication message no longer appears when different web applications are installed
on the same server and the default IIS configuration is changed. (PRSM-11914)

The Cross Talk event icon appears in the Player display. Previously, the icon was missing from the
display. (PRSM-11392)

When you edit or create a Coaching Session an email is sent to the selected Trainee(s) with the
content of the coaching session note. Previously, this content was not included in the email.
(PRSM-11236)
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If a Coaching session is created from the Player or through Batch Actions, an email specifying that
the session was created now contains the correct session type. Previously, the email contained the
wrong session type. (PRSM-11717)

When viewing a text interaction from the Coaching Session page, the Viewed Interactions count is
now updated. Previously, the count was incorrect. (PRSM-11721)

The title row of the Reports call list is now lined up with the tables columns. In addition, you can now
change the column widths. Such an action no longer causes additional disproportions. (PRSM-11362)

When a topic is given a long topic name, the name is no longer cut when displayed. (PRSM-11340)

Filtering the Recently QAed widget according to the last X amount of hours will now produce results
for the same amount of hours. (PRSM-11695)

The Find field in the User Actions > User list filters the data according to the name displayed in the
Ul. Previously, it filtered the data according to the Username (not displayed in the Ul). (PRSM-11693)

When working with Explorer, the content in the Permalink window is within the window's border.
Previously, the content overflowed from the window border. (PRSM-11320)

When a build number includes three digits (for example, 8.5.103), all the digits appear in the
SMConfig Login screen. Previously, the third digit did not appear. (PRSM-10770)

In the web interface, in the Monitor System page, the interaction statistics include all interaction
types. Previously, the statistics only included data for audio interactions. (PRSM-9755)

The Playback Speed option in the SMConfig Audio panel was removed since it is no longer
required. (PRSM-13549)

An error no longer appears when you delete a category in SMART. The SMART category is now
successfully deleted. (PRSM-13205)

When a search filter is configured:

* The Speaker Parameter list is no longer empty.

¢ The Interaction Types and Languages parameters now contain correct data.

(PRSM-11576)
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The Metadata Frequency report now returns information for text interactions. (PRSM-13477)

The Topic Analysis - Trend report now returns information for text interactions. (PRSM-13478)

Upgrade Notes

To upgrade to release 8.5.400, refer to the SpeechMiner 8.5.x Upgrade Guide.
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Release 8.5.3

Speech and Text Analytics Release Notes

You can find links to Release Notes for particular 8.5.3 releases of Speech and Text Analytics, if
available, in the tree menu on the left or in the list of Available Releases.
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8.5.300.08

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
09/30/15 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
Segmented interactions are now categorized as expected.
Previously, categorization was problematic. (PRSM-14788) SpeechMiner

. ) Genesys Products
SpeechMiner now shows metadata for keys that contain spaces

(for example, Disposition Code) and for non-alpha characters (for

example, /). (PRSM-14421) List of Release Notes

Upgrade Notes

To upgrade to release 8.5.300, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.300.07

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows

07/16/15 Hot Fix X

What's New :
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

* Significant SQL server performance improvements have been * List of 8.5.x Releases

made, most notably in an SQL Cluster environment. Note: The
significant SQL server performance improvements are only
relevant for hot fixes 8.5.003.01, 8.5.300.07, 8.5.401.24 and
8.5.501.05. (PRSM-14214)

¢ 8.5.x Known Issues

Product Documentation

Resolved Issues SpeechMiner

This release contains the following resolved issues: Genesys Products

List of Release Notes

It now takes between 10-15 seconds to receive results when
using the Search Filter to search for an agent. Previously, such a search would take over a minute to
yield results. (PRSM-14130)

An error message no longer appears when drilling down into a Report?s details. (PRSM-14113)

You can now search for interactions using more than one topic as search criteria. Previously, in some
cases SpeechMiner was unresponsive when searching for interactions according to more than one
topic. (PRSM-14112)

The upgrade process to 8.5.300.04 is now working as expected. Previously, this process failed.
(PRSM-13855)

MP3 files can now be created when Audio Encryption is enabled in the SMConfig Audio panel.
(PRSM-13769)
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The external Media Player now displays results for all clusters. (PRSM-13629)

The Related Words feature now returns valid results with dual channel calls. (PRSM-13472)

Upgrade Notes

To upgrade to release 8.5.300, refer to the SpeechMiner 8.5.x Upgrade Guide.
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Release 8.5.3

8.5.300.04

Speech and Text Analytics Release Notes

Release Release .
Date Type Restrictions AIX
03/03/15 General
What's New

This release is under shipping control. This release does not
contain new features or functionality.

Resolved Issues

This release contains the following resolved issues:

Linux

Reports can now be configured to use an external URL (for

example, for Load Balancer) when connecting to SpeechMiner. As

a result, the Drill Down and Export report features are now
functioning properly with Load Balancer. (PRSM-13455)

The index ix_originalTime is no longer missing from the TextData

table. (PRSM-13137)

Solaris Windows

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.300, refer to the SpeechMiner 8.5.x Upgrade Guide
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Release 8.5.3

8.5.300.03

Speech and Text Analytics Release Notes

Release Release i .
Date Type Restrictions AIX Linux
01/09/15 General
What's New

This release contains the following new features and
enhancements:

* New Quality Management: 8.5.300.03 features an all new
Quality Management module, rebuilt from the ground-up. The
new module features enhanced forms as well as improved
workflows for scoring interactions and agents. Four new Quality
Management report templates are included in 8.5.300.03.

* Exploration of text channels: Text channels are now included
in Exploration tasks. Term clusters can be generated for chat and
email, and displayed in the Trending page.

* Language enablement: Recognition of Italian and Mandarin
audio is enabled.

* Functionality changes: Three Dashboard widgets (Gauge, My
Queues and Recently QAed) and the QM Agent Summary
report were removed from SpeechMiner 8.5.300.03.

Solaris Windows

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

To run SpeechMiner 8.5.300.03 you must use a minimum resolution of 1366x768.

Resolved Issues

This release contains the following resolved issues:

When using a permalink to search for interactions, the results grid contains results consistent with

the search represented by the permalink. (PRSM-11861)
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If a session is created from the Player or through Batch Actions, the link to the session (in the email
that specifies the session was created) now works. Previously, this link did not work as it should.
(PRSM-10964)

In the 8.5.2 release, the Actions menu is now supported for the Player search grid when playing a
text interaction. Previously, the Action menu did not function as expected. (PRSM-11344)

You can now assign a user the QM Manager role without assigning them another role. (PRSM-13114)

You can now create a widget name with 77 characters. Previously, Widget names were limited to 25
characters.(PRSM-)

The Segments column in the Interaction grid cannot be sorted. Previously, the Sort option did not
function as it should. (PRSM-11931)

When working in Explorer 10, the Done option in the Search filters is now functional. (PRSM-11428)

The Action options in the Edit Report window are now aligned. Previously, the options were not
aligned on the screen.(PRSM-11452)

All Edit Report page options can be used in an Internet Explorer environment. (PRSM-11867)

Completed Action Items are sent back to the user who created them. (PRSM-11910)

Action items cannot be edited when the Web's Edit Action Item functionality is disabled.
(PRSM-11602)

If the system's time zone is ahead of UTC, item due dates are now displayed according to the local
time. (PRSM-11600)

The scroll functionality associated with the Actions list is completely functional when the list is longer
than the size of the screen. (PRSM-11599)

The SpeechMiner Search Filters > Clear Filters option resets the filter information provided at the
top of the Search grid. (PRSM-11572)

In @ multi tenant configuration, when entering an erroneous path for the physical web folder, a
message is not displayed. (PRSM-11550)
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When a program is deleted in SMART and the change is applied, the Topic Correlation task will not
initiate an error. (PRSM-9429)

The Energy bar in the Player is now highlighted when working with Internet Explorer 10, Internet
Explorer 11 and Firefox. (PRSM-11491)

In Internet Explorer, the player correctly displays the Energy bar for a voice discussion.(PRSM-11390)

When working with Explorer 10 and Explorer 11, the font is the correct size when adding calls to a
Call List and a Coaching Session. (PRSM-11606)

The No Audio indication is working as expected.(PRSM-11568)

Call Forward is now functional in email and in the My Messages widget. Call Permalink is also now
functional. (PRSM-10818)

The following data in the Call Info Attributes tab is now accurate:

e Processed calls: Processing time.

* Non processed calls: does not include a process time.

(PRSM-10540)

The tool tips for the event icons in the Media Screen Player are displayed properly. (PRSM-11537)

When creating a new comment without a specific time, the time displayed when you view the
comment details is 00:00. (PRSM-11502)

In systems with Screen Recording, when you disable the video using the Disable Video button in the
Player, the grid automatically adjusts to the new layout. (PRSM-11143)

The following warning no longer appears after logging into SpeechMiner: "HTCC is misconfigured.
Either SpeechMiner user does not have necessary privileges or HTCC URI is wrong." (PRSM-10889)

When forwarding a text interaction the email body contains the correct content. (PRSM-11560)

The Manual Category data in the Interaction Information screen is displayed properly. (PRSM-11430)

The speaker names are included with chat exports. (PRSM-11413)
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When assigning or removing the "view all reports" permission you do not have to reset IIS for the
change to take effect. (PRSM-11952)

When you open a text interaction after playing an audio interaction, the player stops playing the
audio of the previous audio interaction. (PRSM-11899)

The UPlatform correctly processes and stores dual channels when using PCM files with 44.1 KHz
sampling rate. (PRSM-10538)

When RCS URI is not configured properly in an Analytics + Recording environment, Playback will now
remain responsive. (PRSM-12047)

Explore > New Search was changed to Explore > Search. As a result, emptying the Search grid is not
expected . (PRSM-10883)

It is possible to Audit from the transcription screen. (PRSM-11584)

Creating a new Coaching Session from a Batch Action within the grid takes less than one minute to
run. (PRSM-11563)

The Topic Correlation report can be run by a Genesys Administrator Extension (GAX) user.
(PRSM-11071)

Previously a large amount of external metadata fields increased the event history metadata
processing time. Now the event history metadata processing time for a large amount of external
metadata fields has been reduced. (PRSM-12069)

SpeechMiner was not able to play back an audio interaction from an MCP Failover. In this version,
SpeechMiner is now able to play back an audio interaction from an MCP Failover. (PRSM-13277)

The Related Words feature is now returning valid results with dual channel
calls. (PRSM-13364)

Upgrade Notes

To upgrade to release 8.5.300, refer to the SpeechMiner 8.5.x Upgrade Guide.
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Release 8.5.2

Speech and Text Analytics Release Notes

You can find links to Release Notes for particular 8.5.2 releases of Speech and Text Analytics, if
available, in the tree menu on the left or in the list of Available Releases.
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8.5.201.08
Speech and Text Analytics Release Notes
Rt;l::ese Rt:_;e::e Restrictions AIX Linux Solaris Windows
05/26/15 Hot Fix X
What's New

This release includes only resolved issues.

Resolved Issues

This release contains the following resolved issues:

The web server does not stop working when you make changes to
the Edit page in an Internet Explorer environment. Previously,
using some features in the Edit page caused the web server to
stop working. (PRSM-13528)

SpeechMiner Queue playback page displays properly in an
Internet Explorer 11 environment. Previously, this playback page

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

did not appear as it should in an Internet Explorer 11 environment. (PRSM-13312)

SpeechMiner was not able to play back an audio interaction from an MCP Failover. In this version,

SpeechMiner is now able to play back an audio interaction from an MCP Failover. (PRSM-13277)

Upgrade Notes

To upgrade to release 8.5.200, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.201.07/

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
01/26/15 General X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
When RCS URI is not configured properly in an Analytics +
Recording environment, Playback will now remain responsive. SpeechMiner
(PRSM-12047)

Genesys Products

Previously a large amount of external metadata fields increased
the event history metadata processing time. Now the event
history metadata processing time for a large amount of external
metadata fields has been reduced. (PRSM-12069)

List of Release Notes

SpeechMiner used the same RCS configuration options for IIS and the browser for Screen Recording
encryption. Now a new separate External RCS URI value was added for recording so that when
working with Screen Recording IIS and the browser do not use the same RCS configuration.
(PRSM-12374)

The index ix_originalTime is no longer missing from the TextData table. (PRSM-13137)

Upgrade Notes

To upgrade to release 8.5.200, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.201.06

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
10/22/14 General X
What's New .
Helpful Links

This release contains the following new features and

enhancements: Releases Info

* Single sign-on support for Genesys HUB. Genesys cloud * List of 8.5.x Releases
customers can now access SpeechMiner without having to re-

authenticate. ¢ 8.5.x Known Issues

¢ Recognition support for Japanese audio.

e SpeechMiner web interface support in Korean. .
P PP Product Documentation

* GIR Ul improvements, notably, call exporting.
SpeechMiner

Genesys Products
Resolved Issues y

List of Release Notes
This release contains the following resolved issues:

The Calls Export feature is now available for Recording Only mode. (PRSM-11660)

The following characters are now supported for the database password:
<
>

&

(PRSM-11822)

An additional Index Backup folder will be created when the Index Daily Backup task is configured.
(PRSM-10226)
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All database objects associated with the Purge feature are now in the database backup file.
(PRSM-11934)

For a GIR interaction it is now possible to use the More Actions menu without selecting the
interaction checkbox. (PRSM-10175)

In the Events grid, the audit date and time can now be converted to the local time correctly.
(PRSM-11567)

Japanese is now supported in upgraded versions to 8.5.201.06. (PRSM-11614)

Program property fields are now updated when importing and overriding programs that already exist.
(PRSM-10449)

The Event search does not time out. (PRSM-11641)

SpeechMiner no longer includes a System Alert report template. (PRSM-11433)

You can export interactions from the Web Ul when working with a previous version of the Search
grid. (PRSM-11499)

The following wildcards are now supported for text interaction recognition: [ccexpdat], [currency],
[number], [socialsecurity], [time], [zip code]. (PRSM-11553)

When the Web Session Timeout message appears and you click OK, the session is extended.
(PRSM-11613)

When previewing a form in Explorer, the SpeechMiner navigation bar no longer appears at the top of
the Preview window. (PRSM-11503)

When the SpeechMiner system contains a large amount of topics, the search will now return results
when you select All Topics and perform a search. (PRSM-11385)

The Stored procedure (sp_create_DB_storage_partitions) is based on audio and text interactions.
Previously, the Stored procedure was only based on audio interactions. (PRSM-10643)
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Upgrade Notes

To upgrade to release 8.5.200, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes

Release 8.5.2

8.5.200.09

Speech and Text Analytics Release Notes

Release Release i .
Date Type Restrictions AIX Linux
08/26/14 General

What's New

This release contains the following new features and
enhancements:

* New Responsive Style User Interface: In this release, the Main
page, Menus, Media Player, Search pages and grids have been
updated with the new design.

*« New Media Player with Video Playback Capability: The updated
media player now supports screen recordings. When working with
GIR, audio and screen recordings can now be synchronized.

¢ Multiple QM Forms per Interaction: Multiple QM form evaluations
can now be attached to a single interaction.

e Categorization Based on Spatial Relationships: Text interactions
can now be categorized based on rules such as: ?found ?abc?
within X words of ?xyz?.".

e Wildcard Support for Text Interaction Topic Definitions: Like Voice
interaction topic definitions, Text interaction topic definitions can
now utilize wildcards.

Solaris Windows

X

Helpful Links
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

¢ Recognition Improvements: Continuous recognition improvements were made in this release based on

new customer and vertical training material.

¢ Functionality changes: Anonymous Permalink was removed from SpeechMiner.

Resolved Issues

This release contains the following resolved issues:

Categorizations are now based on word-based positions. (PRSM-10098)

For category elements of type "Text", the Occurrence and Position properties are no longer ignored.
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(PRSM-9192)

Indexing text interactions functions as expected. Previously, errors may have occured when indexing
text interactions. (PRSM-10519)

The table layout in the Action Items area of the Coaching Session screen is now properly aligned.
(PRSM-10761)

The Manage Categories option is no longer found in the Tools menu. You can create and manage
categories using SMART. (PRSM-10973)

Previously, when a new metadata field was added to the SpeechMiner database, the search function
failed and the following error message appeared: Cannot load the search. Column <column>
does not belong to table calls grid, and only the first segment played.

For segmented GIR calls, the Playback option in the Events grid can now be initiated from the
position of the term.

When the Media Player is embedded in an external application, it now plays the entire call. Previously
in this scenario, the Media Player played the first segment of a segmented GIR call only.

Upgrade Notes

To upgrade to release 8.5.200, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes Release 8.5.0

Release 8.5.0

Speech and Text Analytics Release Notes

You can find links to Release Notes for particular 8.5.0 releases of Speech and Text Analytics, if
available, in the tree menu on the left or in the list of Available Releases.
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8.5.00/7.01

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
06/15/17 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
The Find option in the Topic Analysis Audit report > Topic
filter is now functioning as expected. (PRSM-18094) SpeechMiner

. . . o Genesys Products
The Audit Text Interaction tool tip is now functioning as

expected. (PRSM-18378) List of Release Notes

Upgrade Notes

To upgrade to release 8.5.0, refer to the SpeechMiner 8.5.x Upgrade Guide.
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SpeechMiner 8.5.x Release Notes Release 8.5.0

8.5.000.02

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
04/12/17 Hot Fix X
What's New .
Helpful Links
This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

¢ 8.5.x Known Issues

Product Documentation
SpeechMiner
Genesys Products

List of Release Notes

This is not a full release. This release only includes the Web application.

Resolved Issues

This release contains the following resolved issues:

Text interactions in Operation Search can no longer be viewed by users that do not have permission
to view the specific text interactions. (PRSM-18281)

Searching for interactions according to an External ID now functions as expected. Previously, the
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string sometimes resulted in an empty interactions list. Note, search results include only interactions
with the value you entered for the ID including a suffix. (PRSM-14682)

Upgrade Notes

To upgrade to release 8.5.0, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.000.00

Speech and Text Analytics Release Notes

Release Release = . . .
Date Type Restrictions AIX Linux Solaris Windows

02/07/17 Hot Fix X

What's New :
Helpful Links

This release contains the following new features and Rel Inf
enhancements: eleases Into

* Manual Text Interaction Categorization: Users can now * List of 8.5.x Releases

manually assign a category to a text interaction from the

Interaction Attributes page. * 8.5.xKnown Issues

¢ Audit Text Interactions: Users can now audit text interactions.

Product Documentation

Resolved Issues SpeechMiner

This release contains the following resolved issues: Genesys Products

List of Release Notes
Database purge is now working as expected. Previously, the
database purge was working slower than expected. (PRSM-17411)

When a text interaction is opened after an audio interaction was opened, the user interface for the
text interaction no longer includes the previous audio interaction's attributes. (PRSM-17071)

An error no longer occurs when an attempt is made to export a Call list with a size smaller than the
default limit. (PRSM-16271)

When you drill down to a specific agent in the Agent Comparison report, the interactions in the
interaction list all have a date within the selected date range. Previously, some of the interactions in
the list had a date that was not in the filter date range. (PRSM-16741)

Chat interactions can now be exported. Previously, it was not possible to export chat interactions.
(PRSM-16462)
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Release 8.5.0

It is now possible to export an email using Operation Search. (PRSM-16340)

The Select/Deselect All option is now working for Operation Search. (PRSM-16338)

The sp_get old audio Stored procedure no longer times out. (PRSM-17940)

CPU intensive script no longer reduces SQL Server Performance. (PRSM-17421)

Upgrade Notes

To upgrade to release 8.5.0, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.005.01

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
06/07/16 Hot Fix X
What's New .
Helpful Links

This release contains the following new features and

enhancements: Releases Info

« Default Call List Order: A new configuration option that * List of 8.5.x Releases
enables you to determine the order of interactions in a call list.
The new sort options are: Descending by Date Added, Ascending
by Date Added, Descending Alphabetical and Ascending
Alphabetical

¢ 8.5.x Known Issues

* Include Header Data when Exporting Text Interactions: p ;
. | ; X . r tD mentation
When exporting text interactions, the Subject, Date and Time, oduct Documentatio
From, To, Cc and Bcc information is exported along with the .
content of the interaction. SpeechMiner

¢ Export or Add the entire Search Results list: Users can now Genesys Products
export all the interactions in the current search results view as

well as add all interactions in the current search results view to )
an existing or new call list. List of Release Notes

* Re-categorize Interactions Option: SMART users can now
decide to re-categorize all existing interactions or not based on updated category definitions.

* Database Optimization: Database optimization improvements have been made to remove
unnecessary storage. This optimization enhances the Events table and reduces the size of the
database.

 Extend E-mail Search Capability: The search capability has been extended to include additional
filters for e-mail headers. You can now search for e-mails according to header fields including To, From,
Cc and Bcc fields. After upgrading to 8.5.005.01 you must re-index text interactions in order to be able
to use the new email filters for existing data.

Resolved Issues

This release contains the following resolved issues:
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Database purge is now working as expected. Previously, the database purge was working slower than
expected. (PRSM-17411)

The highlight Search/Event terms feature in the Interaction transcript is now functioning as expected.
(PRSM-15678)

When working with Internet Explorer 10 and there are more than 500 Call Lists or with Chrome and
there are more than 1000 Call Lists associated with the More/Batch Action > Add To option, the
browser now responds as expected. (PRSM-15704)

Upgrade Notes

To upgrade to release 8.5.0, refer to the SpeechMiner 8.5.x Upgrade Guide.

Speech and Text Analytics 243


https://docs.genesys.com/Documentation/SPMI/8.5.5/Upgrade/Welcome

SpeechMiner 8.5.x Release Notes Release 8.5.0

8.5.004.00

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
01/27/16 Hot Fix X
What's New .
Helpful Links

This release contains the following new features and

enhancements: Releases Info

« Timestamps in Comments: Interaction display improvements * List of 8.5.x Releases
have been made to include a timestamp in comments. Users will
now see the date and time at which the comment was made/last
edited.

¢ 8.5.x Known Issues

e Search Term/Event Term Highlighting: Users can now select
to either highlight Search terms and/or Event terms in the Product Documentation
Interaction transcript when an interaction is played from the

Search Results grid. .
SpeechMiner

¢ Reports Support for Text Interactions: SpeechMiner now
displays reports differently for reports that only include text
interactions. For example, reports with text interactions will not
include the Duration column in the report grid.

Genesys Products

List of Release Notes
¢ Edit Call Comments Permission: A new permission has been
added to control which Users can edit a call comment; this
permission is system wide for a given User.

¢ Support for Text Attachments: SpeechMiner can now include and analyze text attachments that are
part of a text interaction. The system will analyze the content of the attachment in the same way it
analyzes text interactions.

* Storage of Text Interactions SpeechMiner will now store text interactions in the file system instead
of the database. This includes encryption of the file on disk if configured as well as a unique value for
retention policy period for these text files.

¢ Support for Raw Text Interactions: SpeechMiner can now analyze raw text interactions (that is .txt
files) in the same way it analyzes audio, e-mail and chat interactions.

Resolved Issues

This release contains the following resolved issues:
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All users with the Report Menu permission for Web will appear in the Share with Users list. Previously,
the system checked for the wrong permission to add the user to the list. Now the system checks for
the Report Menu permission. (PRSM-15071)

When exporting text interactions using Batch Actions, the exported file is now formatted correctly.
Previously, the format was incorrect. (PRSM-15125)

When searching for a specific term the search no longer highlights the term when it is part of another
term. (PRSM-15034)

Text Recognition now analyzes a word preceded or followed by a tab. Previously, the word preceded
or followed by a tab was not analyzed. (PRSM-14968)

The process of updating topic events after changing the strictness or a name was moved to run off-
line and not during the SMART Apply process. Previously, updating topic events after changing the
strictness or a name, resulted in a time consuming operation. (PRSM-15302)

Upgrade Notes

To upgrade to release 8.5.0, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.003.02

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
09/09/15 Hot Fix X
What's New .
Helpful Links

This release includes only resolved issues.
Releases Info

e List of 8.5.x Releases

Resolved Issues « 8.5.x Known Issues

This release contains the following resolved issues:

Product Documentation
Install this hot fix to prevent an SQL error from occurring when

the EntryID column in the callEventsTbl table reaches a value of SpeechMiner
2,147,483,647 or more. (PRSM-14721)

Genesys Products

List of Release Notes

Upgrade Notes

To upgrade to release 8.5.0, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.003.01

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
07/07/15 Hot Fix X
, Helpful Links
What's New

Releases Info

This release contains the following new features and
enhancements: * List of 8.5.x Releases
e Significant SQL server performance improvements have been * 8.5 Known Issues
made, most notably in an SQL Cluster environment. Note: The
significant SQL server performance improvements are only
relevant for hot fixes 8.5.003.01, 8.5.300.07, 8.5.401.24 and
8.5.501.05. (PRSM-14214) Product Documentation

SpeechMiner

Resolved Issues Genesys Products

This release contains the following resolved issues: List of Release Notes

When creating a SpeechMiner report according to specific dates, the correct dates are returned.
Previously, the wrong dates were passed to the search query and the values returned are
wrong.(PRSM-14235)

You can now successfully work with the Trending tab. Previously, when you tried to access the
Exploration (Trending) tab, an error message appeared. (PRSM-14183)

The Metadata Frequency report now displays the correct results. Previously, the report contained
inconsistent results. Note: If the Metadata Frequency report does not drill down properly, contact
Customer Care for the correct Metadata Frequency report. (PRSM-13936)

The Related Words feature now returns valid results with dual channel calls. (PRSM-13364)
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An error no longer appears when working with recognition servers that are far away from the
database. (PRSM-13296)

Text search results are returned at a normal speed. Previously, the text search results performance
was slow. (PRSM-13285)

Upgrade Notes

To upgrade to release 8.5.0, refer to the SpeechMiner 8.5.x Upgrade Guide.

Speech and Text Analytics 248


https://docs.genesys.com/Documentation/SPMI/8.5.5/Upgrade/Welcome

SpeechMiner 8.5.x Release Notes Release 8.5.0

8.5.002.00

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
12/08/14 General X
| Helpful Links
What's New

Releases Info

This release includes only resolved issues.
» List of 8.5.x Releases

¢ 8.5.x Known Issues

Resolved Issues

This release contains the following resolved issues: Product Documentation

) ) ) . SpeechMiner
It is now possible to export emails and chat conversations and
use the Batch Actions functionality for all types of interactions.

(PRSM-12199) Genesys Products

List of Release Notes

The uninstaller is functional even when IIS is not installed. To
uninstall previous versions, 1IS should be installed on the machine. (PRSM-12292)

The More Actions link is functional from the Dashboard. You can now export email and audio
interactions. (PRSM-10306)

Playing back an interaction or moving from one interaction to another no longer causes a memory
leak. (PRSM-10288)

Text Recognition Stemming is functioning as expected. (PRSM-10619)

SpeechMiner recognizes text without errors. (PRSM-10620)

The Content Browser and the New Search interaction grid display the same number of interactions.
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(PRSM-10624)

The difference between the time it takes to fetch a longer or shorter interaction is minor.
(PRSM-11700)

SpeechMiner email visualization is functioning as expected. The chat content is no longer broken.
(PRSM-11714)

Next and Previous buttons are functional in the Operation Search grid for all supported browsers.
(PRSM-11835)

You can now search for interactions using comments. (PRSM-11836)

All currency characters are supported except for currency characters that do not have an html code.
If you want to see hidden numbers, update the FILTER_WORDS field in the callRecognizer table to 0.
(PRSM-9797)

Stereo audio transcriptions include a separate line for each speaker. (PRSM-12187)

The Fetching performance for interactions with numerous metadata fields was improved.
(PRSM-12111)

The text processing speed has improved (especially for long texts). (PRSM-10377)

Upgrade Notes

To upgrade to release 8.5.0, refer to the SpeechMiner 8.5.x Upgrade Guide.
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8.5.001.00

Speech and Text Analytics Release Notes

Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
03/28/14 General X
| Helpful Links
What's New

Releases Info

This release contains the following new features and
enhancements: * List of 8.5.x Releases

* Ability to add text interactions to saved lists. * 8.5 Known Issues

e Ability to add comments to text interactions.
e Ability to search for numbers in text interactions.

Product Documentation
* Ability to display events in text interactions.

e Support for wildcards in Spanish. SpeechMiner
¢ High Availability improvement for indexing. Genesys Products

e Ability to configure backup Configuration Server in SMConfig.
List of Release Notes

Resolved Issues

This release contains the following resolved issues:

SpeechMiner now includes the following search filters for recording-only mode:

* Agents
e Partitions
e Call length

e External ID

Previously, when the SpeechMiner license did not contain analytics, the entire SpeechMiner User
Actions section was missing from the search filters. (PRSM-9888, PRSM-9960)
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SpeechMiner can now filter word sequence lengths in the database. In the Callrecogngizer table, the
MIN_FILTERED _DEQUENCE parameter controls the minimum sequence number for filtering. The
default value is 1. (PRSM-9045)

SpeechMiner users can now forward calls to agents that are configured in the Genesys configuration
database. (PRSM-9893)

The SpeechMiner search filter now filters out text interactions by their metadata fields. Previously, all
text interactions appeared in the search results. (PRSM-9884)

The topic filter in the reports data set now supports text interactions. (PRSM-9684)

SpeechMiner, when opening emails, now highlights those portions of the emails where the Topic is
found. (PRSM-9467)

Upgrade Notes

To upgrade to release 8.5.0, refer to the SpeechMiner 8.5.x Upgrade Guide.
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Release Release i . . .
Date Type Restrictions AIX Linux Solaris Windows
01/13/14 General X
| Helpful Links
What's New

Releases Info

This release contains the following new features and
enhancements: * List of 8.5.x Releases

. . . . . e 8.5.xK I
* A new operation mode was added in this release. This Recording 8.5 Known Issues

and Analytics Mode enables full integration of Genesys

Interaction Recording solution with SpeechMiner. It functions as a

user interface for recorded calls and also supports SpeechMiner?s

audio analytics and management capabilities. Product Documentation

e Authentication with Genesys credentials (via the Genesys

Configuration Server) is now supported. SpeechMiner
¢ Support for the Chrome browser was added. Genesys Products

e SpeechMiner now supports the processing and display of chat
interactions. List of Release Notes

¢ It is now possible to sort Categories alphabetically in both the web
Manage Categories interface and the SMART interface.

e |tis now possible to configure a custom security text in the web Login page.

Resolved Issues

This release contains the following resolved issues:

An is Enabled field was added to the ResourceType table. This field allows the professional-services
administrator to choose which interactions to support in the system.

In the Callrecognizer table, a new parameter, MIN_FILTERED_ SEQUENCE, was added. This parameter
defines how long a number sequence must be for it to be filtered from the text of calls. This makes it
possible to filter long sequences, such as phone numbers, without filtering shorter sequences, such
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as amounts of money.

Upgrade Notes

To upgrade to release 8.5.0, refer to the SpeechMiner 8.5.x Upgrade Guide.
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